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I. MAIN SCREEN NAVIGATION
1. PURPOSE OF HAWKEYE™
The idea for HawkEyeTM started in 2006 as the 3rd-generation of the successful directional
drilling application WinSURV3DTM. It is intended to provide directional drilling
information to people involved in the workflow of directional drilling within a rich and
powerful 3D environment. That workgroup includes directional drilling companies,
directional drillers, engineers, geologists and operators.
A DIRECTIONAL DRILLING TOOL
When a workgroup is out drilling a well, HawkEyeTM provides a set of powerful tools to
meet a variety of goals related to a project. Proper use of the 3D space will allow them
to clearly present how they are doing and how far away they are from other wells in a
clear and intuitive way. Many folks do not have great internal mental 3D visualization,
so having a 3D interface overcomes that problem and HawkEye’s 3D environment
actually expands greatly a person’s spatial visualization of a project.
A directional drilling company will often be charged will planning the geometry of the
well and HawkEyeTM provides powerful tools to allow them to do that very easily.
Drilling engineers use HawkEyeTM to keep up with what is going on, to keep track
passively and rest assured of the drilling operation without having to spend a lot of
time tracking numbers and visualize things off of list.
Geologists can incorporate their seismic and geologic graphic representation as overlays
and visually see where the well is in reference to where their targets are.
Generally there is a gap between what geologists understand about certain drilling
engineering restraints and what a driller understands about certain offset data. The
friction between the two groups is alleviated with HawkEyeTM by creating a common
visual workspace in which all data is compiled and easily seen. When a geologist’s data
is compiled alongside the driller’s information, the two groups can forge an optimal
and efficient drilling operation.
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A WELL PLANNING TOOL
HawkEyeTM is a first class well planning tool, allowing for the well planning
development of a single well or an entire platform or pad. Virtually all types of wells
can be planned with HawkEyeTM, ranging from simple slant wells to complex 3D wells
that twist and turn. The well planning version of HawkEyeTM supports the direct
generation of wall plots, invoking InkScapeTM as the primary graphics editor for the file
that HawkEyeTM generates. InkScapeTM is a widely supported vector graphics editor
which specializes in support of the SVG (Scaled Vector Graphics) file standard.
HawkEyeTM well planning is template driven. Customized planning templates can be
easily created, as can customized plot templates. Once created, these templates can be
used to greatly increase productivity.
Included with the Well Planning version of HawkEyeTM is a Torque and Drag module.
This module allows one to predict the torque and drag characteristics of a given well
profile as a function of the variables affect torque and drag. It is easy to use.
THE TWO VERSIONS OF HAWKEYE™
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2. RECOMMENDED SYSTEM SPECS
The most important first step in utilizing HawkEyeTM is the having the proper
equipment. A laptop with maximum specs that will run the program without a hint of
slowdown is still only one-fifth the cost of one copy of HawkEyeTM so it makes a lot of
sense to get the right equipment.
a. 3D Navigation with Mouse
Certain core aspects of the HawkEyeTM interface were designed for optimum 3D
navigation with a certain kind of mouse. Although these devices were once “specialty”
mice, they can now be acquired at a very reasonable price.
Since the predominant workspace in HawkEyeTM is the 3D
space, the users find themselves doing a lot of moving along
a curve in addition to the zooming in the plotting modules. It
turns out that the art of zooming has been perfected in the
computer interface world. High-speed scrolling is best
done with Logitech’s Hyper-Fast Scrolling or
TM
HyperScroll or Ultra-fast scrolling. This is basically a
scroll wheel that is weighted and balanced so that when
you flick it, it will spin continuously for some time. But
since its weight is calibrated just right, you can stop the
spinning with just a touch.
The program in the 3D space requires a frequent number of
mouse wheel clicks up and down, and since the standard
mouse wheel will actually click at each interval, it becomes
an arduous task to navigate up and down a curve if the wheel does not move
continuously.
TM

TM

At least with all of the Logitech Hyperscroll models, the wheel itself can be switched
between smooth motion and click motion, so the user is not forced to always use
continuous motion scrolling. This may prove useful when trying to conduct a fine-tune
zoom or for small iteration movement.
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HARDWARE SPEC at a GLANCE
Minimum requirements:
•
•
•
•
•
•

Windows XP Professional or above
2 GB RAM
1366 horizontal resolution
1.8 GHz processor
80 GB hard drive
Logitech™ mouse with Hyperscroll™ wheel

Recommended specs:
•
•
•
•
•
•

Windows 10 or 11
4+ GB RAM
Any quad-core processor
1920x1080 resolution
120+ GB hard drive
Logitech™ mouse with Hyperscroll™ or Ultrafast scrolling

TM

Logitech’s HyperScroll mouse wheel is
recommended for navigating the 3D space in
HawkEye . These models are referred to as
Anywhere , MX or VX models.
TM

TM

TM

TM
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b. 3D Navigation with the Keyboard
For users who do not have access to a mouse with Hyperscroll or ultrafast scrolling,
they may navigate quickly and easily with keyboard hotkeys.
The Arrow Keys and W,A,S,D keys are interchangeable in the key list below, so that the
user has the option of keeping one hand on the keyboard and one on the mouse.
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c. Screen Resolution
HawkEyeTM requires a certain resolution. 1920x1080 is recommended.
Although great advances have been made in available quality and pixel counts for
computer displays, companies still sell plenty of low-res screens because many ordinary
computer users do not have an explicit need for a massive pixel count and it is a way to
keep their costs down. HINT: Although 1366x768 is billed as “HD,” it is only barely
adequate for HawkEyeTM.
At a minimum to run HawkEyeTM without interface crowding issues, the monitor should
be at least 1366 pixels across. However, the recommended horizontal count is 1920
(commonly as 1920x1080). The program is optimized for 1920x1080, and using a
display with this resolution will greatly enhance all aspects of your work
productivity and overall happiness.

Set to the Best Resolution (1920x1080)
Regardless of the physical dimensions of your monitor, it is nice to have at least a
TM

1600 pixel horizontal to run HawkEye , but 1920x1080 is best.
Checking your resolution in Windows 7/8:
1. Right-click on the desktop.
2. Select “Screen resolution.”
3. Use the Resolution drop-down menu to get to highest res.
Checking your resolution in Windows 10/11:
1. Right-click on the desktop.
2. Select “Display Settings.”
3. Change the value under “Display Resolution”

10
HawkEye

TM

User’s Manual

Copyright © 2022 by Performance Drilling Technology

Set the Display to 100% Magnification
It is vitally important in Windows 7/8/10/11 to set the screen magnification to
100%. (And not 125% or 150%)
To get to that setting, search for “Display” in the Start Menu search bar. (In
Windows 8, search for “Display” under “Settings.”) Open up the panel and select
“100%.” If it is not already at 100%, you may need to log out and back into
Windows after changing it.
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d. Operating System
Operating System
Windows XP Pro

Runs HawkEyeTM

Windows Vista 32-bit
Windows Vista 64-bit
Windows 7 32-bit
Windows 7 64-bit
Windows 8 32-bit
Windows 8 64-bit
Windows 10 32-bit
Windows 10 64-bit
Windows 11

e. System and Video Memory
PROCESSOR: Recommended is a quad core processor, but dual core processors are
both much more common and usually just as sufficient.
VIDEO MEMORY: On-board video memory on any modern computer with an i5 or
equivalent processor and a 1920x1080 screen will be sufficient.
RAM: At least 2GB of RAM is required. Modern computers come with 4 GB at a
minimum, and 8 or 16 GB would ensure no slowdown or issues with the program.
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3. INSTALLING AND UPDATING HAWKEYE™
Installation of HawkEyeTM is a mostly automated process. The program is installed via
an internet connection.
Using default installation folders is immensely helpful when troubleshooting and
keeping track of files upon reinstallation and using HawkEyeTM on multiple machines.

INSTALLATION VIA INTERNET
1. Turn off the UAC (Search “UAC” from the Windows Start Menu, set to 0,
then reboot).
2. Make Sure the HASP key is plugged into a USB port.
3. Connect computer to the Internet. NOTE: Don’t disconnect throughout
this installation process. If the connection is severed at any point, you
will need to and start over.
4. Navigate in any browser to the site:
http://hawkeyert.azurewebsites.net/hawkeye_pdt/hawkeye.msi
This will download an MSI file named “hawkeye.msi.” This is the
“installer” of the program.
5. A version of the .NET Framework must be installed on the machine and
will do so in the course of the installation process.
6. Several other small applications will install. They may take a few minutes
to install, but they are recommended, and in the case of presentation
plots and Inkscape, necessary. Click through and accept the default
settings where applicable:
c. Ssrc SVG - This provides support for the Graphics Designer.
d. INKSCAPE – This is a free Vector graphics program.
e. CUTEPDF Writer – This is a free PDF printer. It is installed so
that the user has access to all page sizes when designing plots.
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4. CHECK FOR UPDATES

Click on the “Help” tab on the top right of the main screen to access the following:
•

The Update button to check for updates

•

Open a hotkey map (keyboard shortcuts for the program)

•

A link to the Quickstart Guide (16 pages)

•

A link to the User’s Guide (this document)

14
HawkEye

TM

User’s Manual

Copyright © 2022 by Performance Drilling Technology

5. Project Organization
a. Files and Databases
All data for each Field/Project is saved to a single database file with the extension
“.HawkEye.mdf”. The data is organized and presented in a tree structure hierarchy, a
concept much like several other well planning software applications, including
Landmark’s Compass.

Briefly, file organization is as follows:
DATABASE FILE (.HawkEye extension) contains:
Collection of FIELDS and or COMPANIES…
Which contain a collection of PROJECTS…
Which contain a collection of STRUCTURES…
Which contain a collection of SLOTS…
Which contain a collection of WELLPATHS that are
either proposed plans or actual surveys.

TARGETS are assigned to either a STRUCTURE or a SLOT.
LEASE LINES and HARD LINES are associated with the STRUCTURE.
LITHOLOGY is assigned to the STRUCTURE, but also to the each WELLPATH.
CASING is assigned to each WELLPATH.
JOB INFORMATION is assigned to each WELLPATH.
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b. New Project Wizard
In the top left corner of the Main Screen, the first icon is the Wizard. Clicking on the
icon brings up the Project Quick Start, a project Wizard that enables the user to create
project with a minimum of information in a short amount of time, all in just a few steps.

STEP 1 Enter the Field Name. If it already exists, it will be in the drop-down menu in
STEP 1.
STEP 2 Enter the Project Name. Also choose the type of North Reference as well as the
units to be used (feet or meters). Choosing the Safety Ruleset for most users
will not be necessary (the rulesets are company-specific separation factors for
ellipses of uncertainty). Here the user should also enter the project’s elevation
and RKB for the structure if known. If this information is not yet known, it can
be later entered by right-clicking on the slot or structure in the Data Tree and
selecting “Edit” in those menus.
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STEP 3 Open the Job Information dialogue and enter information. The information in
this dialogue will pull from any job information that has already been entered in the
Daily/BHA portion of the program. Otherwise, the user will create a new Company and
Job ID in this step.

STEP 4 Click on the “Geodetics Information” button and open up the Geodetics
dialogue. Choose the Group to be used.1 If the computer is connected to the Internet,
then Google Maps will automatically come up with the current location. If you are
working in international territory, it is likely that a UTM will be used, either southern or
northern hemisphere. All of these are available in the first pulldown menu at the top of
the dialogue. Then click “Save and Exit.”

1

If you do not have the geodetics information yet, that is okay. Just select “None” from the
Group pull-down list. This will simplify the Slot Geodetics dialogue and allow you to work
with local coordinates until the geodetics can be entered at a later time.
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After completing the final step of the Wizard, click “Ok.” Now you will have a fresh
project waiting in the Data Tree. The Wizard provides the following by default:
•
•
•
•
•

Structure
Slot
As Drilled Curve
Proposal Curve
(First) Target

You can delete or edit these initial objects by right-clicking on any of them and choosing
an action from the contextual menu.
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c. Data Tree
The Data Tree is the basis for navigating through all the immense information that a job
TM
contains in HawkEye . It is intuitively organized to allow the user the easiest method
of random access to project information. It is by default on display on the left-hand
window of the main screen.

HEIRARCHY: The data hierarchy here should be
familiar to WinSURV3D users with some minor
TM
changes. From the top down, data in HawkEye
is organized into:
Data is organized first by FIELD/PROJECT. This
is the root of the tree, and could also be
conceptualized as the COMPANY (Operator).

DATA TREE ICONS
FIELD/PROJECT
Project
Structure
Slot
Proposal Wellpath

TM

Although HawkEye
could have multiple
FIELD/PROJECTIONS open at a time, it will only
have one of these FIELD/PROJECT trees expanded
and displayed at a time.
The next level is PROJECT, of which also only
one can be open at a time. Underneath each of the
projects are the one or more STRUCTURES.

Survey (Workcurve) Wellpath
First Target
Second Target
Target

Under structures are the various SLOTS. From there, PROPOSED WELLPATHS,
WORKCURVES and TARGETS are all thrown in at the same hierarchical level, grouped
by their slot.
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A PROJECT ( ) may be composed of
any combination of STRUCTURES ( )
found in a given FIELD/PROJECT or
COMPANY ( ). Although the identical
tree may appear under each Project, the
data for a particular Structure is only
written to the database once, and any
modifications to it will be in effect
throughout all projects in which that
Structure appears. However, if you
choose to edit a Project by deleting a
particular Structure, only that single
Project would be affected: the Structure
data remains in the database, in the Field
and any other Projects it is a part of.

The highest level of data is the
FIELDS/PROJECT, under which all other
dataforms are organized. Any given
FIELD/PROJECT
can
contain
an
unlimited number of projects, structures,
slots, curves, etc.

A Project is created and exists within an
individual Field. The simplest way to
understand the hierarchy is to visualize
the case of an offshore drilling program.
The Field may be a particular reservoir;
there may be multiple platforms (Structures) drilling in that same field; each platform,
or STRUCTURE, has the capacity to drill from a number of SLOTS ( ) in the template;
and finally, there can be any number of Wellpaths ( , ) associated with each Slot.
USING THE SAME STRUCTURE: One Project may be a single Structure; for another
you may want to include the next closest structure for anti-collision purposes; a third
may include several other structures, and so on. In other words, the same structure, or
any combination of structures (within a single Field) can be part of any number of
different Projects.
COLLAPSING AND EXPANDING: Any level of the tree may be expanded by clicking
on the “plus sign” (“+”) to the left of that item. (Conversely, clicking on a “minus sign”
(“-“) collapses the tree back up to that level). To whatever degree the complete tree has
been expanded, you can collapse it again by clicking on the named level (or the minus
sign): everything below that level will collapse from view. If there is no plus sign next
to the object, that means there isn’t any data below that level associated with that object.
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ASSIGNING TARGETS TO SLOTS: Targets can be assigned to specific Slots in a
Structure. If they are assigned, you will find them under the slot in which they are
associated. If a target is not assigned to a Slot, it will be placed at the bottom of the Data
Tree under the last displayed datum in the Structure:

An unassigned Target will be at the bottom of a Structure branch (left). To
assign it, just right-click, select “Adjust Target Parameters” and select the
assignee slot from the “Slot” pulldown menu (right).
The EDIT PROJECT button will pull up the small Project Information dialogue. The
TARGET LIST button brings up the comprehensive Target List manager, which
includes the Target Adjuster dialogue and the tools to add, delete and edit all the
targets of the project. The CURVE MANAGER button invokes the small Curve List box
that allows for turning on and off curve.
TO ADD A CURVE, just click on a blank numbered box, then go down to the Curve
Data window and then:
1. Type in a name for that curve
2. Select the type, either proposal or survey
3. Select the slot to be associated
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4. Enter location, tie in and direction
values
5. Click “ADD.”
The new curve will appear in the first open
available square. Any further tweaking of the
curve can be done by Right-Clicking on the
curve’s numbered box and selecting “Edit
Curve” from the curve contextual menu.
SET AS WORK CURVE/SET AS PROPOSAL
CURVE: To set a curve as the work curve, or a
Proposal curve as the current plan, simply rightclick on the numbered box and select the first
item on the menu, “Set as Work Curve.” If you
make any curve that is not number 0 the work
curve, the curve will automatically be the
Number 0 curve, otherwise retaining all of its
parameters including color.
The former Number 0 curve will be swapped out
with the new one such that all other curves keep
their number.

Right-clicking on a curve’s box
in the Project Control Panel is
the same as right-clicking on
one in the 3D space, bringing up
the comprehensive contextual
menu for either the proposal or
work curve.
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1. Slot/Wellhead
The Slot is the most-used data level of a given project. All
curves and targets are associated under a given slot at any
given time. The slot in HawkEye is represented with a “rig”
icon.
A “Structure” will contain as many slots as are needed, and
only lithology information, target planes and hard/lease lines
are associated to a structure.

RIGHT CLICK ON THE SLOT: To change slot information,
right-click on the rig icon in the Data Tree and select “Edit Slot
Data.” Notice that the right-click menu for slots has virtually
everything you will need which is slot-related. Only from this
right-click menu can you do the following:
•
•
•
•

Edit Slot Data (also from large icon, see below)
Add New Well Path
Set slot as the reference slot
Delete the slot

EDIT SLOT INFORMATION: When “Edit Slot Data” is selected, it will open the Slot
Information dialogue.
You may also get to the current slot’s
information by clicking on the large rig icon at
the top of the screen. The Slot Information
dialogue has all of the location information
associated with that slot.
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SITE/SLOT NAME: This is the only place where the name of the slot can be changed
besides initially in the Project Wizard or the Structure Manager (Well Planning only).
INPUT COORDINATES: All of the parameters inside of the green background are
used to define the slot’s location, either by local coordinates, Northing and Easting
coordinates, or Lat-Long coordinates.
CONVERGENCE: This value is derived from the location data of the slot, and indicates
the number of degrees difference between grid north and true north. This number is
also displayed in the Geodetics dialogue when defining surface location.

LAUNCH GEOHAWK:
When the “Launch
GeoHAWK” button is
clicked, it launches a special
version of the Geodetics
dialogue. In this special
version, the user cannot
change any surface location
data (highlighted on the
right). Only the specific
location data for the slot can
be altered.
The point of GeoHAWK is to utilize the power of the Geodetics dialogue, which uses
Google Maps and Google Earth (if installed), for slots. In this fashion, slot location can
be defined, visualized and mapped out with great precision.
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6. Top Tabs
HawkEye’s main screen is organized by default into three distinct information areas.
On the left is the Data Tree. On the right is the 3D space by default. And at the bottom is
the Survey List Panel.

HawkEye has three primary data windows by default.
To switch to a two-panel mode, click the “Settings” tab and then uncheck the option on
the far left that reads “3-Panel Interface.” This will turn off the Survey List Panel at the
bottom of the screen.

RESIZING WINDOWS: The proportion of the screen that each window takes can be
resized manually. Resize by “grabbing” a border, left-clicking and dragging the border
to resize. Just move them around and you will quickly get the feel for them.
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a. File tab
At the top left of the main screen in
TM
HawkEye is the File tab. This menu allows
the quick launch of a few core dialogues and
modules in the program.
Database vs. Project
TM

HawkEye
has a flexible method of
maintaining projects in database files. It is
important to understand the distinction
between a “project” and an entire “database
file.”
• A database file contains a collection of
projects.
• Whereas a project is a collection of
wells/structures that are related to
one another on an operational basis.

NEW DATABASE PROJECT: Select
TM
this option to start a new project. The first thing HawkEye will ask is for the
project file to be named and located. Choose a file location and name the project- it will
have a “.HawkEye.mdf” double extension.
A database consists of a single
.hawkeye.mdb file. There are several important rules of thumb with a HawkEye
database file and its name:
•
•
•

Do not rename anything in the “.hawkeye.mdb” letters themselves
Do not include special characters in the filename (e.g.
drillproject.westtexas.hawkeye.mdf is bad because of that first period)
Do not include special characters anywhere in the entire filepath

A database file can consist of many hundreds of projects. It is not recommended that
hundreds of projects are stored in a database file, however; the reason being that
opening and maintaining a large database file consumes more machine time and also
putting all your eggs in one basket could lead to some extreme frustration should the
“.HawkEye.mdf” file be corrupted by destructive forces such as a power surge, a virus,
or just bad luck.
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NOTE: The best strategy is to have an assigned folder (i.e. “c:/HawkEye/Data” or your
TM
Desktop) in which all of your HawkEye database files are stored. Make routine
backups of this directory.
A good plan is to keep a group of related projects for a given customer within a single
database; if your customer wants to have direct access to your data it is an easy matter
to simply send them the file without being concerned over whether or not some other
company’s information is divulged.

Open Database:
1. HawkEye Database: This will invoke the open project dialogue but will only
open files with the “.HawkEye.mdf” extension.
2. WinSERVE File: This launches a special dialogue in which the user may
TM
TM
either create a new HawkEye file, or import WinServe files to an existing
TM
HawkEye project file.
3. Compass Transfer File: Opens an .edm.xml file created by Compass, and
asks you to specify factors such as North reference

Save As New Database: Any currently displayed and existing project data can be
saved over into a new, separate HawkEyeTM file. This is useful for backing up
and preserving projects as they are before venturing into project deviations. When a
project is saved as a new file, the project will still be open under the old name. Thus
future changes will be saved to the old project while the new one remains untouched.

Merge HawkEye databases: This tool allows for the merging of separate
“.HawkEye.mdf” databases. This can be useful in circumstances under which
different users are working together on a general group of projects. To use this tool
simply use the explorer to point the “.HawkEye.mdf“ file you want to merge with the
TM
current database already opened within HawkEye .

Save As / Export Project: Export Project to WinSERVE: This will allow the user
TM
to save certain project data to a WinServe (.svy) file. Not all project data is
TM
saved to a .svy file from a HawkEye project. Before the .svy file can be saved, it must
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TM

already exist, HawkEye does not create the file, it just writes to it. This is because a
TM
TM
WinServe .svy file has all kinds of data in it that HawkEye can’t possibly know, like
TM
TM
how the plots in WinServe should look. All HawkEye does is fill in the curve and
TM
target data. NOTE: If the HawkEye project has more than 20 curves, then only the
TM
TM
first 20 will be exported to the WinServe file. That is because WinServe .svy files
have a 20 curve limit.
Recent Projects: This list displays all recently opened project files.

Recent Files: This list displays all recently opened HawkEye databases.

TM

EXIT: This will close HawkEye . The program will always automatically save
TM
current data to the currently open HawkEye project file. In order to preserve a
project prior to changes made before closing out, make sure to save the project as a new
TM
HawkEye project.
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b. Home tab
NOTE: Projections are covered in Chapter III: Projections.

Save Surveys
This will force the program to save all added surveys and changes to any
surveys to the current HawkEye database. The program does this by default
every five minutes, but you can push the save as often as you want here.

Report
This launches the Report Generator, which is covered in Chapter IV: Reports.

Quick Plot
This launches the Quick Plot module, which is covered in Chapter V: Plots 1.
Quick Plots.

Add Survey
This opens the Survey Editor. This is the best way to add surveys in the
program individually. In this dialogue all of the surveys for the currently
selected well will appear, and several of their parameters may be edited.
The BEST WAY to add a survey is,
once inside the Survey Editor, type the
Measured Depth, press ENTER, then
type in the Inclination, press ENTER,
and then type in the Azimuth and
press ENTER. After the third
“ENTER,” your new survey will have
been created and added to the Survey
List Panel. See the section on Surveys
on how to import and handle surveys.
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Job Info
Job data is used in the program in several ways, as listed below:
•
•
•

TM

Job data is how HawkEye and its Daily/BHA module communicate
Job data is displayed in report headers
Job data is displayed in wall plot headers

Company: This should be entered first. If
a company name has been entered
before, then it will appear in the dropdown menu here.
Job ID: This is the core identifier of the
Job as it relates to the Daily/BHA portion
of the program.
Available BHAs: This is not editable
here, but rather a read-only indicator of
how many BHAs have been created
under the selected Job ID above.
Curve Name: This is not editable here, but rather an indicator of which curve is
currently selected for the job being edited here. Any given “Job” in HawkEye is
associated with only one curve.
All other fields: The remaining fields do not have a data impact in the program, but are
rather displayed in report headers.
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Target List
See the dedicated section for a full description of the Target List.
For more on Targets generally, see Chapter II Project Data: Targets.

Add Target
Click this to add a target to the current Look-At Point on the current active
curve displayed in the 3D space. The default shape is a 100-foot wide, 5-foot
thick green cylinder. The Target Adjuster opens for this target so you can
adjust these parameters as desired.

Hydraulics
This opens the Hydraulics module. Several points of data need to be in place
before launching this, and the program will prompt you if you haven’t done so
yet:
1. Job ID needs to be assigned to the current curve.
2. A BHA needs to be assigned to the surveys of the current curve.
Assigning a BHA to a curve: This is done in the Survey List Panel, in the BHA ID
column, which is by default the second from the left. Any BHA that you select for a
survey becomes the selection for all surveys below that survey. (Press Tab after making
a selection)
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3. Casing needs to be entered for the current curve.
Entering Casing: Click on the Edit tab in the main screen, then click on the “Casing”
icon to enter casing data for the current curve. Click here for more on Casing.

BHA Daily
This launches the Daily/BHA module of the program, covered in Chapter VI:
Daily/BHA. This module is where the user can: Create BHAs and BHA reports,
enter Daily Activity and create Daily Reports, and keep track of inventory on a job,
generate shipping tickets, and generate end of well reports.
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c. Edit tab

The Edit tab contains all of the most used secondary functions in the program.

Add Lease Line / Hard Line
Click on either of these first two
icons to create a Lease Line or
Hard Line.
The Lease/Hard Line Editor will then open, where you can define a Line by one of five
methods, called “Input Modes” on the top left. First select one of these modes.
Then enter the coordinates of each
point for your line at the bottom.
Depending on which Input Mode
you’ve selected, the BLACK CELLS
in the bottom will change. Those
BLACK CELLS are the only ones
that you can edit. The rest are
automatically calculated based on
what you have entered.
The dark grey window on the right,
titled “TARGET ADJUSTER,”
allows you to edit the appearance
of the Line in the 3D space, but not
its mathematical location, which
will remain 2D point-to-point lines.
Remember to check the boxes in the 3D View in the bottom middle of the dialogue to
turn on the line in the 3D space.
For more details on how to import Lease and Hard Lines, see the section under Editing
Non-Critical Info: Importing Lease/Hard Lines.
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Add Target Plane
A target plane is defined by its TVD,
Side A and Side B, as well as its Dip
Direction and Dip Inclination. Target
Planes in HawkEye are used to denote flat planes
for a variety of reasons and can be set as the
active target when using the Horizontal
Projection.
Click here for more on Target Planes.

Add Side Track
This will create a new curve
that stems from the existing
active curve in the 3D
space. You can see which curve is the
parent curve at the top of this
dialogue.
The curve can be either Proposal,
Work, or both, and the most
important information is its tie-in
point to the parent curve, defined at
the bottom of the dialogue.
You can also choose four different
types of projects to base the new
sidetrack on by first selecting the projection type in the dropdown menu, then adjusting
the parameters on the right.

Paste to End
If you have surveys copied, you can click this to append those surveys to the
end of the current, active curve.
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Paste as New
If you have surveys copied, you can click this to create a new curve out of
those surveys.

Copy Curve
This will copy whichever curve you have selected, to be pasted elsewhere.

Casing
Adding casing in
TM
HawkEye is a process
similar to adding lithology.
It is done layer by layer and each
entry can be customized. To get to the
Casing Editor, click on the casing icon
at the top of the main screen.
The Casing Editor will allow the
appending of casing information to
the selected curve. The first step is to
click the “Add Casing” button. This
will add a casing entry to the selected
curve, wherein all the vital
information can be entered in any order.
The size is defined from a lookup menu of different casing sizes. The selected size will
determine the choices for the weight of each casing. The sizes available are as follows:
List of Casing Sizes
11 7/8
13 ½

10 ¾

11 ¾

14

24 ½

13 3/8
4½

16

20

5½

18 5/8
6

6 5/8

7

7¾

7 5 /8

8 5/8

9¾

9 5/8

Riser

5

35
HawkEye

TM

User’s Manual

Copyright © 2022 by Performance Drilling Technology

SET DEPTH ERROR:
The Casing Editor will give a
“Set Depth Error” if the user tries to add casing with a
set depth greater than the maximum MD.

Aside from casing size and weight, which are selected from drop-down menus, other
parameters are defined manually.
ID/OD: Internal and Outer Diameter in inches.
TOP MD: This number defines the beginning of the casing from the top down along the
wellpath.
SET MD: This is measured depth or TVD to which the casing is run.
COMMENT and COLOR: Click on the Comment field to add any relevant notation to
be associated with the casing. The color field opens to a palette when clicked on.
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DEFINE CASING BY THE
LITHOLOGY: Casing can be defined in
the Lithology editor2. To do this, rightclick on a proposal curve and select
“Lithology.” A lithology dialogue will
open, but it will be specifically
associated with the current proposal
curve. You will see the name of the
proposal curve in the title bar of the
Lithology editor.
Once inside the Lithology editor, you will notice two additional columns on the right
side of the normal spread of parameters. These columns are where you can add casing
that starts and ends with respect to wherever the lithology boundaries are.
The two columns are the Casing Size/Weight, wherein the casing can be defined, and
the Casing Offset, where the casing tops can be defined as not having to start exactly at
the layer borders.

When casing is defined here in the Lithology Editor, the casing will appear in the
normal Casing Editor.
2

For proposal curves only, since a work curve will not usually have casing defined by lithology
boundaries, despite the best plans of mice and men.
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COPYING TO STRUCTURE: When you add casing in the lithology editor, and then
click “Copy Lithology to Structure,” it will also copy the added casing. To prevent this,
you must delete all casing entries by selecting “none” for the Size/Weight and “0” for
Offset before copying to the structure.
DOES NOT WORK ON SIDETRACKS: Adding casing through the Lithology Editor
will not work on sidetrack proposals since they do not start at 0 TVD.

Lithology
Lithology
in
TM
HawkEye
is a
tool that allows
the user to enter known geological data as it
relates to the range of the well. The lithology
data, graphically represented by colored
patterns, appears in the 3D space as well as in
the plots and reports if desired. The lithology
datasets can either be metaphorical graphical
representations or geological snapshots and
cross-sections of actual field seismographs
(“picture” lithology) if such data is available.

Displaying the data in the 3D space
allows for important visualization of
the known material types in
proximity to a well.

OPENING THE LITHOLOGY EDITOR:
1) Click on the Lithology icon in the Edit tab.
. 2) RIGHT-CLICK anywhere in the
background of the 3D space or on a curve and select “Lithology.”
TURNING LITHOLOGY ON AND OFF:
1) RIGHT-CLICK anywhere in the background of the
3D space and select “Show Lithology” or “Hide
Lithology,” depending on if it’s already on or off.

2) Check the box next to the Lithology icon in the Edit
tab labeled “Show Lith.”

38
HawkEye

TM

User’s Manual

Copyright © 2022 by Performance Drilling Technology

THE MANY FACES OF MOTHER EARTH
The function of the Wellpath Lithology editor hinges on lithology layers
chosen by drop-down menus. Each new layer will have a material type to
TM
be assigned to it. HawkEye provides a number of materials to choose
from:

NOTE: Any of these patterns can be replaced with custom pattern files by
clicking on “Edit Patterns” in the top left of the Wellpath Lithology panel.
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LITHOLOGY CONTROLS: At the top of the Wellpath Lithology panel there are a
number of functions:

ADD LAYER and CLEAR LAYER: This may be the first place to go when using
lithology, where each layer can be added manually or cleared entirely. Each new layer
is by default Euclidian and given a depth of 200 ft/m.
EDIT PATTERNS: All of the lithology materials from the layer’s drop-down menu
have particulars pattern associated with them. But they are easily changed out with
user-provided pattern files in the Edit Pattern dialogue. The pattern family is
TM
HawkEye by default but can be switched to the Compass family or customized by
group or individually here.
COPY LITHOLOGY TO STRUCTURE: Any given set of lithology data is associated
with the select curve, so it must be actively attached or associated with a structure. This
button will take the curve’s lithology data as currently displayed and copy it to the
structure under which the curve is associated.
GET LITHOLOGY FROM STRUCTURE: This button will retrieve the lithology
information from the structure and apply it to the current curve. NOTE: There must be
a lithology data set copied to the structure first.
(E.g. If a lithology is set up with a proposal curve, it is not automatically going to
display when the as-drilled work curve is being followed. To share the lithology
between the two, “copy lithology to structure” when it’s being displayed along with the
proposal curve, then follow the work curve and click the “Get Lithology From
Structure” button.)
DEPTH TYPE: It is important to know the method in which the depth for each lithology
layer is defined. Subsea depths start from sea level and go down. TVD depth type
includes the RKB and the elevation.
DYNAMICALLY POSITION and LITHOLOGY DIRECTION: Either one or the other
of these can be selected at a time. These affect the direction the lithology plane is
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pointed. With Dynamic positioning turned on the direction is affected by the direction
at the current focus point. If the formation has a dip, and there is a significant change in
direction such as in a turn zone then the lithology plane will be recalculated after the
scroll wheel as stopped moving. If Dynamic Positioning is turned off then the lithology
points in the direction specified by the Lithology Direction input.
TRANSLUCENCY: Control the translucency of the currently displayed lithology set.
The range is from 0 to 100.
SPLIT LITHOLOGY: This will create two copies of the lithology layer in the 3D space
and they will “sandwich” the current look-at point. Use the slide control to move how
far away the duplicate layers are from the point of interest. This feature is useful for
creating a valley effect in which the well can be referenced against the lithology data
from more angles.

SHOW EUCLIDIAN LITHOLOGY (DEFAULT): This allows the lithology to be
defined by the basic input list be displayed. Sometimes when using a ‘real’ lithology it
is not desirable to show both the Euclidian and real lithologies.
SHOW DESCRIPTIONS: Descriptions are entered
in the layer editing segment under the Euclidian
Lithology tab. When “Show Descriptions” is
selected, a small text box will appear in the 3D
space inside of the lithology’s plane on the bottom
left corner.
BUILD LITHOLOGY UPWARD: The lithology picture is built by default from the top
down. If all dips are the same for all the lithologies then the algorithm for the order in
which layers are drawn is irrelevant. However, if the dips are non-zero and some are
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greater than others then the order can be potentially important. This is not a really
important feature, but it could possibly turn useful.
HORIZONTAL DISPLACEMENT: This slider controls the horizontal span of the entire
lithology display in 3D space. It will crunch or stretch the patterns along the horizontal
plane. The range is from roughly 1,000 to 25,000 feet.

EUCLIDIAN LITHOLOGY (DEFAULT): Once the Wellpath Lithology panel is open,
simply click “Add Layer” on the top left to begin adding lithology data to the project.
Each layer will be blank and have a number of drop-down menu or text field to define
the layer. Click on each box to edit it.

TYPE: Euclidian or Real. Euclidean is the default type that is displayed, and it is
characterized by its straight horizontal borders dividing each layer. “Real” lithology is
characterized by its irregular border between layers, the undulating thickness which is a
more realistic representation of the geology.
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NAME and DESCRIPTION: The Name, as of now, is not really used in reports or
output, but the Description is used. It is used in the presentation plots and also as a
description for interpolated comments
TM

TOP DEPTH and BOTTOM DEPTH: Directly enter the depth of the layer. HawkEye
will not have the layers overlap and will give notice if there is a depth conflict. Each
new layer is given a default depth of 200 (ft/m) from the last layer.

LITHOLOGY: Choose from the drop-down menu what type of material the layer
represents. The list is comprehensive and should encompass most types encountered in
the field.
DIP-ANGLE and DIP DIRECTION: Number fields here define the dip of the particular
lithology plane.
PICTURE LITHOLOGY: The
Picture Lithology tab will
allow the user to utilize any
available
seismographic
imagery for use in place of
the colored lithology patterns
provided. NOTE: These slices
of 3D seismographic data are
not always available from the
company
in
charge
of
geological
survey
and
assessment.
Click “Browse” to select the bitmap. Be sure to check the “Show Picture Lithology” box
to display the custom picture, and define the picture loaded by TVD, Direction, Width
and Height in the provided fields. Define the lithology here by one of three modes,
selected with each of the respective radio buttons: Lat-Long, Local EWNS, or by
Geodetic Grid.
DEFINE CASING BY THE LITHOLOGY: See more in the next section on casing on
how to place casing automatically for where a proposal curve crosses a lithology
boundary.
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HOW TO SET A DEFAULT LITHOLOGY
If you make a target plane (e.g. right-click on any curve and select “Create
Target Plane”) for any given reason and you don’t have the lithology set for
that TVD, the program will give you this for a texture:

Since this is not a convincing or appealing texture, you may want to set a
default other than “Not Available.” Here’s how:
1) Open up the Lithology module.
2) Click on “Edit Textures” at the top left.
3) Scroll down to the texture titled “Default.”

4) Double-click on the “N/A” texture.
5) Choose your new default texture.
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Curve List
Pulls up a list of all curves in
either the current project or the
current structure/pad, for the
purposes of turning on and off their
visibility and their labels.
They can also be renamed here by
double-clicking on the name itself.

Current Structure
This brings up the Platform/Pad editor for the platform/pad of the current
active curve. You can also access this editor by right-clicking on the
platform/pad in the Data tree and selecting “Edit Platform/Pad.”

Current Slot
This brings up the Slot/Wellhead editor for the current active slot/wellhead.
You can also access this editor by right-clicking on any slot/wellhead in the
Data Tree and selecting “Edit Slot/Wellhead.”
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Magnetics
MAGNETICS MODELS: Once inside,
the first step is to select a magnetic
model file. HawkEyeTM uses the IGRF
(International Geomagnetic Reference Field)
and WMM (World Magnetic Model) magnetic
models. (Future models will include those
developed
by
National
Oceanic
and
Atmospheric Administration and the British
Geological Survey). The BMMG model is
available for those users who have a paid
license for it, but is currently not available
standard with HawkEyeTM. It is important to
have the right model selected. The IGRF2020
model is good until 2025.
SURFACE
LOCATION:
Magnetics
is
automatically calculated when a surface location is entered in a project, but that location
(Lat-Longs) can be manually changed in the Magnetics panel in the fields highlighted in
light green at the top.
PRINTING: Just click the “PRINT” button and a handy one-page Magnetics/Geodetic
Report is generated, containing not only all pertinent magnetics information, but
several methods of correction based on which north the user needs to correct from.
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Geodetics
Accurate mathematical positioning of a well site and the associated targets,
lease lines, hard lines and offset wells is extremely important in any drilling
operation. With directional drilling the need for accurate positioning is
enhanced not only by concerns for the drilling operation with regard to no-drill zones
that are defined by hard lines, but also legal concerns that are defined by lease lines.
This is true all around the world, of course, but in the U.S. where many wells are drilled
to the benefit of many mineral rights owners, this knowledge is even more vital.
Thus, it is important for drilling engineers, geologists and directional drillers to have a
functional understanding of the mapping system being employed for their well. The
following sections will briefly describe the systems most widely used, first in the U.S.
and second in the rest of the world. For anyone interested in expanding their
knowledge about geodetics in general, a few hours poking around on the internet can
lead to a very interesting learning experience. A good place to start is with
www.wikipedia.com.

1. Geodetics Systems Generally
STATE PLANES and the PLSS SYSTEM: If working in the U.S., then you will likely be
TM
working with one of the State Planes or Township-Ranges-Sections or both. HawkEye
does not have support for all states that use the PLSS system, but does fully support the
original western states that adopted the system. In some states like Louisiana,
Oklahoma and Florida, there are modified TRS systems being used, but available digital
TM
information can’t be immediately utilized by HawkEye because it is not in a standard
TM
format. Eventually PDT will convert these non-standard formats for use in HawkEye .
STATE PLANE COORDINATE SYSTEM
“The State Plane Coordinate System (SPS or SPCS) is a set of 124 geographic zones or
coordinate systems designed for specific regions of the United States. Each state
contains one or more state plane zones, the boundaries of which usually follow county
lines. There are 110 zones in the continental US, with 10 more in Alaska, 5 in Hawaii,
and one for Puerto Rico and US Virgin Islands. The system is widely used for
geographic data by state and local governments.
Its popularity is due to at least two factors. First, it uses a simple Cartesian coordinate
system to specify locations rather than a more complex spherical coordinate system (the
geographic coordinate system of latitude and longitude). By thus ignoring the curvature
of the Earth, "plane surveying" methods can be used, speeding up and simplifying
calculations. Second, the system is highly accurate within each zone (error less than
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1:10,000). Outside a specific state plane zone, accuracy rapidly declines, thus the system
is not useful for regional or national mapping.
“Most state plane zones are based on either a transverse Mercator projection or a
Lambert conformal conic projection. The choice between the two map projections is
based on the shape of the state and its zones. States that are long in the east-west
direction are typically divided into zones that are also long east-west. These zones use
the Lambert conformal conic projection, because it is good at maintaining accuracy
along an east-west axis. Zones that are long in the north-south direction use the
Transverse Mercator projection because it is better at maintaining accuracy along a
north-south axis. The panhandle of Alaska, whose maximum dimension is on a
diagonal, uses an Oblique Mercator projection, which minimizes the combined error in
the X and Y directions.”3
The figure to the left illustrates an eight-state
region showing the NAD27 and NAD83 zones for
the SPSC. The dashed lines are county lines. The
dark orange lines within the states are the NAD27
zone lines and the light orange lines are the
NAD83 zone lines. In this example, only New
Mexico has any changes between the two datums.
(NAD27 and NAD83) Within each of these zones
there is assigned a specific projection method,
along with specific references from which grid
coordinates are measured.

One common problem in well planning is knowing which zone a surface location is in.
Of course the operators should already have recorded this, but more often than not it is
not recorded in any immediate records, so it is left up to the well planners or directional
drillers to figure it out for themselves.
TM

HawkEye makes this very easy; all you need know is what county your surface
location is located in, something that is commonly recorded in many records.

PLSS (Public Land Survey System) SYSTEM

3

From Wikipedia.com

48
HawkEye

TM

User’s Manual

Copyright © 2022 by Performance Drilling Technology

“The [PLSS] system was created by the Land Ordinance of 1785. It has been expanded
and slightly modified by Letters of Instruction and Manuals of Instruction, issued by
the General Land Office and the Bureau of Land Management and continues in use in
most of the states west of Pennsylvania, south to Florida, Alabama, and Mississippi,
west to the Pacific Ocean, and north into the Arctic in Alaska.”4
States with complete BLM (Bureau of
Land Management) coverage
Alaska, Arizona, California, Colorado,
Idaho, Montana, Nevada, New Mexico,
Oregon, Utah, Washington, Wyoming
States with limited BLM coverage
Alabama, Arkansas, Florida, Illinois,
Indiana, Kansas, Michigan, Minnesota,
Mississippi, Missouri, North Dakota
(central and western portions are
covered), Ohio, Oklahoma, South
Dakota (western part is covered).

Map shows the PLSS coverage in the US
(from Wikipedia).

This mapping system was designed to help map out the unchartered territories in a
general mathematical way. Numerous meridians were established that are the origins
from which Townships and Ranges are measured. They are the black cross hairs seen
on the above map. The map is divided up, as a general rule, into 36 one mile square
blocks referred to as Townships (not shown) and each square mile is referred to as a
Section. Sections are commonly divided into quarter sections and quarter-quarter
sections and so on. Now, if you have been involved with surveying for long it
shouldn’t be much of a surprise to find out that there are exceptions to the 36 square
mile rule. There are lots of exceptions, in fact. The boundaries of townships that butt
up to a river or a state border are truncated. Sections, in some rare cases, can actually
have the same number in the numerical reference system, but not be connected. Let’s
not stop with the confusion there. The coordinate that measures North or South of the
meridian reference line is called Township and the east-west coordinate is called Range.
So, a Township’s location nomenclature is defined by a (Township, Range) coordinate
which seems a bit confusing, but only because two different things are being called by
the same name.
Geodetics in the Rest of the World

4

From Wikipedia.com
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Different countries employ different systems and datums depending upon the
particular history of the given country. Each surface location should specify either grid
coordinates, and the associated zone, or the geographic latitudes and longitudes down
TM
to the 5th or 6th decimal place in seconds. HawkEye can accommodate most systems
used in the oil industry.
Generally, by selecting the Group, System Zone and datum, one can set up the grid
mapping system for most places in the world where the oil field operates. The most
common mapping system used in the world is the Universal Trans Mercator, or UTM.
TM
HawkEye divides this system into two groups, the Northern Hemisphere and the
Southern Hemisphere. The diagram below illustrates how the UTM overlays the world.

“The Universal Transverse
Mercator (UTM)
coordinate system is a
grid-based method of
specifying locations on the
surface of the Earth that is
a practical application of a
2-dimensional Cartesian
coordinate system. It is a
horizontal position
representation, i.e. it is used to identify locations on the earth independently of vertical
position, but differs from the traditional method of latitude and longitude in several
respects.
“The UTM system is not a single map projection. The system instead employs a series of
sixty zones, each of which is based on a specifically defined secant transverse Mercator
projection.”
HawkEye’s ability to display a map with Google Earth or Google Maps is a useful tool
for many reasons, but one of the most important reasons is that if an input is incorrect
such as a positive longitude instead of a negative longitude it will be pretty obvious if
the map puts you in the middle of China instead of the US.Geodetics in HawkEye
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GETTING TO THE PROJECT GEODETICS:
TM
Geodetics in HawkEye is handled from two different
perspectives, for projects and for individual slots. The
main geodetics dialogue for projects can be accessed
in three places:
1) By setting up the geodetics through the
Project Wizard, or
2) At any time by right-clicking on the project in the Data Tree and selecting “Set
GeoDetics,” or
3) By clicking on the Geodetics icon in the Edit tab at the top of the main screen.

SLOT GEODETICS
The other perspective of geodetics in HawkEye is by slot. To access a slot’s geodetics,
be sure to have a well currently selected under that slot, and then click the Slot Editor
button at the top of the screen. This opens up the Slot Information dialogue (which can
also be opened by right-clicking on the desired slot
in the Data Tree and selecting
“Edit Slot Data”). The Slot Editor is used to re-name a slot, as well as specify location
data.
LAUNCH GEOHAWK: The purple button at the bottom of the Slot Editor launches
GeoHAWK, which is almost exactly like the Geodetics dialogue except that the Group,
System Zone, Datum and State/County cannot be edited. It is used to allow slot
location data to be tied in with the Google Earth interface.
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CHOOSING A GROUP, OR NOT: When a
new project is started with the Project Wizard,
the user is prompted to set geodetics. At the
very top left of the Geodetics box, the dropdown menu allows this. However, if the user
does not yet have the geodetics data, the
choice “None” can be selected. This will
eliminate the display of the Easting/Northing
and the Lat/Long fields in the Slot Editor
dialogue, thereby making location interaction
simpler, at least until the geodetics can be
entered for the project later.
DON’T SWITCH IT UP: Since each of these above-mentioned groups has different sets
of valid locations, switching between groups is not recommended. Conflicting
coordinates as paired with invalid groups will likely crash HawkEye and you may lose
all unsaved project data. Best bet is to put the geodetics information in right the first
time.
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SET STATE AND COUNTY: One powerful method available to help accelerate
determining what the proper State Plane to use is the State/County-> Set tool. The
control box is located in the upper central part of the Geodetics dialog. To use this,
select the State and County where the rig site is located.

Then, be sure to click the “Set” button after selecting the desired county. You will note
that the program has now automatically selected the proper State Plane and System
Zone associated with that county.The coordinates that have been automatically entered
for the Lats and Longs and Northings and Eastings are the default values for that
county, normally the center of the county.
CHOOSE INPUT: You should select the radio
button for either the INPUT GRID or INPUT
Lat/Long and enter in the associated site values. The
program will determine all corresponding numbers
and if you are connected to the internet Google
Maps and Google Earth will display the location in
the Map tab to the right of the screen.

2. HawkEye’s PLSS Support
HawkEyeTM is the only directional drilling program to date that provides powerful
PLSS (Public Land Survey System) support, allowing Township, Range, Section and
Section calls to be input and in return get the geographic and State Plane coordinates.
Also, geographic coordinates (Lat, Long) can be input and the program will determine
the Township, Range, Section, State, County, State Plane Zone and Grid coordinates,
and a set of section calls. In addition to that you can automatically create lease lines
that show up in the 3D space, charts and presentation plots.
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The above screenshot of the geodetics illustrates HawkEye’s PLSS capabilities (older
version of the dialogue). The thick black line represents a county line, in this case
Arapaho County, Colorado. The blue line represents the Township, the red border
represents the Section, Sec 4. The white borders with the yellow thumbtacks are
showing all the other sections of the given township. (Invoked by checking the “Show
Sections” box).
The complete legal description of the location is Sec4-R62W-T5S 2626.52 FEL, 2607.71
FNL. Translated—Section 4, Range 62 West, Township5 South - Section Call: 2626.52
feet East from East line, 2607.71 feet from North Line.
The screenshot below illustrates the same location, but this time the ‘Show Sections’ is
turned off and the thumbtack in Google Earth has been clicked, illustrating all of the
different methods of referring to the same location in the white info box.
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For users who need to routinely work with TSR coordinates and section calls in the
western states this is an invaluable tool.

PLSS INPUTS: With certain states, the user may have the option to input the TRS5 data
directly. These additional fields, under the “Input Map” radio button and
compromising the bottom half of the whole panel, are only available in about eleven
states. So when choosing a state and county for the project, these inputs may well not
appear in the Geodetics editor.
A FEW QUIRKS: When using the PLSS fields, it is important to remember a few
peculiarities about the state survey data. First, each state may have more than one
Meridian. Be sure to choose the right meridian when inputting PLSS data.

5

(TRS) Township, Range, Section
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Second, the Township and Range can be selected by number from a dropdown menu,
but the North/South and East/West must be chosen first for each of them. This is
because the list of available townships and ranges are different between east, west,
north and south.
PLSS OFFSETS: Users can enter offsets in the
PLSS data set. Be sure to select the correct
reference from the pulldown menu for both the X
and Y offsets. FEL is “From East Line.” Thus
“FWL, FNL, FSL.”
In this particular example, you can see the offset
noted by the bottom right thumbtack. It shows a
location 1000 feet (FEL) From East Line and 500 feet
(FSL) From South Line. This is shown in the Google
Earth interface. If you click on the thumbtack itself, a
pop-up will appear, displaying all relevant map
data, as illustrated on the previous page.
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3. Google Earth Support
HawkEyeTM can superimpose the 3D curves of a project onto a Google Earth. Make sure
to have the Google Earth program installed. Find the link to download the program for
free at http://earth.google.com.
The Google Earth module will do two
principle things. First, it will illustrate
over a satellite image of the planet’s
surface
any
geodetically
section
information defined in a project. This
boundary is illustrated with a green line
and offset with a white line:
The second function of the module is to illustrate the scope and location of a project visà-vis its location in a zone. The project information that is displayed on the surface map
appears to sit aboveground, although obviously any well would be underground.

With only 3D Curves toggled on,
the well will be displayed as ending
at the surface of the planet and
extending upwards to the sky with
a 1:1 scale.

With both 3D and 2D Curves on, a
path along the surface will illustrate
where the curve walks along the
surface as well as the 3D curve
going upward.
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The Google Earth module requires that Google
Earth be installed. It will also require a live
internet connection to run. Download the program
for free at http://earth.google.com

One major setting to keep in mind is the 2D and 3D Curves toggle, found in the bottom
left options tree.
By turning on both 2D and 3D Curves, the image will display not only the image of the
well with the bottom touching the surface and extending to the sky, but also a line of
where the curve travels with respect to the surface.

GOOGLE AND HAWKEYE GEODETICS: As noted in the above section on Geodetics,
Google Earth is intergrated as an API inside of the HawkEye geodetics dialogue.
Although it is not crucial for entering and editing geodetics information, Google Earth
does a tremendous job in helping the user visualize coordinates and other map
parameters as they are entered into the program.
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Presentation Plots (Well Planning Version)
This icon launches the Presentation Plots module, which is covered in the
Plots chapter of this book and which is only available in the Well Planning
version of the program.

Structure Manager
The Structure Manager, which is only available in the Well Planning Version
of HawkEye, is used to start a multiple-slot project quickly. It organizes any
number of initial slot points and numbers them in a user-defined pattern.
Their positions can be defined by any of the possible patterns found in the field, and can
save a lot of time in getting the slots made in the project database.
OPEN THE STRUCTURE MANAGER: Right-click on the Structure
icon
found in the Data Tree on the lefthand side of the main screen.
This will open up the Structure submenu.
Select the Structure Manager
from this list. The slots made from
here will be associated with that structure that was right-clicked on.
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The panel on the right-hand side of the Structure Manager is dedicated to the placement
and labeling of the slots:
GROUP STYLE: The general orientation of
the slot group can be rectangular, circular
or custom. (NOTE: Custom option is not
available in current version).

LABEL STYLE, ORDER & DIRECTION:
These options create the way the slots are
numbered, and cover all iterations of
sequential labeling for rectangular and
circular slot groups. The START CORNER
radio buttons determine where the
sequential labeling begins. Additionally,
the slider in the bottom left corner of the
picture window toggles label orientation.
SIZING: Bearing and distance between each slot can be defined here.
ASSOCIATE WITH: Any of the slots can be designated as the Reference Slot, and that
Reference Slot can be associated with either another slot or the current structure. The
Reference Slot can also be given a coordinate offset.
EXCEL: Once a slot group has been set up,
click the “EXCEL” button and the slot
coordinates will be exported into an Excel
spreadsheet, complete with a floating
picture of the slots that can be placed
anywhere on the spreadsheet.
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ADD GROUP: Any set of slot parameters can be saved as a custom group by clicking
on the “Add Group” button at the top of the Manager.

CLICK “SAVE” FIRST: Once a structure’s slots are
labeled and oriented, click the SAVE button. Then click
“APPLY TO SLOTS.” This will close out the Structure
Manager and begin building each slot under the current
structure. Those slots will appear in the 3D space as well
as in the Data Tree.
Each newly made slot will have a survey and proposal
curve named after its slot label.

NOTE: After a slot group has been made and curves built from the respective slots,
going back to change the orientation and labeling of the slots in the Structure Manager
is not recommended. Thus it is best to get the details of the slots correct before
beginning to build curves from any of the slots created.
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Snapshot
This feature is specifically for
Presentation Plots (Well Planning
version). It allows the user to capture
3D images for use in the “multishot” element of
a wall plot.

Display Settings
This opens the Display Settings tab, which is covered at the end of this
subsection under Settings Tab.
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d. 3D Screen tab

The 3D Screen tab at the top of the main screen displays some options for the 3D space.
This will toggle on and off Comments and Annotations for
all curves in the 3D space. Comments will show up in a
Critical Points report, while Annotations will only show up
in the 3D space and nowhere else. You can click this “Create Anno.” button to create an
annotation at wherever your current Look-At Point is on the curve in the 3D space.

Toggle various 3D visual aid elements
with these boxes.

Transparency of all curves, as well as your Zoom Factor
are controlled here. NOTE: Your zoom is also controlled
by holding down the right mouse button and moving the
mouse wheel up and down.
These control how all Lease and Hard Lines are
displayed. To turn off individual Lines,
uncheck them in the Data Tree.
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e. Tools tab

Google Earth
Google Earth is a separate program, and HawkEye uses its API (a software
plugin) to display the current Project’s curves and hard/lease lines on satellite
imagery of the location based on the Project’s geodetic information.
NOTE: This plugin feature only works after geodetic information has been entered in
the Project’s geodetics dialogue. Get to that editor by right-clicking on the Project in the
Data Tree and selecting “Set Geodetics.”

Interpolation Tool
Interpolation is a method of constructing new data points within the range of
TM
a discrete set of known data points. In HawkEye , the Interpolation tool
allows the user to either merely CALL FOR A SURVEY ENTRY into a list one
at a time, or to go ahead and use an interpolation point as a TIE-IN POINT for a
sidetrack curve.
Once inside the panel, there are two major
choices: 1) to invoke either an MD or a TVD
interpolation, and 2) whether to merely
have that interpolation point or to use the
point as a tie-in for a sidetrack curve.
The first step is to enter either the MD or
TVD depth in the top left. Then hit TAB and
TM
HawkEye will calculate the interpolation,
filling in all the data down the middle
“Interpolate” column. The columns to the
left and right are survey stations displayed
for reference.

The Interpolation panel breaks down
into two choices at the top: 1) MD or
TVD as the mode of measurement,
and 2) either insert the interpolation
or make it tie-in for a sidetrack curve.
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The second step is to decide whether to INSERT
that interpolation into the survey list, which only
requires clicking on the “Insert” button; or
making that interpolated point a tie-in point for a
sidetrack curve.
By clicking on the “Make Tie In” button, a
dialogue will appear for creating a new curve
and you can enter the parameters for a sidetrack
proposal. Once created, it will appear in the Data
Tree just like any other proposal curve, with all
the attendant options associated with it.
Interpolating from Lists: The interpolation tool includes two options for interpolating
surveys directly from simple text files that could be set up with NotePad or WordPad.
Simply input MD or TVD, (comma) comment or formation top, whatever. Input as
many lines as you need, then save the file. You can use that file on other curves and
save yourself the hassle of interpolating tops for each iteration of a what-if scenario
being played out with geologists and drilling engineers that keep changing
specifications.

Torque and Drag
This is a 3rd party module that optionally comes with HawkEye Field and
always comes with HawkEye Well Planning. The final chapter of this manual
covers the functionality of this program. If you do not see this icon, then your
license does not contain the rights to this particular module.

.IPM Survey Tool Manager
The Survey Tool Manager is an interface for importing or exporting advanced
error modeling files. These files are usually provided by engineers who are
familiar with the schema and are generally not tweaked from within
HawkEye, although they may if the user is knowledgeable and comfortable with the
parameters.
OPENING THE MANAGER: The Survey Tool Manager is found in the Tools tab in the
top middle of the main screen.
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On the lefthand side of the Survey Tools Manager is a tree-style list of the different
models being implemented. Along the top are the fields displaying:
• Vendor (dropdown list)
• Short Name
• Description
IMPORT/EXPORT: The Survey Tool Manager works with the industry standard .ipm
files, which may be imported or exported.
DEFAULT SURVEY TYPE: Choose from Magnetic, Gyro, or unknown.
TEMPLATE: Choose from a dropdown list of available .ipm files to load an ISCWSA
template.
LOCK/DEFAULT: Check either of these buttons to lock in the current template
selection and to make the selection your default, respectively.

NOTE: It is not recommended to change or alter the tool profiles in the Survey Tool
Manager unless you understand the various parameters. Since the error models are
highly mathematical and settings dependent on one another, simple mistakes could
render the error model that you are using unusable or worse.
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Refresh Model
This will force the program to recalculate all uncertainty calculations and
refresh the 3D space. The program will normally do this automatically but
sometimes after adding/editing a survey, it might need refreshing.

Error (Uncertainty) Display Options
This opens a menu from which you
can choose a variety of visual modes
for the zones of uncertainty in the
program. Each of these options is based on
the same calculations, and those calculations
are based on whichever Survey Tool you
have chosen for the surveys. The hotkeys for
quickly toggling through each of these view modes is in brackets.

Advanced Error (Uncertainty) Display Options
This opens a menu of more advanced zone-ofuncertainty view options for the 3D space.
LD: Least Distance
NE: North-East
HL: Highside-Lateral
All uncertainty displays in the 3D space are based on the
Survey Tools listed for each survey, which themselves are
based on .IPM error models associated with that tool.
ISCWSA SIGMA: Adjusting this value controls the confidence level to be calculated by
the ISCWSA model. For example, let’s say the confidence level is 95%, or 2 sigma in
statistics jargon. What this means is an ellipsoid displayed along the well will illustrate
the volume for which we have 95% certainty that the true survey point is in that
volume. The larger the confidence level, the bigger the ellipsoid. Most operators use
two sigma or three sigma confidence levels, two sigma being the most common.
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From Curve Controls

The “From Curve” tool allows you to create an
entirely new curve based on the position of an
existing curve. This new curve, once created, will
show up in the Data Tree as a special “f” curve
nested under the parent curve.

68
HawkEye

TM

User’s Manual

Copyright © 2022 by Performance Drilling Technology

f. Settings tab

The Settings tab contains almost all non 3D-space settings, mostly pertaining to the 2D
spaces (VS Ciew and Top View). You can easily see the categories by looking for the
white text on blue backgrounds at the bottom of each subsection.
3-Panel Interface toggles the main screen’s mode. Three
panels include both main windows as well as the Survey
List Panel on the bottom right. Otherwise it’s just the two
main windows without the survey window.
Remote View: This opens a dialogue that allows the user
to adjust visual settings to accommodate remote access to
the computer. Sometimes the 3D space will be too sensitive to mouse controls and
appear “jumpy.” Options here help to allieviate that issue.
Survey Grid: This opens the Grid Manager, which allows the user to customize the
appearance and the columns of the Survey List Panel (which is only visible when 3Panel Interface is turned on). You can also access this Grid Manager by right-clicking on
the colored header of the Survey List Panel itself and selecting “Grid Manager.”
Auto Comments: This will automatically create comments
at every “critical point” in a curve. NOTE: This is intended
for Proposal curves that generally have clean geometry
except for a few points (e.g. KOP, Landing, TD). If you click
Auto Comments for an as-drilled curve, the program will
likely regard every survey as a critical point.
Clear Comments: This will erase ALL comments for the current curve. There is no
Undo function in this program, so be careful.
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Show tips at startup: This refers to startup tips that are no longer active in HawkEye
Autosave: Set the frequency at which you want the program to save survey data to the
current HawkEye database.
Projection Interval length: Set the length between surveys when creating projections.
Include structures: Set the radius from the current structure/pad within which other
structure/pads in the project are to be displayed in the 3D space.

Target & Casing Comments: These
parameters control the appearance
of the Target and Casing comments
that float next to those objects in
the 3D space.

Information Text: These parameters control
the appearance of the text found at the top left
of the 3D space. You can toggle that
information on and off by pressing “I” while
the mouse cursor is hovering in the 3D space.
The parameters shown at left here are optimal
for viewing this information Not all combinations of parameters will yield legibility.

3D Axis Font: These parameters control the text shown
along the axis of the floor and walls of the 3D space.
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Charts Axis Font: These parameters control the
appearance of the axis labels in the 2D views (VS and Top
tabs).

3D Cage Wall Colors: These
parameters control the colors of the 3D
space’s background “walls” and
“floor.” The color selections are not
straightforward, as they blend with the
“BG Color” that is also selectable here.

Label Manager: This opens a separate dialogue that allows
the full control of labels in the 2D views (VS and Top tabs).

VS and TOP VIEW:
Check any of these boxes
to toggle the particular
label to show up in the
2D VS view and 2D top
view.
AUTO LABEL
FREQUENCY: This
section relates to how
often you want to have a
label generated in the
plot. For now the only
option is to select every X number of surveys. However, by MD and by TVD every X
number of feet or meters should be available in future versions.
SCOPE TO APPLY: This controls to which curves the labeling schema is to be applied,
whether it is to all curves or just the proposal curve and or the current work curve.
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TEXT PROPERTIES: This section of the panel controls all of the features of the lettering
as they are found in the 3D space. To change the fonts, select the “Axis Labels” tab at
the top of the panel and click on the “3D Axis Font…” button.
VS VIEW EXAGGERATION: Exaggeration increases the Y-axis interval, which is
useful for horizontal wells when trying to better fit the entire well in the graph. The
exaggeration is by ratio, so if “1” is 100ft/division, then “2” would be 50ft/division, and
“3” would be 33 ft/division.
BOTH PLOTS: Check any of these boxes to toggle the described features which are
applied to both the VS View and Top View graphs.

NO GRID: This will remove all background lines in the 2D
views (VS and Top tabs).
MAJOR LINE TYPE: This controls the draw type of the
background grid’s major grid lines.
MINOR LINE TYPE: When “Major Minor” is selected in the Display Grid, these
settings will control the draw type and characteristics of the many smaller, minor lines.
Unless the user wants a blotting effect in the background, it is best to keep these lines
thin and light in color.

Major Line Type: Controls the color and style of the
Major lines in the 2D views (VS and Top tabs).

Minor Line Type: Controls the color and style of the
Minor lines in the 2D views (VS and Top tabs).
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Top View Axis Labels: Rename the axis labels that appear
on the outside of the Top view (Top tab).

VSP View: Rename the axis labels
that appear on the outside of the VSP
(“Vertical Section Plane”) view (VS
tab).
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g. Help tab

The “Help” tab on the top right of the main screen gives access to the following:
•

The Update button to check for updates

•

Open a hotkey map (keyboard shortcuts for the program)

•

A link to the Quickstart Guide (16 pages)

•

A link to the User’s Guide (this document)
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7. Main Window Tabs

The tops of the two main windows have tabs that can switch the view mode of those
windows.

a. 3D View
The 3D view is open by default on the right-hand window of the main screen. You may
need to adjust the window size by dragging the left-hand border to the left to maximize
the 3D window.

Navigation tools in the 3D space are many and powerful, and they are discussed in
detail in the next section. But here are a few key mouse-based tools to remember:
FUNCTION
Zoom in and out
Pan
Move slider
Access context menu

MOUSE CONTROL
Hold right button and scroll wheel up and down
Hold left button and move mouse around
Move scroll wheel up and down
Right-click on the object (curve, target, plane or background)
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The main options for operating the 3D space are found at the bottom of the 3D window
against the blue background.

It is important to get acquainted with each of these tools, but often the quickest way is
TM
to experiment with them in HawkEye . Switching between work and proposal curve is
utterly essential, as is the zooming tool, but learning the different grid and ellipsis
modes will also greatly enhance the user’s abilities to visualize the space around the
well.

Work Mode/ Proposal Mode Toggle: Left-click this button to
switch between Work Mode or Proposal Mode. NOTE: There
can be only one “Current” work curve and one “Current”
proposal curve to follow at a time. To set a new “current”
curve, just right-click on the curve and select “Set as Current
Work/Proposal Curve.” OR, press “Z” to switch modes while
cursor is in the 3D space.
Driller’s View/ Highside Up: Left-click to reset “Driller’s
View,” which always switches to Work Mode on the current
work curve, turns the Highside Up mode on, and puts the
view at the latest survey station.
Sight Editor: Left-click on this to open the Sight Editor. You
can also toggle on and off the sight in the 3D space with the
spacebar (cursor needs to be hovering over 3D space). With
the sight on in the 3D, right-click on the sight and select
“Sight Editor.” There is a custom sight for the current Work
curve as well as the current Proposal curve.
Sight Toggles: Check and uncheck these to turn on and off
the two sights (one for the current Work Curve and the other
for the Curve Proposal (Plan) Curve).
Highside toggle: Turn on or off the Highside Always Up
mode of view.
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Look-at Point Depth (MD): In the 3D space, the Look-at
Point (POV) is only ever at one point on a curve that can be
slid up and down with the wheel.

This is where the Look-at Point is located wherever it is on a
curve, defined by current MD. The user can type in the MD,
then hit TAB to update.
Look-at Point Depth (TVD): The depth of the Look-at Point,
displayed by TVD here.
NOTE: These depths are also displayed in the top left of the
3D space (Press “I” when cursor is in the 3D space). The user
can type in the TVD they want to be at, then press Tab to
update.
Step Interval: This sets the distance of each mouse wheel
“click” when gliding up and down the curve. Even with the
hyperscroll mouse, it takes a lot of spinning traverse the
length of a curve at 1 ft per iteration. But sometimes that’s
what is needed for precision navigation. Choose from the
step speeds: 1, 2, 5, 10, 20, 30, 50, 100.
Step Slider: This is a way to move the sight up and down the
curve aside from the scroll button on the mouse, or W,S or
UP, DOWN keys. This slider become more sensitive as the
curve gets longer because the ends of the slider are always
the top and bottom of the curve. Click either end to skip to
the very beginning or end of the curve.
Curve Menu: Left-clicking this button is the manual version
of RIGHT-CLICKING on a curve in the 3D space or Data
Tree. It will bring up the contextual menu for whichever is
the current curve. This is useful when the MD or TVD
specified is exactly what is desired.
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b. Vertical Section (VS) View

This is the view that one would have of a
well from the side. The view plane is by
default 90 degrees from the proposed
bottom hole location. The direction which is
used to set the Vertical Section Plane (VSP)
is the closure direction between the surface
location and the end of the well.
Exaggeration decreases the Y-axis interval,
which is useful for horizontal wells when
trying to better fit the entire well in the
graph. The exaggeration is by ratio, so if “1”
is 100ft/division, then “2” would be
50ft/division, and “3” would be 33
ft/division.
The icon on the top left

will open the Graphics Properties panel.

The Presentation Plot icon next to it
will open the Presentation Plot module of
HawkEyeTM, with the current Vertical Section view at front and center. (Well Planning
version only).
PAN: Holding down the RIGHT mouse button on the 2D window and dragging the
cursor around will move the orientation of the grid, allowing the user to navigate along
a curve or otherwise change a view perspective along the graph’s plane.
ZOOM: Holding down the left mouse button to draw a box onto the graph will zoom
the graph into that area. Hold down the right mouse button and scroll the mouse wheel
up and down to zoom.

78
HawkEye

TM

User’s Manual

Copyright © 2022 by Performance Drilling Technology

c. Top View

Also referred to as a horizontal view,
the Top View is as if looking at the
well from above, with north oriented
to the top.
The icon on the top left
will open
the Graphics Properties panel.
The Presentation Plot icon next to it
will open the Presentation Plot
TM
module of HawkEye , with the
current top view at front and center.
(Well Planning version only)
PAN: Holding down the RIGHT
mouse button on the 2D window and
dragging the cursor around will move
the orientation of the grid.
ZOOM: Holding down the left mouse
button to draw a box onto the graph will zoom the graph into that area. Hold down the
right mouse button and scroll the mouse wheel up and down to zoom.
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d. Proximity
This plot shows the distance from
the reference well (oriented in the
center) to the other wells.
CALCULATE PROXIMITY BOX: In
order to “turn on” this plot, you
have to check the “Calculate
Proximity” box. This will activate
the relatively resource-consuming
calculations. This can also be done
by clicking on the blank circle plot
itself.
REFERENCED CURVE: This is a display-only box that indicates which curve is the
referenced curve that is shown as the center point of the plot. Change the reference
curve by changing the current curve selected for the 3D space.
SCALE: Set the radius within which distances between curves is analyzed.

THREE TYPES OF DISTANCES:
TRUE: The closest distance from the reference point to any other well, regardless of
what plane it is in. Some references regard this as the “closest spherical distance.” It is
important to have this distance type turned on when you are approaching a well, as it is
the only tool that can pick up a head on collision with another well.
NORMAL: The plane that the distance is measured on is the plane which is
perpendicular to the direction vector where you are currently aimed (current MD, Inc
and Azm). This distance is often the most useful when directional drilling; knowing
how much to the left or right, or up and down one is determined with this tool. NOTE:
This is the distance type used when adding a UD and RL column to a survey report.
TVD: The distance measured along the horizontal plane at the TVD of the current
reference well location. In vertical wells this tool is most useful.
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LEASE LINE DISTANCE: Turning this on will measure the distance to any active lease
or hard lines. It will display any user-set offset distance to the lease line, as well as the
boundary line distance. The proximity information generated here is displayed in the
3D info field in the upper left corner of the 3D space. This distances displayed will
have an ‘O’ and a ‘B’ appended to the end. The ‘O’ represents the offset boundary from
the lease line and the ‘B’ represents the actual boundary itself. Only the closest
boundary point data is displayed.
You can see a thin line in the 3D space connecting the current point with the boundary
lines. (To turn on 3D Info, just open the Graphics Properties panel and select the “3D
Options” tab, and click the “Show 3d Info” box).
NOTE- North Arrow v. High Side Arrow:
When following along the reference curve,
the Proximity plot will stay oriented to north
(as indicated by red the arrow pointing up
labeled “North”), but when the look-at point
reaches an inclination greater than 1.5
degrees, a black highside arrow will appear to
indicate the orientation of the plot, and the
red north arrow will remain.
NS/EW and UD/LR: If the look-at point along
the curve is somewhere under the inclination
threshold (set in the Sight Editor on the
bottom right of the form), then distances to
the curves will be expressed in terms of North/South or East/West of that curve. When
the look-at point reaches an inclination higher than the threshold, then distances are
displayed as Up/Down and East/West of the curve.
Distance Lines: When “Calculate Proximity” is turned on, distance lines will appear in
the 3D space to illustrate the distances calculated in the plot. They are color coded red
and black for true distance, Blue and Black for normal distance, and Cyan and Black for
TVD distance.
TIP: To get to a specific look-at point for particular proximity analysis, just type in the
MD or TVD into the forms then press Tab in the bottom left just below the 3D window.
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PROXIMITY INFOCARD: By left-clicking on any of the Distance Lines, an Infocard
appears containing all the relevant information of that particular distance calculation
from that particular point to the other well.

IN-DEPTH ON THE PROXIMITY LINES:
The directional driller has two references for orienting his drilling motor; the one he
uses depends upon the last measured inclination. If the inclination is above a certain
low value, normally 2 - 5 degrees inclination, then he orients his motor to high side.
(The most intuitive way to think of high side is that it is the way you like airplanes to be
flown, right side up – that’s high side in oil field jargon).
Otherwise he orients his motor to the magnetic direction that he wants to move
towards. The MWD tool will control the switchover, so when the DD sees an
inclination above the Magnetic-Gravity Tool face value he knows that all the tool faces
being sent are gravity tool face. The fact is that this is one piece of operational
information that must be monitored carefully when sliding at low angles.

In the snapshot of the Proximity Infocard shown below there are two types of proximity
described. The following is a description of how to interpret this card. The first
proximity type is the proximity to a well and the second proximity type is Next POI
(short for Point of Interest).
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PROXIMITY – Sight set to [Normal Plane\TVD Plane] or [Gravity TF\Magnetic TF]
This can represent the proximity between the reference well and any other well
in the project, depending on which Proximity Line you clicked on.
Type: [True Minimum\Normal Plane\TVD]
This represents the type of proximity values being displayed. The True
Minimum values are illustrated by the yellow and black checkered connection
bars in the 3D space. The Normal Plane is illustrated by the green and black
striped connection bars, and the TVD plane connectors are represented by the
Blue and Black lines. The user selects one or all types of proximity under the
Proximity tab. It is best to use True Minimum, but the other two are useful under
different circumstances.
Reference: Reference well name @ X MD, Inc: X, Azm: X
This is the name of the reference well and the current point.
Comparison: Name of comparison well and MD point of comparison
Distance: Straight line distance for type of distance X
Separation Factor: N\A Sigma: N\A
If separation factor is being calculated the current value and the current Sigma
will be displayed here.
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For Gravity Tool Face the distances are described:
Reference is X Above or Below the comparison curve
Reference is X Left or Right of the comparison curve
Reference is X is in Front of or Behind the comparison curve
For Magnetic Tool Face the distances are described:
Reference is X North or South of the comparison curve
Reference is X East or West of the comparison curve
Reference is X in Front of or Behind the comparison curve
When vertical or near vertical (when magnetic tool face is used), it is easiest to
explain relative positions in terms of normal geographic terms such of NorthSouth and East-West. At higher angles, when gravity tool face is used, the
geographic terms become less useful for orientation and steering, so the plane
perpendicular to the direction being drilled (the normal plane) is used as the
steering guide. The easiest way to describe orientation relative to this plane is by
describing it in local human terms, Above-Below, Left Right, in Front and
Behind. The normal plane proximity will always lie on the normal plane, the
TVD plane proximity will always lie on the TVD plane and the True Minimum
proximity will be off those planes almost always. The local descriptions of the
true minimum are projected to the normal plane.

NEXT POI: Points of Interest are defined by the comments that are included on the
Proposal curve. A POI can be a kick off point or the top of a formation or any other
survey that has a comment. The only time this proximity is displayed is when the
current curve is the work curve and there is a plan curve and the plan curve has
comments. Hawkeye will automatically search for the next point of interest and
display how far away it is from the normal plane defined by the inclination and
azimuth at the point of interest.
The primary purpose of this is to allow for the users to have a heads-up about what is
next in line, be that a formation top, casing point, or a critical point in the plan.
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e. Ladder Plot
The Ladder Plot is another way of
visualizing the distances between
curves. This type of plot is also referred
to as an ‘MD vs Distance’ plot.
The distance of each curve is plotted in
the vertical scale as a function of the MD
(measured depth).
If the two lines overlap one another that
should be interpreted as a potential
collision problem.
The advantage of this type of plot is that
one can instantly spot problem areas by
noting the points at which the curves
dip down near the baseline.
REFERENCED CURVE: Select the
curve to be the baseline reference with
this drop-down menu. The dropdown menu contains all curves in a project.
MAX DISTANCE: This is the observed radius from the reference curve, the distance at
which HawkEyeTM will stop plotting a curve.
COMPARED CURVES: This drop-down will allow the user to check off each or all the
curves to be compared.
REFRESH: Hit this button to recalculate any changes made to the Ladder Plot
parameters.
DOUBLE-CLICK TO FULL SCREEN: Double-click on this chart to maximize it and get
the color legend that identifies each curve by color.
DOTTED LINES: The dotted lines in a chart represent the outer boundary of
uncertainty for a given curve.

85
HawkEye

TM

User’s Manual

Copyright © 2022 by Performance Drilling Technology

f. Alerts
The Alerts tab in the bottom right of the
main screen provides a criticality number
between 1 and 5, with 5 being the most
dangerous, according to certain rulesets
that are defined by different companies, in
reference to proximity. Center-to-center
distance between wells, and ellipses of
uncertainty (calculated by ISCWSA error
model) are used to calculate proximities.
SAFETY RULESETS are chosen at the start of making a project and can be edited at any
time by RIGHT-CLICKING on a project in the Data Tree on the left, then selecting “Edit
Project” and choosing from the drop-down menu labeled “Safety Ruleset.”
Directional Drillers and drilling engineers should play close attention to Alerts when
drilling in a crowded area.
CRITICALITY LEVELS:
Criticality Comment
1
Nothing to worry about, proceed drilling.
2
Monitor separation factor as drilling proceeds.
3
Caution, continuously monitor Distance both onshore and offshore.
Review the action plan for the possibility that the separation factor falls
below 1.5.
4
Drilling operations should take swift, positive action to change drilling
direction, increase survey accuracy or other actions to increase the
separation factor.
5
Stop drilling. You are in a very high risk situation.
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g. Surveys
One of the primary regions on the main screen is the survey grid at the bottom. It
displays all the survey information for the currently selected path and has a
customizable data spread that behaves like a spreadsheet application.

TM

The surveys in HawkEye are displayed in the default main screen along the
bottom. The window provides a wide spread of customizable information fields.
CUSTOMIZE COLUMN ORDER AND FREEZE FRAMES: The data columns can be
moved left and right by clicking and dragging the column header and dropping it
wherever desired. In addition, there is a freeze frame stop control that can also be
dropped between any two columns in order to
“freeze” all columns to the left such that when the
horizontal scroll bar is used, only the columns to
the right are moved.
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The full spread of data in the survey window is extensive, offering 46 different types of
data for each survey entry. The following is a list of the data displayed for each survey:
List of Survey Data Columns
No.
BHA ID
MD
Azm Deg
Inc Deg
Closure Dir Deg Closure
NS
EW
TVD
Comment
NN (ft2) *
EE (ft2) *
VV (ft2) *
NE (ft2) *
NV (ft2) *
EV (ft2) *
HH (ft2) *
LL (ft2) *
AA (ft2) *
HL (ft2) *
HA (ft2) *
LA (ft2) *
Minor
Major
Minor
Azm
Deg
Vertical
HLA Major
HLA Minor
HLA Depth
HLA Azm Deg Survey Type
Subsea
DLS °/100
Build Rate °/100
Walk Rate °/100 VS
TFA Deg
Easting
Northing
Latitude Deg
Latitude DMS
Longitude Deg Longitude DMS RKB
CL
* Measurements may be in feet or meters, depending on project settings.

BEST WAY TO ADD SURVEYS ONE BY ONE: Click the blue plus icon on the far left
in the row of projection icons to open the Survey Editor. In this dialogue all of the
surveys for the currently selected well will appear, and several of their parameters may
be edited.
The BEST WAY to add a survey is,
once inside the Survey Editor, type the
Measured Depth, press ENTER, then
type in the Inclination, press ENTER,
and then type in the Azimuth and
press ENTER. After the third
“ENTER,” your new survey will have
been created.
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1. Copy and Paste Surveys
Surveys can be imported in HawkEyeTM or they can be added and edited manually
within the program. One simple way to import surveys into HawkEyeTM is to copy them
from a spreadsheet and paste them directly into the survey window.
STEP 1 Grab the data from the spreadsheet
by selecting it and copying (Ctrl+C or
right-click and select “Copy”).
NOTE: HawkEyeTM will accept
spreadsheet data from Microsoft
Excel, OpenOffice and all other
common spreadsheet programs.
IMPORTANT: Spreadsheet column
order must be in MD, INC and then
AZM from left to right in order to
paste properly in HawkEyeTM.
STEP 2 Select a curve from either the Data Tree or the Project Control
Panel. NOTE: The surface location of the curve must already be
established. The recommended method to choose a curve is to
use the Project Control Panel. Just left-click once on a curve in the
Projection Control Panel to select it. This will bring up the
surveys for that curve at the bottom of the main screen.
STEP 3 Paste the data into the curve’s survey list by
RIGHT-CLICKING anywhere in the Survey
List Window, then selecting “Paste Data.”

As long as the data columns were arranged in
the right order in the original spreadsheet
(MD, INC then AZM), then HawkEyeTM will
take that data, extrapolate all additional data
and display the curve information in the 3D
space.
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USE THE RIGHT-CLICK MENU: Another way of bringing in more than one survey at
a time is to import them directly into the curve data via the Curve right-click menu.
This context menu can be accessed directly in the 3D space, Data Tree or the Project
Control Panel by RIGHT-CLICKING on a curve. Depending upon the context in which
this menu is invoked the contents will be more or less as you see them here.
If it is a work curve you see, then the “Set as Work Curve” will be the first item instead
of “Set as Proposal Curve.” You can change the color, clear all the comments, Autocomment a curve, add surveys and so on. You should have already become somewhat
familiar with most of the items and they are self-explanatory for the most part.
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2. Importing and Exporting
Worthy of special mention in the curve right-click contextual menu are the Export and
Import options. Surveys can be exported to five types of files. NOTE: Any additional
standard formats that may be required can be included per request by the user.
3. CSV files – Comma, Space or Tab Delimited files that can be easily
imported into spreadsheets and databases.
4. SAY files – A special survey format that works with PDT’s other survey
products, WinServeTM and WinSurv2TM.
5. MMS files – A special survey format that for the Mineral and Mines
Service in the United States.
6. DIMMS files – A special file format to supply survey data to DIMMS, a
Landmark rig reporting system.
7. CompassTM files- The import options on the menu should be fairly
obvious. However, one very important option is not on the menu and
that is the import of a CompassTM transfer file.

3. Importing a Compass Transfer File
CompassTM is a widely used Landmark product. This software is similar in function to
HawkEyeTM and can export a variety of XML transfer files for use within CompassTM.
HawkEyeTM uses the .EDM.XML transfer file.
If you are a user of CompassTM, or a company you are working with is a user of
CompassTM and you want to get all of that data on a given project into HawkEyeTM, then
create an EDM.XML transfer file in CompassTM. Then drag and drop that file directly
on top of HawkEye’s 3D space and if all goes well you will have all the surveys,
geodetics, lithologies, targets and casings in HawkEyeTM. You can also navigate to the
following:

91
HawkEye

TM

User’s Manual

Copyright © 2022 by Performance Drilling Technology

II.

PROJECT DATA
RIGHT-CLICK ON EVERYTHING

CUTTING TO THE CHASE: Although the functionality of adding various tiers of
data into the Data Tree is explained below, a useful general shortcut that must be
TM
mentioned is that HawkEye is all about right-click menus. Most objects on the
TM
screen in HawkEye have a contextual menu that can be accessed by right-clicking
TM
on it. In these menus lie the power of HawkEye , where things can be added,
edited, deleted, and where relevant jumps to other dialogues and control panels are
always found.

1. ADDING BASIC PROJECT DATA
Although the New Project Wizard is great for getting started, the user will inevitably
have to dive into the Data Tree and add things like slots and curves. But doing so is an
intuitive process.

a. Adding Projects and Structures
ADDING FIELD/COMPANY: Starting from
the top, in order to add a new Field to the
currently open database, right-click on the
FIELDS/PROJECTS label at the very top of the
Data Tree and select “Add New Field.”

This opens up a small dialogue in which you can
enter the Field Name and the Location. Location as
entered in this dialogue is not used anywhere in the
program, but it is a useful reference datum.
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ADDING PROJECT: Once a new Field is added, right-click on
that field in the Data Tree and select “Add New Project.” This
will pull up the Project Information dialogue, where name,
units and other basic relevant data can be added. Geodetics can
also be set from this dialogue.
NOTE: If you don’t want to set geodetics
just yet, you can do it later, but you still
have to go into the Geodetics dialogue and
then Save and Exit in order to finish the
Project Information dialogue.
ELEVATION (To Mean Sea Level) :
The current version allows only one mode
of elevation, which is the structure’s
elevation plus the RKB height.
TM

Once a Project is created here, HawkEye
will provide a default Structure/Pad, Site/Slot, dummy Well Path and First Target. The
dummy surveys are placeholders waiting for the user to modify them, and will show
up in the 3D space as short vertical curves by default.
Once a Project is created, HawkEyeTM will
provide for it a default Structure/Pad,
Slot/Wellhead, Well Path and First Target.
If there was no survey then there would not be a
visible component in the 3D space. This is the
equivalent of what you commonly see on a data
tree that has a ‘+’ to the left of a closed tree item.
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ADDING STRUCTURES/PLATFORMS: To add
addition Platform/Pads, simply right-click on the
Project
in the Data Tree you want the Structure to be
associated with, then select “Create New Platform/Pad
For Project.”

In this dialogue, structure data (name, reference slot, elevation and convergence) and
structure original coordinates can be added. To finish, click the “Create” button and the
structure will appear in the Data Tree. Along with the new structure, there will be a
default Slot and a default slot survey.
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ADDING SLOTS/SITES: To add a new Slot/Wellhead,
right-click on the Structure
, then select “Add New
Slot/Wellhead”.

This invokes the Slot Information dialogue, which allows the user to input the
Slot/Wellhead name, and add a variety of different coordinates defining it.

Coordinate information can be added via Latitude-Longitude, GeoDetic Grid (Grid X &
Y coordinates), or Local EW NS based on the current Slot/Wellhead location.
Click “OK” to save and close out this dialogue.
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b. Adding Wells and Sidetracks
ADDING A WELL: To add a well or “curve,” right-click on the
associated Slot/Wellhead in the Data Tree to pull up the
contextual menu, then select “Add New Well Path”.

In the “Add New Curve” dialogue, you may
enter the Curve name, Job No. (new or
pulled from existing Jobs already entered),
Curve Type (proposal or survey), RKB, tie in
point and referenced slot coordinate. The
curve will appear as named under the slot
you right-clicked on in the Data Tree. NOTE:
To create a new slot, don’t create a curve and
change the surface Tie-in point here. Instead,
create a new Slot/Wellhead and create a new
curve under that new Slot/Wellhead.

ADDING A SIDETRACK: Right-click on the associated
curve to pull up the contextual curve menu, then select
“Add Side Track Curve” .
In the Create Side Track dialogue, you define the sidetrack
curve as an entirely new curve which starts at the defined
tie-in point. Additionally, you can define the sidetrack as
any kind of projection before creating it, using the
“Projection Type” dropdown menu.
NOTE: The most critical parameter of a sidetrack is the Tiein Point, which is defined either by MD or TVD off the
parent curve, so double-check your parent curve and those
numbers before creating a new sidetrack curve.
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2. EDITING CRITICAL INFO
a. Targets
1. Creating and Managing Targets
Targets in HawkEyeTM have several important functions: to act as designation points for
the so-called targeted projections (Slant, Aligned, BOT and Horizontal, explained in Ch.
III Projections), to serve as visual aids in the 2D and 3D space as representations of , and
to act as placeholders or bookmarks in an active work space.
IN 3D SPACE: Targets appear in the 3D space by
way of their own parameters which define
appearance, orientation and location. They do not
follow curves or other structures and their
specific
parameters
must
be
re-defined
individually to be moved around or changed.
IN THE 2D VIEWS: The targets appear in the Vertical
Section and Top Views (VS and Top tabs). Their labels can
be customized in the Graphics Properties panel, which can
be accessed by clicking on the top left icon
in either 2D
window.
The target labels can be moved around in the 2D windows
by left-clicking and dragging them.
Any target can be right-clicked on in the 2D views to pull up a quick synopsis of critical
target information.
IN THE DATA TREE: Targets
can be found in the Data Tree where they are
associated with a particular structure/pad or slot/wellhead. When the New Project
Wizard is used to start a new project, the Wizard will create a single default target
under the default slot. Otherwise, a target must be added manually. Any new target can
be found in the Data Tree as well as the Target List.
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ADDING TARGETS: There are several ways to add a target to a project:
1.

In the Target List: Click on the bottom row of the list and a new target will
appear. (More on the Target List later in this chapter).

2.

In the Curve Menu: Right-click on any curve and select “Create Target at This
Point” and the target will appear at that exact point.

3.

In the Crosshairs Menu: Right-click on the red Crosshairs found on the Sight
and select “Save as Permanent Target.” It will appear in that exact spot.

TARGET RIGHT-CLICK MENU: The target contextual
menu is pulled up by right-clicking on a target name in the
Data Tree or the target in the 3D space. All of the primary
functions of the target can be found in this right-click menu.
•

TARGET ADJUSTER:
This option in the rightclick menu will open the TARGET ADJUSTER panel,
which is the primary main screen platform for
editing targets. This control panel is explained in
detail in the next subsection.

•

TARGET LIST:
This option in the right-click menu invokes the TARGET
LIST, which is a comprehensive, interactive list of all targets in a project and
includes the TARGET ADJUSTER PANEL. This control panel is explained in
detail in one of the following subsections.

•

EDIT 3D FONT:
This opens the Graphics Properties Manager, on the 3D
Cage tab. (Here you can edit not just the target labels, but also the labels for other
information and the attributes of the 3D walls).

•

HIDE:
A target can be hidden by right-clicking on it in the 3D space and
selecting “Hide.” Targets can also be hidden by unchecking the checkbox to the
left of its name in the Data Tree.
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•

ADD NEW HARD LINE:
This will first prompt the user to enter a name for
the new hard line, then that hard line will appear in the Data Tree. To edit the
hard line coordinates, RIGHT-CLICK on the hard line in the Data Tree and select
“Edit Hard Line Coordinates.” For more information on hard lines, see the
section following this one.

•

ADD NEW LEASE LINE:
This will first prompt the user to enter a name for
the new lease line, then that lease line will appear in the Data Tree. To edit the
lease line coordinates, RIGHT-CLICK on the lease line in the Data Tree and select
“Edit Lease Line Coordinates.” For more information on lease lines, see the
section following this one.

•

CLONE TARGET:
Select this option in the right-click menu to duplicate the
target and all of its parameters. The depth is automatically made 100 length units
deeper than the target being cloned, so this will probably need to be changed
along with the target coordinates.

•

GO TO TARGET:
This right-click option is a navigation tool for the 3D
space. It will take the Look-at Point or current point of view and center it on the
selected target. This is useful for zooming around and getting spatially adjusted
in the 3D space quickly.

•

SET AS THE FIRST TARGET:
This right-click option is a critical tool in
using the targeted projections. Under any Structure, there is only one designated
First Target at a time. Any target can act as the First Target as long as it is
designated as such. When it is set, the First Target is a designation point for the
projection calculations of Slant, Aligned, BOT and Horizontal projections. If any
TM
of these projections are attempted without a First Target, HawkEye will prompt
the user to set a First Target before continuing.

•

SET AS THE SECOND TARGET:
This right-click menu option is used only
for Aligned Projections, which may require a second registered target for certain
TM
calculations. When a Second Target is required yet not set, HawkEye will
prompt for the designation of one.

•

DELETE TARGET:
This option will instantly delete the target from the
database. NOTE: To make a target invisible but retain it, just select “Hide” from
the right-click menu or uncheck its box in the Data Tree.
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HORIZONTAL TARGET RIGHT-CLICK MENU: You can create a horizontal
target by clicking on the large Target icon in the main screen and selecting
“Add Target Plane.”
Then right-click on the target plane either in the 3D space or the Data Tree. The
menu is almost identical to the normal target right-click menu, except that here you
can also designate the target plane as the “Horizontal Target Plane,” which is used
with the Horizontal Projection.
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2. Target Adjuster
The panel that appears inside of the 3D space to the right contains all of the parameters
associated with a target. Its name, assigned slot, color, texture, general shape,
orientation and location can all be changed through this panel.
Pull up the Target Adjuster by right-clicking on a target in the Data Tree or 3D space
and selecting “Target Adjuster.”
This panel will also always appear in the TARGET
LIST, which is a panel explained in a following subsection.
The top four icons in the Target Adjuster are the same options found in the right-click
menu:
Set as First Target, Set as Second Target, Go to Target and Clone Target.
NAME, SHAPE, SLOT: The next three fields
allow the user to edit some critical information.
The “Name” field is an open field and the
target can be called anything. The “Shape”
drop-down menu will instantly shape the
target into one of several default 2D or 3D
shapes: cylinder, cube, polygon, circle, ellipse,
square, circle, ellipsoid, point and other. The
“Slot” drop-down menu contains all slots in a
structure to choose for a target’s assignment.
TVD: A Total Vertical Depth can be entered
manually, and must either be defined as a subsea or an RKB TVD.
COORDINATES: The coordinates for the target are either Local or Grid and the NS
and EW values can be input manually.
MAP: The “Map” button will invoke a separate control panel in which specific,
advanced location data can be entered for the target. The target “Map” panel will allow
the user to control specific coordinate and mapset information. On the right is the
Google Earth view by default.6
6

Google Earth is a separate program that needs to be installed on the local machine. It is free
and can be found at earth.google.com.
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The magnetics icon in the top middle will launch the Magnetics dialogue, which
controls the magnetics adjustment data for the entire project. This can also be launched
from the main screen through the same icon at the top.
Group, System Zone and Datum are displayed, but not editable. These can only be
changed at the Project level, through the Geodetics dialogue.
Current Slot Reference: allows the retrieval of a project’s coordinates; this can only be
changed at the Slot level by selecting the desired slot, and then right-clicking and
selecting the Set as Reference option.
Launch GE: This launches a separate instance of Google Earth loaded with the current
coordinates. If the Google Earth program is already running separately, this button will
send the program the current geodetic information.
Coordinates can be entered either by Grid coordinates or Lat/Long coordinates. Select
the option first and enter the values.
At the bottom, several more parameters are displayed which are relevant to the grid
system being utilized. They are not editable. Below, a brief description of what each
parameter is.
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•
•

•

•
•

Convergence: The angle of difference in degrees between grid north and true
north. This is measured from True North to Grid North.
Scale Factor: The error associated with the map projection as a result of
approximating the surface of the earth as a plane instead of the curved surface it
actually is.
Projection Type: This is the type of mathematical projection system used.
Nearly all systems utilized are either Lambert or Transverse Mercator. Many
projections systems are used in cartography, but most legal systems around the
world involve at least a variation of one of the two mentioned systems.
Earth Radius: This is the radius from the earth’s equator to the center of the
earth.
Flattening: This is a mathematical constant representing the amount of flattening
the earth has as a result of its rotation. The earth is not completely spherical
mostly because of the fact that at the equator it is moving 1000 miles an hour and
the centrifugal force causes the earth to bulge at the equator.

The remaining parameters in the Target Adjuster can be
changed by the drop-down menu arrows in increments
of 1, or values may be manually entered to any
specificity unless otherwise noted. Length units are
either in feet or meters, depending on which unit is
chosen for the project.

CL-DIR: Direction from the surface location to the Target center
CLOSURE: Horizontal distance from the surface location to the target center
DIAMETER: Controls the total
width of the circular ends (of
cylinders only).

ROTATION (THICKNESS): This parameter does not apply to any shapes, but in its
place “Thickness” appears when a hardline or leaseline is selected.
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THICKNESS: This controls the
amount of vertical space which the
target occupies. (Not applicable to
2D shapes.)

SIDE A AND B: These two
parameters control the length of the
default x-axis and y-axis sides of a
non-circular shape. (Side B is not
applicable to 2D shapes.)

DIP/DIRECTION: This controls the
degrees in which the target is turned
from its geometric center (i.e. its
azimuth). Pictured is 0 and 45
degrees, with the target rotating
clockwise.
DIP/INCLINATION: This controls
the degree of tilt that the target
shape assumes. Pictured is 0 and 45
degrees, with the top of the target
tipping to the left.

DIR. OFFSET: This controls the
directional offset of the target, which
is the distance along the hole, up or
down. Pictured is 0 and -200, where
the target appears to drop in
elevation.
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X OFFSET: This value, in units of
length, displaces the target off of its
defined location on the X-axis.
Pictured is the Top View and an X
Offset of 300.

Y OFFSET: This value, in units of
length, displaces the target off of its
defined location on the Y-axis.
Pictured is the Top View and an Y
Offset of 300.

OPACITY: This controls the
translucency factor of the target,
ranging from 5-100.

COLOR: Although the entire palette
of colors is available for targets,
there may be discoloration
depending on the underlying texture
chosen for that target.
TEXTURE: A wide variety of default
textures are available for the targets.
In addition, user textures can be
selected from the file explorer on the
top left of the dialogue.
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3. Target List
The Target List is the comprehensive control center for all targets associated
under a slot or structure. It includes the Target Adjuster within it.

OPEN THE TARGET LIST: Access the Target List by right-clicking on
a target in either the Data Tree or the 3D space, then selecting “Target
List.” Regardless of the target clicked on, the Target List will display
data on an entire slot or entire structure’s target array.
You can also launch it by clicking on the Target List icon under the
Home tab.
TARGETS ON: Choose either “Current Slot” or “Current Structure” to select the range
of targets to be displayed in the list below.
SORT BY: Organize all displayed targets by either “TVD” or “Closure Distance.”
SHOW TARGET ARRAY: This toggle will turn on the “Target Array” fields, which
allow the user to select any sequence of targets for multiple-target projection setups.
Such a setup can only be taken advantage of in the HawkEyeTM Command interface. See
the section on HawkEyeTM Command (Ch. IV. Section 4) for more details.
PARAMETERS: Targets are defined in the List across 11 parameters, each of which can
be changed in this panel. The order of the columns is not changeable.
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TARGET ADJUSTER: The Target List contains the Target Adjuster within it. As
described in the previous sub-section, simply click on the name of the target in the list
and its specifics will appear in the Target Adjuster panel above, where they can be
changed.
4. Target Array
The Target Array is used only in a specific projection sequence in which a number of
targets are hit with a series of tie-ins that are created simultaneously in the Proposal
mode.
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b. Target Planes
Although the Horizontal Projection will generate a target plane when you
activate the projection, you can also generate a target plane from scratch.
Do this by clicking on the Target Selector icon (large red and yellow target icon in the
main screen) and selecting “Add Target Plane.” This will bring up a Target Adjuster
dialogue where you can define the size, dip and direction of the target plane. The
default target plane is going to be at 3500 TVD and 0,0 local. To change the parameters,
right-click on the target plane in the Data Tree or 3D space and select “Adjust Target
Plane.”

To use a custom made target plane as the horizontal projection target, right-click on
your target plane either in the 3D space or the Data Tree and select “Set as Horizontal
Target Plane.”
The target plane created here is defined as through the parameters in the Target Plane
Adjuster dialogue. It will take on the texture that is found at that TVD from the
lithology of the structure or slot with which it is associated.
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CREATE A TARGET ON THE TARGET PLANE: You can create a target directly
centered on the plane by grabbing the blue “handle” that is located at the center of
every target plane. Simply drag the blue handle to the place on the plane where you
would like the target to be generated, then right-click on the handle and select “Save As
Permanent Target.”

To get the exact location you want before making this target, check your Handle
Coordinates which appear when you drag the handle around. The Handle Coordinates
are located on the top right inside the 3D window.
When a new target is created, the blue handle resets to the middle of the target plane for
future service.

109
HawkEye

TM

User’s Manual

Copyright © 2022 by Performance Drilling Technology

3. EDITING NON-CRITICAL INFO
a. Importing Lease/Hard Lines
Hard lines are boundaries beyond which one does not wish to drill, a no-go zone. Lease
lines are legal boundaries that often have to be visually incorporated into a well plan to
illustrate how far the well is from the lease line or its offset line. For all practical
purposes, HawkEyeTM treats the creation of both lines almost identically for most
practical purposes.
TWO WAYS TO CREATE LEASE/HARD LINES:
IMPORT THE SPREADSHEET OR TEXT: Lease line boundaries can be
very complex. The data for building them normally comes from data a survey
company the operator has utilized to specify the surface location of a well. If
you can obtain a spreadsheet with the coordinates of the points specified in
any one of several styles, you can cut and paste the data into the spreadsheet
editor used to input hard/lease line data. This is by far the easiest and best
way to input this kind of data because it is very quick and it reduces the
likelihood of input errors that can be confounding with a long list of lease
line coordinates.

1.

COPY-PASTE THE SPREADSHEET OR TEXT: The other way is to copypaste from a delimited text file that has the data arranged in lines with the
values separated by commas, tabs, or spaces. This process involves more steps
than the first method but has the advantage of reducing input errors, same as
the first method.

2.

The first step is to copy the data from the spreadsheet or text. The data usually
comes in one of several common formats: Local Coordinates, Grid
Coordinates, Direction-Distance or DMS-Distance.
Once the data is copied, create a new hard/lease line in
HawkEye. Do this by just right-clicking in the Data
Tree on either the Project
or the Structure
under
which the line is to be associated. Then select one of the
two options at the bottom of the right-click menu.
This will open up the Lease Line or Hard Line editor.
Right-click in the table section on the bottom half of the
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editor and you will be given a number of choices on how to paste the data.
NOTE: How you paste the data here needs to match how the data was
oriented in the original spreadsheet or text file.
The first seven options when pasting in hard/lease line data
are composed of two columns. The last option, DMSDistance, is a five-column format. Choose the method of
pasting and the data will import and get calculated. Each of
the numbers are editable once entered in this fashion.

ADJUST THE LINE: There are two aspects to any hard/lease
line: its coordinates and its 3D display properties. To edit a
hard/lease line’s coordinates, right-click on the line in the Data
Tree and be sure to select the “Edit Hard Line Coordinates”
option.
If you want to edit the way the line will be displayed in the 3D
space, such as editing thickness of the line, then select “Adjust
Hard Line Parameters,” which will open up a Target Adjuster
box for that line.
SEE THE LINE IN 3D: To see the lease/hard line in the 3D space as more than just 2D
lines, click on “View” at the top of the screen, go to Hard/Lease Lines, and check the
“Show 3D Object” box. If this box is not selected, then any parameter changes in the
line’s target adjuster won’t show up as a 3D object in the 3D space. You can also toggle
this 3D display box in the Lease Line or Hard Line Editor.

DIY: If you do not have access to a spreadsheet or text file with the data and you have a
lot of points, you can create one by the old fashion way, by doing it yourself.
Maintaining data in one of those forms makes it much easier to edit. However, if you
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only have a few points to enter, then using HawkEye’s editor to input the values is not a
problem.
The following screenshot shows the Lease Line Editor open, and the lease line
displayed in the 2D space with a 500 ft internal offset represented by the dotted line.
Note that there are four different Input Modes, which are also the coordinate display
modes:
•
•
•
•

Local Coordinates
Grid Coordinates
Direction-Distance and
DMS (Degrees, Minutes, Seconds) – Distance.

Next to the Input Mode box is the Boundary offset box. Internal and external offsets
can be set by entering the distance and then selecting the radio button for what you
want (Inner or Outer). HawkEyeTM will calculate the line and display it. The ‘Close
Line’ option is for when the last point is automatically set to the first point, so that a
closed lease line can be more easily input. The 3D View box has options on how to
display the line in the 3D space.
In the example shown the data was automatically generated by HawkEyeTM from a PLSS
Township, Range, Section definition. To enter data manually it is usually best to count
the number of points you will be entering and the use the “Add Point” button that
many times, creating a blank spreadsheet in the Editor that has all the space you will
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need. Next, decide what Input Mode you will be using. If it is Local Coordinates, Grid
Coordinates or Longitude, Latitude coordinates all you need do is enter each pair of
coordinates, either line by line or by going down each column and entering all the EW
coordinates, for example, and then proceeding to the next column and filling in all the
NS coordinates.

ANCHOR POINT: If you are inputting coordinates in Direction-Distance, the most
important thing to remember is to FIRST, input the starting Xpoint, Ypoint. This is the
“anchor” point, and is labeled line “0” in the coordinates table. From that point on you
will only need to enter the direction and the distance.
MOSTLY THE SAME: Mostly everything that is true for Lease Lines is true for Hard
Lines. With Hard Lines you can also have offsets if you so desire.
MULTIPLE HARD LINE PASTING: However, with the spreadsheet cut and paste
option with Hard Lines, there is an option you are presented with when pasting the
data to the grid which allows a list of independent hard lines to be added
simultaneously. In this mode, each successive pair of points constitutes a single line.
HawkEyeTM will automatically generate a Hard Line definition for each pair of points.
You can then edit them independently for color, names and offsets by editing their
target parameters if you so choose. When you paste in the data, HawkEyeTM will prompt
you for this option.
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b. Comments and Annotations
1.

COMMENTS

ADD COMMENTS: Comments are generated in HawkEye at any given survey, either
in the Work Mode or Proposal Mode. They can be entered manually at the survey by
typing in the comment in the List Panel below in the space for comments.

AUTO-GENERATE COMMENTS: Comments may be generated automatically for
proposal curves by right-clicking on the desired curve for comment in the Data Tree,
and selecting “Auto Comments For This Curve.” This will create a comment at each
critical point in the proposal (e.g. KOP, Begin
Build, Begin Turn, PBHL). You cannot
generate auto-comments for a work curve
since each survey would be considered a
critical point due to its irregular, nongeometrical nature.
When a comment is created,
it will appear in the 3D space
at the point on the curve on
which it was created, marked
by a green sphere.

DELETE A COMMENT: To delete a comment, erase the text from the Survey List Panel
at the bottom of the main screen (the field in black as pictured above). Or to delete ALL
the comments of a curve, go into the curve’s menu and select “Clear Comments.”
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2. ANNOTATIONS
Annotations are slightly different from comments in that they can only be generated
manually. In other words, there is no way to auto-generate annotations. Think of them
as personalized notes outside the bounds of what is to be included in a plot or report.
ADD ANNOTATION: To add an annotation
to a curve, go to that curve’s menu and select
“Add Annotation.”
The Enter Annotation box has a number of options,
including choosing the exact depth and type of
depth at which the annotation will appear along
the curve, as well as the font and color of the
annotation.

DELETE AN ANNOTATION: The only way to delete an annotation
is to right-click on the blue sphere where it resides on the curve, then
select “Delete.”
NOTE: Sometimes it is tricky to get the right-click menu to come up for the annotation,
and may require adjusting the point of view and zoom in order to nail the sweet spot on
the blue sphere.
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III.

PROJECTIONS

TWO MODES: There are two overall modes in
HawkEye. The Field Mode is default and available in
both versions. It is used for directional drillers who are
not creating much in the way of complex proposals or
well plans. Whereas the Well Planning Mode, available
only in the eponymous version, is used to created
complex well plans.

1. WHAT YOU NEED TO KNOW
HawkEye’s Field Mode offers nine types of projections that can be used by directional
drillers as well as well planners. They are:
•
•
•
•
•
•
•
•
•

Bit (Compound)
Measured Depth (Straight Line)
Total Vertical Depth (Straight Line)
Nudge
Multi-Nudge
Horizontal
Slant
Aligned
Back on Track (BOT)

MODES: FIELD v. WELL PLANNING
The main difference to keep in mind between the Field Mode and Well Planning
Mode is that, although they both have the same arsenal of projections which can be
appended end to end, only in the Well Planning Mode can a projection be edited at
any segment and have the rest of the curve recalculate.
In other words, in the Field Mode, only the last appended projection can be edited,
so that in order to edit a part further up the curve, the user must delete all
appended parts of the curve made subsequent to that higher up part before editing
it. In the Well Planning Mode, all parts of the curve are editable at all times.
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Each of these projections can be quickly generated and edited from the main screen by
clicking on the corresponding icon:

These can be broken down into two broad categories of projections. The “Targetless”
projections can be created from any point on a curve without having to select a target.
“Targeted” projections, on the other hand, require a target toward which a projection is
created.
TWO GENERAL FAMILIES OF PROJECTIONS
TARGETLESS PROJECTIONS:
• MD & TVD Projections- Hold a particular inclination and azimuth and go in a
straight path for a certain user-defined distance.
•

Nudge and Multi-Nudge Projections- Mimics minimum curvature
calculations but allows for the nudging of a variety of different parameters.

•

Bit or Compound Projections- Allows a projection to be strung to a bit from
where your survey position is. From there you can append other kinds of
projections to the end.

TARGETED PROJECTIONS:
• Slant Projections- a.k.a. DLS projections, Build-and-Hold Projections. Can
solve for a hold angle by providing a dogleg severity or solve for dogleg
severity by providing a hold angle.
•

Aligned Projections- Set two dogleg severities, as well as desired inclination
and azimuth at target.

•

Back-on-Track (BOT) Projections- Set two dogleg severities and a minimum
distance in order to intersect your proposal.

•

Horizontal Projection- Will project to a horizontal plane, which is considered a
2D target. Horizontal plane is defined by an RKBTVD, a max dip angle and a
max dip direction.
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a. Work Mode vs. Proposal Mode
The most important thing to understand when in HawkEye’s 3D space is
that there are two modes for building and navigating between your
curves: the Work Mode and the Proposal Mode. You can toggle between the two modes
by clicking the corresponding cursor icon just below the 3D window:

WORK MODE: The primary difference between the two modes is that the Work Mode
will allow you to follow along the currently selected Work Curve.7 Also, when you
make a projection, it is automatically starts from the end of the work curve, but will not
stay there unless you append it. See more on appending projections to your curve in the
following section.
On the right we see our Work Curve
(Survey Curve) in red, and a slant
projection made from the Projection Panel
in light green. When this projection is
made, we can slide along and look at all
the projected surveys to see what kind of
DLS or inclination we need to hit. But the
green projection is not part of the
workcurve. And it is replaced by the very
next projection we make.

7

Set any survey curve in your Data Tree as the “Work Curve” by right-clicking on it and
selecting “Set as Work Curve.”
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The very next thing we did was make a
Quija projection from the panel. Just like
all projections, it starts from the end of
our Work Curve in red. But it replaced
our previous projection. We can travel
along this new projection to explore its
parameters, but it, too, will be replaced
by the next projection we make.
The idea is for the driller to be able to
make short-term predictions from where the well is already drilled.

PROPOSAL MODE: In the Proposal Mode, you are able to follow the Proposal Curve.8
When you make projections in the Field Mode, your new one will replace whatever
you have in place previously.
There are exceptions to this, however. You can build up proposal curves projection by
projection with the following two methods: 1) Append to Curve- after a projection has
been generated, click on the “Append” button at the right-hand end of the row of
projections, 2) HawkEye Command- type in a direct alphanumeric command that
instantly generates and appends the projection (see last section of this chapter).
NO BIT PROJECTION IN PROPOSAL MODE: You will notice that the Bit Projection
(Bit to Sensor Projection) is not available in the Proposal Mode. The icon is simply not
displayed while in Proposal Mode.
This is because the Bit Projection is assumed to only be used with the Work Curve. It
adds a certain length of measured depth at the end of any projection in order to
simulate the course length to the bit not yet reached by the sensor.

8

Set any proposal curve in your Data Tree as the “Proposal Curve” by right-clicking on it and
selecting “Set as Proposal Curve.”
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b. Appending Projections to Curve
The Append function allows the user to append a projection to the end of
the current curve, either in the Work Mode or Proposal Mode. This will be
needed frequently for any user who needs to make a projection with minimal
complication. Fortunately, the process is intuitive and simple.
Step 1- Select your curve: Make sure you are focused on the curve that you want to
append to. Typically this is a proposal curve, since the only way you want to add to a
work curve is by actual surveys. When you find the proposal curve you want to append
to, right-click on it and select “Set as Proposal Curve.”
Step 2- Create a Projection: Select the projection that you want to append and play
around with the parameters to make sure it is what you want. (See next section on
details of each projection).
Step 3- Click “Append”: When you click the Append button, your currently displayed
projection will become a part of the current curve.

GENERATING COMMENTS: Comments can be added to surveys either manually or
automatically. To do so manually, go to the bottom right of the main screen in the
survey window and add comments at all the various critical points like the kick-off
point and the hold angle, etc.
But to generate these comments
automatically, RIGHT-CLICK on the
well and select “Auto Comments For
This Curve.” The critical points
comments will appear in the comments
section on the bottom right.
NOTE: You want to auto-generate
comments only for proposal curves.
There may be an excess of comments if auto-generated for an As-Drilled curve.
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2. PROJECTIONS IN FIELD MODE
APPEND TO BUILD: It is worth repeating here that you can append each of these
projections permanently to the end of either your Work Curve or Proposal Curve by
using the Append button, described in the preceding section.

a. Bit Projection
NOTE: BIT projections are only available in the Work Mode. You cannot
access the BIT projection in the Proposal Mode at all. As the name implies,
the Bit projection will make a projection to the bit. It can be created in two
ways:
1. Straight line projection
2. Nudge projection (w/ DLS and TFO)

APPENDING/COMPOUNDING PROJECTIONS: The Bit
projection works with most of the other projections by
being able to be appended to. This allows for a projection
past the estimated current bit location. It works by 1)
opening the Bit projection dialogue and creating the initial
Bit projection, 2) opening the dialogue for the secondary
projection (take your pick).

Bit projections can be
made as straight line or
nudge-style projections.

Open the Bit Projection panel to make an initial projection then open another
projection panel to append to the Bit Projection. Make corrections on the fly on
either panel to nudge the compound projection into place.
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b. MD & TVD Projections
Measured Depth and Total Vertical Depth projections are of the
simplest kind of projections available. They simply add a straight
extension for a given distance, holding for the existing
inclination and azimuth.
The only difference between the two projections is the type
of depth measurement used, with either measured depth
or total vertical depth. The mechanics of the projection
calculations are identical.
To make the projection, just enter an Added Depth to add
how much from the endpoint you wish to progress in a
straight line. OR put in a Total depth value and
HawkEyeTM will figure out how much added is required.
Clicking “Turn On Projection” will trigger the calculations
and activate the projection in the 3D space.
Press the TAB button after entering a value to get
HawkEyeTM to recalculate a parameter.

MD and TVD
projections simply add a
certain amount of
straight distance from a
point, holding the
existing inclination and
azimuth.
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c. Nudge Projection
The Nudge projection is the best way to nudge a curve and may be the first
kind of projection used when setting about to making a proposal curve. It is
also useful for predicting how the motor and rotary steering system will
behave by setting up the known parameters. Seeing this
projection rendered in 3D space helps to visualize a job with
the information already in hand.
Driller’s View: Since the Nudge projection is
targetless and relatively hands on, you will want to
get started in the right place. The right place to get
started is in the Driller’s View. This view mode will put you at
the end of the current work curve with Highside up.
Once Driller’s View is set and Sights toggled off, you can
select the Nudge tool from the row of projections and open up
the dialogue. There are three solve modes, each allowing for
the entry of up to three parameters at a time out of six:
DogLeg Severity, Tool Face Orientation, Delta (change)
Measured Depth, Inclination, Azimuth and Total Vertical
Depth.

The Nudge projection
interface allows for
maximum manual
manipulation of a
curve. The task is
divided into three
distinct solve modes.
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d. Multi-Nudge Projection
The Multi-Nudge allows the user to string together an infinite number of
Nudge projections. These nudge “segments” can be one of four solve modes:
•

INC/AZM/DLS: Where Inclination, Azimuth and Dogleg Severity are defined.

•

DMD/DLS/TFO: Where Delta Measured Depth, Dogleg Severity and Toolface
are defined.

•

DMD: A straightline segment that holds for a defined Delta Measured Depth

•

HOLDTODMD: Another straightline segment that holds until an MD is reached

You can create a new segment by simply selecting the solve mode in the bottom line of
the first column. In the screenshot below, all four types of segments have been created
and a fifth segment is on the verge of being created.

The segment colors always alternate Green, Red, Blue, and repeat after that. The cells in
white are editable, while the colored cells are calculated for you.
The “Option” tabs at the top allow users to create up to eight templates, so they don’t
have to rebuild a particular array of nudge segments over and over.
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e. Horizontal Projection
Although Horizontal projections are “targeted projections,” they require
horizontal target planes rather than the normal targets to be set as the
anchored tangential object.
The three parameters describing the horizontal plane itself are:
1. The RKB TVD, which is the depth below the surface
location all the way to the point of intersection with the
plane.
2. The Max Dip, which has a
positive value for leaning toward
the observer and a negative value
for leaning away from the
observer. NOTE: The quickest
way to understand this value is to
change it a few times and look at
the difference in HawkEye’s 3D space.

3. The Max Dip Direction is defined
in 360 degrees counting clockwise.
Visualize looking from the top
down on a well and simply define
the direction as one would an
azimuth. The formation would
thus lean into that direction.

Horizontal projections
are a more hands-on
projection requiring
several user-generated
parameters, calculated
by defining a
horizontal plane.
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CREATE A TARGET PLANE: To set a horizontal plane, RIGHT-CLICK on a straight
(tangent) section of a curve, then select “Create Target Plane.” A two-dimensional target
plane will appear in the 3D space along the tangent. Now RIGHT-CLICK on the target
plane itself and select “Set as Horizontal Target Plane.”

NOTE: It always helps to put an extension (tangent) on a horizontal projection (just add
some length in the Extension field in the panel). This elongates the projection and
allows for better visualization of where the projection and the attendant target plane
will be situated. Also note that the texture of the plane itself reflects the data entered in
the LITHOLOGY panel.
NOTE: When creating a target
plane, it will be generated from
zero closure towards the active
direction in which the projection is
made. So if you then take the
projection 180 degrees in the other
way, there won’t be any target
plane in that direction.
To extend the target plane in the
other direction, just repeat the
process of selecting the curve,
RIGHT-CLICKING on it, and
select “Make Target Plane.” This
will extend the target plane in
your new direction and link up
with the first one.
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Horizontal projections will allow the user to enter either the strike azimuth or
the strike inclination.

BORE DOWN JUST UNDER THE FORMATION: The Horizontal projection panel
will only allow for the change of either strike inclination or strike azimuth at any one
time. But they can be modified in succession. To get the projection to get right under the
formation and cruise along underneath, simply determine the proper strike azimuth,
then enter a user-defined Strike Inclination of anything a little over 90 (because a 90
degree strike inclination will put the projection directly on the formation plane).

Entering a Strike Azimuth of 93 can put the projection just under the
formation, yet not deviate too far down away from the plane.

NOTE: Although you cannot define the DLS in this mode, it is the all-important number
to keep an eye on after every parameter change and is thus highlighted in green.
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f. Slant Projection
Unlike the Back-on-Track projections, the Slant projections (a.k.a. “Build and
Hold” projections, “DLS” projections) do not take the proposal curve into
consideration. You give it either a Hold Angle or a DLS to shoot for and it will
create the smoothest possible curve to the target.
To create the Slant projection, RIGHT-CLICK on a target and
select “Set as First Target,” then open up the Slant projection
dialogue. You can either choose a DLS or a Hold Angle,
allowing HawkEyeTM to solve for the other. Then click “Auto
Calculate.”
Clicking “Turn On Projection” will trigger the calculations and
activate the projection in the 3D space. You can also hit the TAB
button after entering a value to get HawkEyeTM to recalculate a
parameter.
Since the job may not always call for being exactly on the
proposal line, the Slant projection might be a favorable option
for planning a smooth and easy path with minimal dogleg
severity and maximum straightaway distances.

Select a target and set it
as “First Target,” then
use a Slant projection
to get a smooth curve to
that target, ignoring
any proposal curve.

The Slant projection here (in green on the left) took a userdefined hold angle of 41.24 and came up with a 2.44 DLS to
get the easiest ride to the target, outside of the proposal.
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g. Aligned Projection
The most powerful and complicated of the projections, the Aligned projection
requires user input for both dogleg severities and the desired inclination and
azimuth at the first target.

HIT CALCULATE: After any change in parameters, the
“Calculate” button must be pushed. This is in order to cut down
on unnecessary and unwanted rendering of calculations:

The following examples illustrate the basic functions of the
Aligned projection panel. However, the full potential of this
tool, like all the rest of the projections can only be discovered by
tweaking and experimenting with the parameters to see how
they behave.
The VS view (VS tab in the main screen) is used to illustrate this
projection.

The Aligned projection
panel is the most
powerful of them all.
Skewer two targets.
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1. At the start, there are
two targets, with a
proposal curve going
through each.

2. Here’s a DLS of 2 for both turns (arrows), and 0 for
inclination and azimuth at target for a vertical
orientation. The projection goes to the first target. Make
sure to set first target in the target’s right-click menu.

3. Putting in an Extension Before of 500 makes a straight line for 500 feet BEFORE
hitting the target, thus the second turn (big arrow) comes earlier. With a 1000 for
Extend After, the projection will go straight for 1000 feet after the target.
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USE VECTOR TO SECOND TARGET: The Aligned projection tool can line up to hit
two targets with relative ease. To get the aligned projection to line up in anticipation for
a second target, the first step is to go to the DATA TREE, then RIGHT-CLICK on a
target and select “Set as Second Target.”

2. Check “Line up to hit
2nd Target” in order to get
the curve lined up for
Target 2.

1. It might take a long time
to manually nudge this
projection directly into the
second target at the bottom.

3. Then hit CALCULATE
and the projection will do
the work of hitting both
targets.

4. Add an Extend Before
length and the final turn
will come earlier (big arrow,
500 ft before the first target),
while the Extend After will
be a straightaway. >>>>>>>>
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h. Back-on-Track (BOT) Projection
Back-on-Track projections will create a curve that will try to realign itself with
the current Proposal Curve within two turns equal or as close to the DLS
provided, within the minimum distance given.
The program will increase the DLS values as necessary when
calculating the minimum curvature to get back on track.

Clicking “Turn On Projection” will trigger the calculations and
activate the projection in the 3D space. You can also hit the TAB
button after entering a value to recalculate a parameter.

BOT projections require
two dogleg values and a
minimum distance in
order to intersect the
Proposal Curve and thus
get back on track.
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Fixed vs. Dynamic: The Fixed option will solve for a solution back to plan based on
your DLS values. The Dynamic option will solve based on wherever your Look-At
Point is on the current Proposal Curve (the program needs to switch to Proposal Mode
in order to do this).
Back On Track to Way Point: Checking the “BOT to Way Point” will turn on a
projection that ends at the current Way Point position, while using the two DLS values
and minimum distance that you have provided.
Set the Way Point position
by going into Proposal
Mode and moving the red
Crosshairs to the position
where you want it, then
right-clicking on the red
crosshairs and selecting
“Move Way Point to Here.”
Once the blue Way Point
has been set, turn on the
BOT projection with the
“Back On Track To Way
Point” box selected and the
projection will go to the
Way Point rather than back
into the Proposal Curve.

Set DLS1=DLS2: This forces the solution to have the same DLS on both turns back onto
plan.
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3. Other Projection Tools

a. The Sight
TM

The Sight is a critical part of the 3D window in HawkEye , a visual aid that
follows the user’s Point of View or “Look-at Point” along a curve. It is highly
customizable and can also quickly be toggled on and off.

The Sight is an integral part of the 3D space in HawkEyeTM, allowing for onthe-fly proximity visualization as well as precision POV recognition.

TM

TWO SIGHTS: There are two Sights in HawkEye . One is associated with the Work
Curve and the other with the Proposal Curve. Each may be toggled on or off with their
own Sight icon next to the respective Curve Mode icon just below the 3D window. Each
of the Sights is only visible in their own mode, and each retains their own customization
settings (e.g. diameter, colors). A Sight may be toggled off also by right-clicking on it
and selecting “Hide This Sight.” Or by pressing the Spacebar when the mouse cursor in
hovering in the 3D window.
SIGHT EDITOR: Either Sight can be edited by RIGHT-CLICKING
on the icon, or RIGHT-CLICKING on the 3D space and selecting
“Sight Editor.” The Sight Editor allows for the customization of
every aspect of the current Sight and changes are automatically
saved.
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The Sight Editor controls all of the appearance options of the Sights for both the Work
and Proposal curves. The parameters are:
•
•
•

•
•
•

Curve Type- Choose either the Work or Proposal Curve Sight to edit.
Style- Choose either contiguous circles or a quartered stagger.
Background- Choose from a combination of either two colors, two textures or
one of each. The colors to choose from run the entire visible spectrum, and there
are about 100 default textures to choose from. But the user may provide a custom
texture by choosing the folder location when prompted.
Text Back Color- Choose the background color of the numbers on the Sight.
Size- This feature defines actual size of the Sight and dictates the distances
defined by the numbers on Sight itself.
Mag->Highside- This drop-down menu ranges from 0.0 to 5.0 in .5 intervals and
defines the inclination the user wants to switch from Magnetic Tool Face to
Gravity Tool Face. When the inclination exceeds this value the sight will be
oriented so that the top is at Tool Face 0. When the inclination is less than or
equal to this value the top of the sight will be pointed due north.

Click “OK” to save all changes to the Sight.
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THE DIRECTIONAL COMPASS: The floating Directional Compass can be turned on
and off through the Sight Maker options dialogue. When turned on, it is a compass that
follows the Look-At Point to constantly show either True North or Grid North,
depending on the current project’s settings.
The Directional Compass will always be the size of the Sight, and will always be
oriented horizontally.
It can be toggled by pressing the “,” (comma) key while the mouse cursor is hovering
over the 3D space.
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b. Projection to the Crosshairs
The crosshairs can be used in the projection mode to act as a First
Target for targeted projections. In order to have the Crosshairs active
TM
on the screen, HawkEye needs to be in Proposal Curve Mode with the
Sight turned on. Switch to Proposal Curve Mode by clicking on the
yellow “W” cursor below the 3D window. If the icon displays “P” then
you are in Proposal Mode. Toggle the Proposal Sight on by clicking on the “Plan Sight”
checkbox next to the “P” cursor.
COLOR: The Crosshairs is always red, and is always sized along with the diameter of
the curve.
MOVE THE CROSSHAIRS: The Crosshairs appears by default in the center of the
Sight, hugging the active curve. To place it anywhere on the Sight, just left-click and
drag it to the area, then drop it. Right-click on it and select “Put in Center” to re-center.
SET AS A TARGET: Pull up the Crosshairs contextual
menu by right-clicking on it.
When The Crosshairs object is set as First Target (or
Second), it becomes a target for projection purposes
only and is not a listed target that can be found in the
Target List or Data Tree.
PROJECT TO CROSSHAIRS TARGET: Once the Crosshairs are set as a target through
the right-click menu (see above), any targeted projection (Slant or Aligned) can be made
to the Crosshairs. The
projection will be redrawn
constantly as you move the
Sight up and down your
reference curve.
Right-click on the new curve
and select “Set as new
proposal” to create a new
curve which goes to that
current point.

137
HawkEye

TM

User’s Manual

Copyright © 2022 by Performance Drilling Technology

c. Target at the Crosshairs
SAVE AS PERMANENT TARGET: Right-click on
the Crosshairs and select “Save as Permanent
Target.” A name prompt will appear and then the
target will have been created at the exact current
location of the Crosshairs. In this fashion, the
Crosshairs can act as a Johnny Appleseed of targets, making it easy to drop simple
targets near a proposal curve without having to input coordinates or offsets.

Select “Save as Permanent Target” from the Crosshairs right-click menu and a
target will be generated in that very spot.

ALSO NOTE ANOTHER WAY TO GENERATE TARGETS QUICKLY

Select “Create Target at This Point…” from the CURVE right-click menu and a
target will be generated in the exact look-at point.
These targets, like any real target, can be found in the Data Tree and Target List. They
are associated with the slot under which the current proposal curve is located.
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d. The Waypoint Target
A quick-use target can be set
anywhere on the Sight in order to
quickly drop in an intermediary target
for projection purposes. This target,
called the Waypoint, is set by rightclicking on the red Crosshairs and
selecting “Move Way Point To Here.”
The Waypoint will appear as a blue
object in the 3D space.
It will also appear as a target in the Data Tree under
the name “WP*”. It may be deleted via the Data
Tree right-click menu, or if it is repositioned
through the Crosshair menu, it will simply exist in a
new location.
NOTE: There is only one Waypoint in the 3D space at any given time.
PLACING THE WAYPOINT: As
mentioned above, to place the
Waypoint, just move the red
Crosshairs anywhere on the
Sight,
right-click
on
the
Crosshairs and select “Move Way
Point To Here.” The blue
Waypoint will appear exactly
where the Crosshairs is located.
Even if the Sight is moved away,
the Waypoint will remain in the
original placement location.
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PROJECTING TO THE WAYPOINT: To actually use the Waypoint, first place it, then
simply right-click on it and “Set as First (or Second) Target.” The targeted projections
will treat it like a designated target in this fashion, and it can act as a quick way to make
a sort of anchor between locations.

SET AS NEW
PROPOSAL: Just as with
regular targets, if a
projection is made to a
Waypoint and then that
projection is made into a
“proposal curve,” the
curve will remain there
even if the Waypoint is
deleted or repositioned
somewhere else.
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e. Interpolation
1.

Interpolating Lithology, Casing and Targets via
Survey Report

The survey report is covered in detail elsewhere in this documentation, but it is worth
mentioning here that interpolation of Lithology, Casing and Target points can be
implemented ‘on-the-fly’ in the survey reports. A small icon is placed next to each
comment, indicating the type of comment. The snapshot below shows a section of the
report screen. The box labeled Interpolation Options shows the choices available for
interpolation. The survey report itself shows the icons and how they are displayed in
the report:
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2.

Interpolating an Entire Curve from Critical Points

The Interpolated Report can be used to generate an entire curve from just a few critical
points. Just follow these steps:
1.
2.
3.
4.

Enter the critical points as surveys into a new or existing curve.
Go to Report Generator and select “Interpolate Survey” as the report type.
Define the increments of interpolation you want for the curve.
Click the “Keep Curve” button. NOTE: This will save over all existing surveys of
the current curve in the Report Generator.
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IV.

REPORTS

Reports in HawkEyeTM can be produced for five different dataforms: survey, critical
points, criticality, least distance and interpolated survey reports.

FIVE TYPES OF REPORTS IN HAWKEYE
1. Survey Reports- This is the default type of report, which presents all
of a curve’s surveys under critical points headings.
2. Critical Points Reports- This report displays only the geometrically
defined critical points and user comments for a curve.
3. Interpolated Survey Reports- A report with survey interval options
that can generate a new set of surveys based on user-parameters.
4. Criticality Reports- A special kind of least distance report where
several different wells can be compared to determine dangerous
proximities.
5. Anti-Collision Reports- A more comprehensive least distance report
that contains separation factor values and secondary related
numbers.

OPENING THE REPORT GENERATOR: There are four ways to get to the
Report Generator in HawkEyeTM.
1. In the top left of the main screen, second from the left, click on the Report
Generator icon. The survey which appears is of the well path that is the current
center of focus in the 3D space
2. RIGHT-CLICK on any curve in the Data Tree and select “Show Survey Report.”
This will bring up the surveys for that particular curve selected.
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NOTE: Right-clicking on a curve brings up a long list of curve-related options,
and in fact, these such contextual menus are the basis for navigating the
various functionalities of HawkEyeTM.
3. RIGHT-CLICK on a curve in the 3D space, then select “Show Survey Report.”
This will bring up the surveys related to that curve.
4. RIGHT-CLICK on the colored bar just
above the Survey List Panel (located
at the bottom portion of the main
screen) and select “Show Survey
Report.” This will bring up the survey
related to the currently focused well.

The Survey Report allows for over 40 different types of data to be
added as data columns. Make sure to maximize the Report Generator
window after opening to get full legibility of the survey window.
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1. SURVEY REPORTS
TEMPLATES: Any of the 41 data types found in the blue columns
on the left can be added to a report template in any order, and any
number of templates can be saved and loaded. This is useful for
various customers with different specs for their reports. To add a
data column, LEFT-CLICK on it from the left hand blue column and
it will appear in the display list column. To remove, select it on it in
the right hand column by left-clicking on it, then RIGHT-CLICK on it
and it will disappear.
To place them in a certain order, they must be removed and
“stacked” or re-added to the righthand column in the desired order.

PRINTING REPORTS: Printing a report is as
simple as clicking the “Print” button at the top of
the Report Generator panel, or by clicking the
printer icon at the top of the panel. A user may
also print from a certain depth. To do that, they would simply select the starting survey
from which to print from the drop-down menu, then click “Print.” This is useful for
avoiding having to print out an entire battery of surveys when for example only the last
ten are needed on paper.

PRINTING TO PDF: HawkEyeTM installs with CutePDF, a program which allows
anything which can be printed onto paper to be printed into a PDF instead. Using this is
as simple as selecting “CutePDF Writer” as the printer in the print settings and then
selecting a target folder for the file when prompted.
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COVER PAGE: A cover page can be added, and
may contain any of three major elements: a logo, a
title or comment, and a snapshot from the 3D space.
To add a cover page, first select the “Cover Page” checkbox in the top left. To add a
logo, click “Load Logo” in the top left and select a graphic that will appear on the top
left and right of the cover page.
To add comments, simply type in whatever desired text into the “Cover Page
Comment” text field in the bottom left of the Report Panel. It will appear
instantaneously on the cover page.

SNAPSHOT: By turning on the Snapshot option,
the cover page will show the last 3D view seen
before opening the Report Generator. So to adjust
the snapshot, the user simply closes the Report
Generator and navigates the 3D space to get just the right angle, then opens the Reports
back up again.

CENTERED HEADER: A block of additional header text can be added to the first noncover page of a report simply by adding text to the “Centered Header” text field in the
bottom left of the Reports panel. Any added header text will appear above the
mandatory header information that always appears in the header zone of a report.

NORTH ARROW: Toggle on the North Arrow with the
checkbox in the top left and such an arrow will appear in
the first non-cover page of the report. This arrow set
displays True north, grid north and magnetic north. (For
more on this arrow, see the Magnetics Report section at the
end of this chapter).

BOX COMMENTS: Comments for each survey can be added here and are usually a
necessary part of reports. To add box comments, just click the “Box Comments”
checkbox and a column of comment fields will appear in the report.
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PAPER SIZE: Choose from Letter or A4.
EXTRA
DATA:
Additional
supplemental data can be
appended to the bottom of a
report by checking them in the
“Extra Data in Report” panel.
When
selected,
the
corresponding data will be
generated,
organized
and
displayed under any displayed surveys.

REPORTS NAVIGATION:
The tools at the top of the
Report Generator panel controls the view modes and zoom. Reports may be viewed
one, two, three, four or six pages at a time. The currently displayed page can be
controlled here as well.
NOTE: Pages can also be navigated by scrolling the mouse wheel up and down while
the cursor is over the report page itself. Also, left-clicking on the report itself will zoom
out one step, while right-click once will zoom in one step.
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SELECTING SURVEY OR PROPOSAL: Select the
curve on which to base the report by clicking on it in
the bottom left window of the panel. You may either
choose a survey or proposal curve. They are
automatically numbered by the sequence in which
they are listed in the project’s database. When a curve
is clicked on, the report will be immediately
generated via all the parameters specified in the
Report Generator panel.

REPORT TYPE: Choose your report type in the middle left
of the panel. A survey entry can be generated at different
frequencies depending on whether the path section is
straight or curved. That frequency input is located in the
same window where the report type is selected and can be
entered manually.
The default Survey Report will display each of the survey
readings of a curve. The survey entries are organized
readings under critical point headings that describe each
part of the curve.

ENTERING SURVEYS: Surveys are not entered in the Report Generator, but rather
only displayed in a report. Surveys can be entered manually in the survey window at
the bottom of the main screen or in the Survey Editor, which can be opened by clicking
on the blue plus icon on the far left end of the projection icons.

Up/Down and Left/Right: Of the many columns of data that can be added to a survey
report, often favored are the UD/LR columns. When these are added to a report, they
will always compare the referenced curve against the Current Proposal Curve,
whichever that may be.
Furthermore, the values will be expressed as UD/LR only in surveys where the
inclination is above a certain threshold (which can be set in the Sight Editor on the
bottom right corner of the form). If a survey contains an inclination under the threshold,
then the distances are expressed in terms of North/South and East/West of the proposal
curve.
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INCLUDE PROJECTION: The default
survey report has a checkbox which allows
the user to include any projections that
were active in the 3D space at the time the
Report Generator was launched. In the
picture to the right, there are two
projections activated, a Bit and a Nudge
projection. By leaving them on and
launching the Report Generator, you have the option to include them in the survey
report, as illustrated below.
Just check the “Include Projection” box in the Report Type
area, and the surveys for the projections will be
automatically added and labeled at the end of the as-drilled
surveys.

You may also generate a report that contains ONLY
projection surveys by clicking on the “Projection
Only” button in the Report Type.
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2. OTHER SPECIAL REPORTS
a. Critical Points Reports
There are two kinds of critical points in HawkEyeTM, the geometrically defined critical
points and user-created comments. With a Critical Points report, each of these survey
points are put into a report, ordered by depth.
To create a Critical Points report, select “Critical Points” from the Report Type, then
select the reference curve on the bottom left. The report will be immediately generated,
displaying all the geometrically defined points as well as user-generated comments for
that curve.

The Critical Points report will display all relevant data points of a curve. Simply select
“Critical Points” as the report type and select the desired reference curve.

In addition to the standard comments, additional comments for Lithology, casing and
targets can be included in the critical points report. In order to include those, just click
the associated check box for the Interpolation Options. An icon for lithology, casing or
a target will precede the description.
If two critical points are defined by the same point then all the comments are joined and
the icon provides a visual cue as to the nature of the comment.
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b. Least Distance Report
A Least Distance report will generate a list of surveys comparing any two curves, as
well as a ladder plot to help discern any dangerous proximities. Any well that is close
to the base line of the plot indicates a potential problem at that measured depth.
SELECT TWO REFERENCE CURVES: To create a least distance report, just select
“Least Distance” in the Report Type window, then select the two reference curves from
the drop-down menu that will appear just below. After selecting the two curves, click
“Create Report.”
The first non-cover page of the Least Distance report is
the ladder plot comparing the two curves, then the
subsequent pages contain the survey list. This list will
have a criticality column with a number from 1 to 5
which will indicate any dangerous proximity between
the two reference curves. 1 represents minimal or no
danger, so a long string of “1”s in this column is always
the desired look for a Least Distance report.
The next column over shows the
distance between the two reference
curves at each survey point. The actual
closest approach may likely be
between survey points, and can be
inferred from this data.

A Least Distance report will
generate a color ladder plot
comparing any two curves in
a project. Y-axis is proximity
and the X-axis is the
measured depth.
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c. Interpolate Survey Report
Additional interpolated surveys can be generated for either survey or proposal curves.
When a survey curve is selected under the
Interpolate Survey report type, an Increment
field appears within which the user may define
an interpolation interval. When a proposal
curve is selected, the interval fields allow the
user to define both the straight segment and
curve segment frequency of interpolated
surveys.

The reason proposal curves have two interpolation intervals to define and regular
surveys is because frequently customers want to see a proposal with the curve section
interpolate by one value, say 30 feet and the hold sections interpolated every 100 feet. A
proposal can be represented by simply inputting the critical points as surveys. A
proposal’s critical points will calculate exactly the same closure and coordinates as the
same proposal that is interpolated every foot. Another way of stating this is that if we
took the proposal that had surveys every foot and removed all the surveys except for
the critical points and calculated that we would come up with the same answer.
KEEP CURVE: The Interpolated Report can be used to generate an entire curve from
just a few critical points. This process takes the critical points and extrapolates them into
a usable proposal curve. Just follow these steps:
1.
2.
3.
4.

Enter the critical points as surveys into a new or existing curve.
Go to Report Generator and select “Interpolate Survey” as the report type.
Define the increments of interpolation you want for the curve.
Click the KEEP CURVE button.

The interpolated surveys will be added as part of the current curve.
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d.

Criticality Report

The Criticality report will graphically represent any dangerous proximities on a
distance plot. All curves in a project are shown with a key at the bottom of the graph.
Be sure to select the desired reference curve from the drop-down menu at the bottom
left of the panel when “Criticality Report” is selected. A Maximum Distance can be set,
a range to which criticalities will be displayed. When a new reference curve is selected,
click “Create Report” in order to refresh the graph.

SHOW PROJECTION: Check the “Show
Projection” box to show any curve’s
projection in the graph. It is recommended
that the projection be made a different
color than the preceding curve in order to
enhance visibility in the graph
The text output associated with the
criticality report will highlight only
Criticality 3, 4 or 5. Criticality 1 and 2
are ignored. This helps to keep the
report to a manageable size.

A Criticality report presents all curves
against a reference curve in order to assess
any dangerous proximities or criticalities.
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e. Anti-Collision Report
The anti-collision report is the program’s most comprehensive report and analysis of
possible collision issues between wells. It’s data columns are set rather than
customizable. Just like the Criticality report, it is important to first select the report type,
and then choose the Reference Curve and Compared Curves in the bottom left.

The first page of every anti-collision report is a ladder plot of the selected curves. To get
to the first page of listed data, navigate to Page 2 using the page navigation tools at the
top of the screen.

Anytime any parameters are changed for this report, you must press the “Generate
Report” button to regenerate the report. Due to the potentially massive amount of data
being processed, this report may take several long moments to load after each regeneration.
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f. Magnetics Report
Magnetics is particularly important when taking
magnetically measured surveys, for example
determining
applied
declination,
etc.
TM
HawkEye
allows for a high amount of
customization in magnetics configuration.
To get to the Magnetics dialogue, click on the
magnet icon at the top center of the main screen.
MAGNETICS MODELS: Once inside, the first
step is to select a magnetic model file.
HawkEyeTM uses the IGRF (International
Geomagnetic Reference Field) and WMM (World
Magnetic Model) magnetic models. (Future
models will include those developed by National
Oceanic and Atmospheric Administration and the British Geological Survey). The
BMMG model is available for those users who have a paid license for it, but is currently
not available standard with HawkEyeTM. It is important to have the right model
selected. The IGRF2010 model is good until 2015.
SURFACE
LOCATION:
Magnetics
is
automatically calculated when a surface location
is entered in a project, but that location (LatLongs) can be manually changed in the
Magnetics panel in the fields highlighted in light
green at the top.
PRINTING: Just click the “PRINT” button and a
handy one-page Magnetics/Geodetic Report is
generated, containing not only all pertinent
magnetics information, but several methods of
correction based on which north the user needs
to correct from.
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V. PLOTS
There are two kinds of plots in the program: Quick Plots and Presentation Plots. Quick
Plots are available in all versions of HawkEye, and allow for smaller “Plan-versusActual” type of plots. Presentation Plots are available only in the Well Planning version,
and allow for large “wall plots.”

1. QUICK PLOTS
QuickPlots in HawkEye are used to create “Plan-versus-Actual” plots on
regular-sized paper (letter or A4). The only place where you can launch this
module is the “Quick Plot” icon in the Home tab of the main screen.
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The Essential Options: There are many different options and parameters to mess with
in the QuickPlot, but only a handful of the most essential ones in order to get a decent
PvA plot as quickly as possible. Here they are in the recommended order of tending to:
1. Sort the Header Information: In order to access the header information, hover
over the header and press the right-mouse button. This will open Job Info for the
current curve. Resize the header itself by dragging the bottom border with the left
mouse button. Text size will automatically resize as you resize the window.

2. Choose the Plot Type: Select your plot type in the
top right. There are two orientations: Portait (on
the top) and Landscape (on the bottom). The V
stands for Vertical, meaning a Vertical Section
Plane plot, or side view. The H stands for Horizontal, or top view.
VH is a combination of both side and top view, as pictured in the screenshot of the
previous page.
The TC plot is a completely different type of plot called a Travelling Cylinder.

3.

Choose the Curves to be displayed: Click on the
“Curves” button to turn on and off which curves you
actually want displayed on the QuickPlot. After
hitting “OK,” the plot will update.
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4.

Fix your labels: Click
on the light blue “Graph
Properties” button in the
same area to open the
options window.
This window is bristling
with options, but in most
cases you will only need
to worry about four
things. In this step, find
the “Font Size” options
on the bottom left with
yellow background and
make those sizes larger
as needed. They will
instantly update in the
plot, so you can see how
large you need the label
fonts to be.

5.

Fix the curve thicknesses: The other two parameters on this screen that you may
want to tweak are the Curve thicknesses, which are the top two numbers on the top
right. These control how thick the curve lines appear in the plot

6.

Double-check your VSP: If you are using a V or VH plot,
then make sure that your Vertical Section Plane is set to the
correct value.

7.

Choose your objects: There are about 20 different
“objects” or data windows and elements that you can add to your plot. Check or
uncheck these as desired. NOTE: You can right-click on the word in many cases
here and instantly edit the data.
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Navigating the plots:
•

Zoom in and out: Use the mouse wheel while hovering over the plot itself

•

Cursor mode: Double left-click anywhere on the plot to switch between the two
cursor modes:
Ruler Mode: for drawing a temporary measuring line by holding down
the left mouse button.
Magnification Mode: hold down left mouse button to draw a rectangle
that becomes the new zoomed in area.

•

Resize the Top View: When using the VH mode, resize the smaller, inner Top
View window with the small red square in the bottom corner of the window.

Save Template: If you’ve put a lot of work into getting your QuickPlot just the way you
or your company needs it to be, save all of your choices by clicking “Save Template.”
(Blue button at the bottom of the righthand panel). This will save your configuration to
a special .hawkplot file that you can load back into QuickPlot by clicking “Get
Template.”

Reset All: The red “Reset All” button on the bottom right is a way to get back to default
settings if you have unintentionally gotten all the settings messed up in some way.
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2. PRESENTATION PLOTS

a. How the Plot Designer Works
The Presentation Plot Designer in HawkEyeTM is one of the most powerful and complex
aspects of the program. It utilizes scalable vector graphics (SVG) when generating wall
plots, making for very clean and precise visual representations of the native data
retrieved from the project database.
But SVG also allows a high degree of flexibility as far as zooming and resizing. The SVG
is in fact handled by a dedicated program called InkScapeTM, which installs with
HawkEyeTM. InkScapeTM itself a tremendously powerful SVG editor that, when even
only minimally understood, will produce very professional and sharp presentationcaliber plots.
SCALABLE VECTOR GRAPHICS (SVG)
SVG has been in development since 1999 by a group of companies within the W3C
after the competing standards Precision Graphics Markup Language (PGML) were
submitted to W3C in 1998. SVG drew on experience from the designs of both those
formats. SVG drawings can be dynamic and interactive. SVG allows three types of
graphic objects: vector graphics, raster graphics and text.
Graphical objects, including PNG and JPEG raster images, can be grouped, styled,
transformed, and composited into previously rendered objects. Text can be in any
XML namespace suitable to the application, which enhances search ability and
accessibility of the SVG graphics. The feature set includes nested transformations,
clipping paths, alpha masks, filter effects, template objects and extensibility.
The SVG Specification contains provisions for rich graphics, and is unlike XHTML,
whose primary purpose is communication of content, not presentation, and
therefore specifies objects to be displayed but not where to place such objects.
Conversely SVG is an ideal PDL for print-oriented uses, as it contains all the
functionality required to place each glyph and image in a chosen location on the
final page.
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WORKFLOW FOR A PLOT
The Plot Designer in HawkEye works in conjunction with other software in order to
make complex plots. The process cannot be described as simplistic, but nor is it too
arcane. There is a division of labor here amongst the programs. Here is the sequence
generally:

•
•

STEP ONE: HawkEye
Add all the graphs, charts, lists, graphics and components that you want.
Tweak the data aspects of graph grids, lists, as well as and colors.
[Click “Edit w/Inkscape”]

•
•

STEP TWO: Inkscape
Position the various items to where you want them.
Tweak non-data elements like label placements and indentations, etc.
[Print to PDF]

•
•

STEP THREE: Adobe Reader
Choose your paper size once your PDF is open.
Print to paper.

OPENING THE PLOT DESIGNER: The Presentation Plot module is opened by
clicking on the “Present. Plot” icon under the Edit tab. This is only found in
the Well Planning version of the program.
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FILE MENU: In the top left of the screen is the “File” menu. It
contains all the essential plot file management options:
•

Save Template: This will save whatever frames are
currently displayed in the plot designer as a template file
(.plt). User can define the name and location of the template
file. The default location where all default HawkEyeTM
templates are stored is c:/HawkEyeTM/plottemplates.

•

Get Template: This simply opens a file launch dialogue to
load any template (.plt) file into the Plot Designer.

MAIN CONTROL PANEL: Although the Plot
Designer has individual panels for each element
of a plot which can be opened and closed, there
is a Main Panel that always stays at the top left.
It is broken into two tabs, the Graph Objects and
Edit Frame tabs. Under the Graph Objects
(default open) tab, the user may select printer,
paper size and orientation, as well as templates,
adding frames and adding other elements to a
plot.
Click “Save PDF File” to get an instant PDF of
whatever is currently displayed without using
Inkscape. This is useful for quick plots containing relatively few elements (e.g. VS v.
Horizontal view)

PRINTING: The Print button, located just next to the paper selection drop-down menu,
allows for a wide variety of print sizes. When the CutePDF Writer is selected as the
printer, this selection contains virtually all print sizes. However, only in the Well
Planning version of HawkEyeTM will the larger wall plot sizes be available for printing.
In other words, the Field version of HawkEyeTM only has the conventional non-plotter
sized options for a paper sizes up to A3. Also note, a paper size is simply not available if
the selected printer will not support it.
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PRINTING PLOTS: FIELD v. WELL PLANNING VERSIONS
The difference between the Field version and Well Planning version of HawkEyeTM
with plotting is that only in the Well Planning version will the larger wall plot sizes
be available for printing and exporting. Only the smaller paper sizes are available in
the Field version since it is assumed that users of the Field version will not need a
plot printout larger than A3.
Exclusive Well Planning version print sizes include: A4, A2, 11x17, ISO A0-2, ISO B1,
B1-B4(JIS), ARCH A-E1, Folio [8.5x13in], 22x36in, 24x48in, 24x60in, 24x72in, 24x84in,
24x96in, 24x108in, 36x42in, 36x60in, 36x72in, 36x84in, 36x96in, 36x108in and
PostScript Custom.

PROJECT PLOTS: Each project is given up to four customizable templates. Select 1-4
from the Project Plots drop-down menu in order to open a template, and to save to it,
just have it selected and click the “Save” button next to the drop-down menu. The
template names can be changed to whatever descriptive name the user wants.
ADD COMPONENTS: There are dedicated buttons in the plot designer’s main control
panel for adding certain components:
• Add Vertical- add a Vertical Section view graph to the plot
• Add Horizontal- add a Horizontal view graph to the plot
• Add MD or TVD vs ??- Add a graph which charts MD or TVD against any given
parameter you chose.
• Add Graphic- Drop any sort of image file into the plot. NOTE: Any graphic
located within a folder path that contains special characters such as “&” will
not load into the SVG environment!
• Add Frame- This button encompasses a long list of additional types of frames
which can be selected from the drop-down menu in the sub-panel created. Those
frames include:
• Header
• Job Data
• Footer
• Slot Data
• General Data
• Text
• Critical Points
• Last 3D View
• Hard Lines
• 3D Perspectives
• Lease Lines
• Geomagnetics
• Lithology
• Geodetics
• Casing
• North Arrows
See more in the last two sections of this chapter titled “Add Frame.”
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SHOW LITHOLOGY: This checkbox will display any entered lithology data as the
background of a graph.
LEFT SIDE: When the user does not want to display the lithology across the entire
width of a VERTICAL SECTION graph, the “Left Side” toggle will limit the display to
only the left side of the displayed curve. This is useful for when the lithology data only
includes tops, which do not actually define dips across an extended horizontal plane.
TRANS: This is a translucency control that will determine opacity of the lithology
background, ranging from 1-100.
SHOW REAL LITHOLOGY: This toggle will overmap any data entered into the
lithology which reflects thicknesses, vertical section departure etc, from the surface
location.
PRINT PDF FILE: This button will pull up the print dialogue and automatically select
the CutePDF Writer as the printer for PDF export of the plot as it appears.
EDIT W/ INKSCAPETM: This button launches the all-important InkScapeTM application,
which utilizes scalable vector graphics (SVG) in order to move, place and resize all the
existing elements of the plot. It cannot be used to edit the plot’s actual data, however.
TEMPLATE FILE: The “Save” button under “Template File” will save the current plot
configuration to a template file (.PLT). Clicking “Get” will open the folder where
template files are stored. HawkEyeTM installs with about a dozen default templates to
choose from.

b. Vertical Section Plots
The vertical section frame is normally
included in the default plot templates since it
is staple information for plots. But for a user
wanting to start from scratch on building a
plot, the VS frame is easily added.
Add a graph depicting a vertical section view
of a project to the plot by clicking the “Add
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Vertical” button in the main control panel. Depending on the nature of the wells, either
Landscape or Portrait may be more appropriate. However, if the plot is very large this
preference will not hinge on the shape of the vertical section frame alone.
GRID FEATURES: The checkboxes in the blue field of
the sub-panel will control whether any of the grids or
the outer frame is displayed. Click on the circle to the
left of any of the grid boxes to open a color dialogue
and select a color for the element from the palette.
RESIZING: Height and width can be changed with the
drop-down menus. The boxes in between these menus
toggle whole-page vertical and horizontal expansion of
the graph. The “Outer Scale” slide control will resize
the frame as a whole. Further fine-tune resizing can be
done in InkScapeTM. (Launch InkScapeTM by clicking the
“Edit w/ InkScapeTM” button in the main control panel
on the top left quadrant of the Plot Designer).
PLACEMENT: The 9-circle grid on the top right will control the general placement of
the graph. However, for fine-tune placement (as well as resizing), InkScapeTM is used.
This grid is only for rough draft placing.
AUTO CALC: When this is toggled on, the Plot Designer will calculate the best way to
fit the relevant portion of the VS view into the graph space displayed. When turned off,
several manual fields are activated, including the vertical exaggeration factor and the
“Div/Tick” drop-down menu, which allows the user to define the number of graph ticks
per division. By increasing the ticks per division, there is a zoom effect on the graph. By
default, graph treats each tick as one inch, but to “zoom out” and increase the distance
per division, just slide down the “Inner Scale” slide control in the sub-panel.
VIEW CHANGES: VSP will change the angle at which the vertical section are being
seen, by degrees. The Start VS and TVD fields control the depth at which the curves
begin on the graph. Adjusting these two parameters when AutoCalc is turned off
allows the user to position the graphics within the grid.
GO TO CHART: The “Go to Chart” button allows the user to leave the Plot Designer
for a moment and re-adjust the positioning of the graph in the main HawkEyeTM
environment. The “chart” launched is merely the VS View, where zooming and
panning can be done in order to get a better view. To get back out of the VS View and
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back to the plot, just click the “View Plot” button at the top of the window. The next
step is to click the “PLOT FROM CHART” button. This button will take whatever
immediately preceding adjustments made in the VS View and implement them in the
current VS plot frame.
LABELS MANAGER: Click the “Labels
Manager” button at the bottom of the
sub-panel to launch the standard
Graphics Properties Labels controller.
This general panel controls both VS and
Top view label and grid characteristics.
In order to get VS and Top view graphs
to look exactly as desired, it is important
to experiment with and understand this
control panel. At the bottom, all settings
can be applied to this plot, all plots or all
charts.
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VERTICAL SECTION WITH LITHOLOGY
Lithology information of a project can be graphically displayed as the background of a
vertical section plot within the Plot Designer. The first step is to make sure there is
lithology data entered the way the user wants it into the project’s database. (See section
on Lithology, Ch.3).
Once a vertical section plot frame has been created
(Click “Add Vertical” in the main control panel of the
Plot Designer), the option to “Show Lithology” will
appear as a checkbox. Toggle on the “Show Lithology”
and the rest of the controls will appear.

TRANS: This is a translucency control that will
determine opacity of the lithology background, ranging
from 1-100.
SHOW REAL LITH.: This toggle will overmap any data
entered into the lithology which reflects thicknesses,
vertical section departure etc, from the surface location.

The “Show Lithology”
checkbox in the Plot
Designer main control
panel
will
project
lithology data as the
background of a graph.

LEFT SIDE: When the user does not want to display the lithology
across the entire width of the vertical section plot, the “Left Side”
toggle will limit the display to only the left side of the displayed
curve. This is useful for when the lithology data only includes
tops, which do not actually define dips across an extended
horizontal plane.
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c. Horizontal Plots
A horizontal plot is simply the “Top View” found in the
main HawkEyeTM module. A horizontal plot can be added to
a plot by clicking “Add Horizontal” in the main control
panel. Be sure to select the desired Paper Size and
orientation above.
Once the frame has been created, its sub-panel will appear
below under the header “Horizontal Plot.”
GRID FEATURES: The checkboxes in the blue
field of the sub-panel will control whether any of
the grids or the outer frame is displayed. Click on
the circle to the left of any of the grid boxes to
open a color dialogue and select a color for the
element from the palette. The “ADD” button will
add an entirely new generic frame.
RESIZING: Unlike many other frames in the Plot
Designer, the Horizontal Plot frame (as well as
Vertical Section View frame) is resized and edited
to a great degree without InkScapeTM. The controls
in the Horizontal Plot sub-panel contain most of
the tools needed. Click the boxes between the
Height and Width fields to maximize the Horizontal plot vertically or horizontally. Both
boxes checked means that the graph will occupy the entire plot.
AUTO CALC: When this is toggled on, the Plot Designer will calculate the best way to
fit the relevant portion of the Horizontal plot into the graph space displayed. When
turned off, several manual fields are activated, including the Origin grid. X and Y Offset
fields, and the “Div/Tick” drop-down menu.
DIV/TICK: By increasing the ticks per division, there is a zoom effect on the graph. By
default, the graph treats each tick as one inch, but to “zoom out” and increase the
distance per division, just slide down the “Inner Scale” slide control in the sub-panel.
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ORIGIN: When “Auto Calc” is
turned off, this grid controls
where the heart of the graph’s
information is positioned. This
is useful for spider plots of any
symmetry.
PLACEMENT: The 9-circle
grid on the top right will
control the general placement
of the graph. However, for
fine-tune placement (as well as
resizing), InkScapeTM is used.
This grid is only for rough
draft placing.

The Origin control (superimposed) will position
the platform of a Horizontal plot to one of nine
positions, allowing for balanced spider plots.

GO TO CHART: The “Go to
Chart” button allows the user
to leave the Plot Designer for a moment and re-adjust the positioning of the graph in the
main HawkEyeTM environment. The “chart” launched is merely the Top View, where
zooming and panning can be done in order to get a better view. To get back out of the
Top View and back to the plot, just click the “View Plot” button at the top of the
window. The next step is to click the “PLOT FROM CHART” button. This button will
take whatever immediately preceding adjustments made in the Top View and
implement them in the current Horizontal plot frame.
LABELS MANAGER: Click the
“Labels Manager” button at the
bottom of the sub-panel to launch the
standard Graphics Properties Labels
controller. This general panel controls
both VS and Top view label and grid
characteristics. In order to get VS and
Top view graphs to look exactly as
desired, it is important to experiment
with and understand this control
panel. At the bottom, all settings can
be applied to this plot, all plots or all
charts.
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d. TVD and TVD Function Plots
The Plot Designer can create graphs which plot the
measured or total vertical depth of a curve as a function
of another parameter. To add this kind of frame to a
plot, just click “Add MD vs ??” or “Add TVD vs ??” and
the frame’s sub-panel will appear below.

From the “vs” drop-down menu in the respective
sub-panel, the user can choose which
measurement to add the depth as a function to.
By making the selection here, the graph is
generated automatically in the plot and can be
resized or moved around.
GRID FEATURES: The checkboxes in the blue
field of the sub-panel will control whether any of
the grids or the outer frame is displayed. Click
on the circle to the left of any of the grid boxes to
open a color dialogue and select a color for the
element from the palette. The “ADD” button will
add an entirely new generic frame.
PLACEMENT: The 9-circle grid on the top right will control the general placement of
the graph. However, for fine-tune placement (as well as resizing), InkScapeTM is used.
This grid is only for rough draft placing.
DIV/TICK: By increasing the ticks per division, there is a zoom effect on the graph. By
default, the graph treats each tick as one inch, but to “zoom out” and increase the
distance per division, just slide down the “Inner Scale” slide control in the sub-panel.
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e. Add a Graphic
ADD A GRAPHIC: To add pictures and graphics to a plot,
first click the “Add Graphic” button in the main control
panel. This will create a sub-panel labeled “Picture” with a
sequential number. Then click the “Get File” button at the
bottom of the sub-panel to open the file selection dialogue
through which any graphic file format can be selected.
HawkEyeTM installs with a number of logos to choose from
(default folder: c:/HawkEyeTM/oilfield.logos) but any image
file may be added to the plot.
To add a second graphic, simply click the “Add Graphic”
button again and another “Picture” subpanel will appear.
RESIZING: Resizing the graphic is done in two ways: either
manually adjusting height and width in the sub-panel, or by
sliding the “Outer Scale” slide control on the right. (Fine-tune
resizing is done in InkScapeTM. Click “Edit w/InkScapeTM” in
the main control panel to launch).
ADJUSTING TRANSLUCENCY: By sliding down the “Inner Scale” slide control, a
graphic’s opacity is reduced. This is useful for creating watermarks on a plot.
PLACEMENT OF GRAPHIC: The 9-circle grid in the sub-panel will give the graphic a
rough placement on the plot, but any fine-tune placement and resizing of the graphic
and of any frame is done in InkScapeTM, the scalable vector graphics program attached
to the Plot Designer. Click the “Edit w/ InkScapeTM” button in the main control panel to
launch the program. (More on InkScapeTM below).
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f. Add Frames: Most Commonly Used
Most of what can be added to a presentation plot falls under the “Frame” category. The
list of frames that can be added are the following:
• Header
• Job Data
• Footer
• Slot Data
• General Data
• Text
• Critical Points
• Last 3D View*
• Hard Lines
• 3D Perspectives*
• Lease Lines
• Geomagnetics
• Lithology
• Geodetics
• Casing
• North Arrows
* Explained in the following section “Add Frame: Screenshots”

This following sections detail the most commonly used frames:

1.
2.
3.
4.
5.
6.

Add/Edit/Delete Frames
Header
Lithology, Casing and Target Lists
Targets List
Critical Points List
Geodetics, Magnetics and a North Arrow
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1. Add/Edit/Delete Frames
ADD FRAME: After clicking the “Add Frame” button from
the main control panel, a component bar appears below the
main panel labeled “Frame.” In this sub-panel, the frame
type can be selected from the “Frame” drop-down menu.
There are 17 types of frames to choose from.
Most of the frames, once chosen and placed, will have the
same set of controls for editing. That control set will be
located in this very same sub-panel, but there will be slight
variations on the controls depending on which frame is
selected.

SELECT FRAME: Only one frame can be selected at a time
for editing. To select a frame, click on the circle to the left of
the component header. When not selected, this circle is pink.
When a frame is selected, its circle is green and its sub-panel
is expanded.

DELETE FRAME: To delete a frame, just click on the red box
on the right end of the sub-panel header. This will instantly
remove the frame and all of its settings from the current plot,
so make sure to have any templates saved before killing a
frame.

173
HawkEye

TM

User’s Manual

Copyright © 2022 by Performance Drilling Technology

EDITING FRAMES: Once a frame has been created,
you can use the “Frame” submenu to edit its CORE
properties. (For more fine-tuning, you will click the
“Edit Frame” tab on the top left). Use the radio buttons
to pull up their corresponding options dialogues:
background color, font color and frame color. You may
toggle whether a colored frame outlines the frame
itself by toggling the “Show Frame” box. You may also
toggle “Section Lines,” which will show if there is
more than one column in the frame itself. Frame size
and width is also controlled in this sub-panel, as is the
font properties found in the header. Click “Font” to
pull up the font properties. The Outer Scale meter will automatically resize the frame,
font and all. Click “Save” to save all the current settings to default for future frames of
that type.
EDIT FRAME TAB: The other tab in the main control
panel of the Plot Designer is the Edit Frame panel. It
is used for more fine-tuning of any given frame. The
first step is to select the object to be edited from the
Frame Objects drop-down menu. This will dictate the
kinds of options that will be available in the rest of the
panel.

Thus there are two levels in which to edit plot frames in HawkEyeTM and they are each
found in their own tab of the main control panel of the plot designer. The colors, fonts
and outer scale is edited under the “Graph Objects” tab, where such frames can also be
added. Under the “Edit Frame” tab, specific spacing parameters can be entered, as well
as section divides and section styles.
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2. Header
The first step in creating a presentation plot from a blank
slate is to add a header. To do that, click the “Add
Frame” button from the main panel, then in the “Frame”
drop-down menu select “Header.” A standard header
will appear at the top of the plot with graphical logo on
the left and seven lines of header text to the right of the
logo. You may edit the basic characteristics of the header
frame as described above, but you may also click the “Job
Information” button to edit the actual information found
in the header.
To edit a header more closely, select the “Edit
Frame” tab on the top left. Then select
“Header” from the “Frame Objects” dropdown menu. You will now see the breakdown
of how the header is built in this panel. By
default the header is composed of three
sections, which can be changed. To change the
relative widths of each section, you will
manually enter the ratio in the “%” field.
Each of these numbers represents the
percentage of the total width of the header at
each section divider.
So in the following example, the ratio of “0, 12, 88, 100” divides a header that looks like
so:

The three sections are 1) the graphic section, 2) the “text flow” section and 3) another
graphics section. The dividers come at 0% width, 12% width, 88% width and at the end
at 100% total width. The next picture shows a ratio of 1,9,91,100:
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To edit any of these sections, use the “SECTION SELECTOR” to move the number up
and down. Sections are numbered from left to right, so the first graphic section above
would be “1.” It is characterized under the “Section Style” drop-down menu as a
“Graphic.” To change this particular graphic, make sure the Section Selector is on “1,”
then click “Browse” to select a different graphic for that section.
NOTE: Any graphic located within a folder path that contains special characters such
as “&” will not load into the SVG environment!
Hit “Apply” after selecting any new graphic or making any changes.
To edit a “Text Flow” section, use the Section
Selector to select it. In this case it would be “2.”
Once selected, the entire panel will change to
display all the text flow options. The most salient
options are the number of rows and columns. Just
like with section width ratios, the spacing of these
columns are controlled by manually entering
ratios. However, notice that the ratios are
specified by default as decimals up to the
hundredth power, so mind the punctuation in this
field.

ADDING DATA COLUMNS: Further below in
text flow editing panel are the data type selection
columns. There you can choose which kinds of
data will appear in the text flow section. On the
left are all the available data types that can be
added.
To add one, left-click on it, and it will appear at
the bottom of the right-hand column. The righthand column, likewise, displays in order from top
down which data types are displayed from left to
right on the plot (restarting from top left on
subsequent rows and columns).
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To remove a data type, left-click and then right-click on the word. To re-order the data,
you must remove each of them and re-stack them in the desired order.
In the following example, there are 14 data types, 7 rows and 2 columns. The columns
are given width ratios of 0,50,100. Remember that the width ratios within a text flow
area only apply to that section, not the entire frame.

Here is another example. The text flow
section is given three columns, with 8
rows per column. But the width
breakdown is a little different:
0,20,80,100.
This creates columns within the text
flow section that are not symmetrical,
which is what the user may want:

MAKE DEFAULT: Once all changes have been made to spec, be sure to click “Make
Default” at the top of the Edit Frame panel.
SAVE AS TEMPLATE: To save any
component or frame settings in one of the four
template slots, just click the Graph Objects tab
at the top, then use the pulldown menu to
select which slot you want to save under, then
click the “Save” button to the right. Remember,
saving in a slot will erase the old template in
that slot, so keep track of your templates.
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3. Lithology, Casing and Targets Lists
The lithology, casing and targets frames are the kinds found
under the general frames list, so to add them to a plot, just
click “Add Frame” in the main control panel on the left side
of the Plot Designer. A “Frame” sub-panel will appear, and
from the “Frame” drop-down menu, select Lithology. It will
automatically appear. Don’t click the “Add” button unless
you want a second frame of that type.
SAME PROCESS: This creation process is the same for
casing and targets, and all of the controls described below are
also identical.
PROXY CONTROL: Once the lithology frame has been
created, it will appear on the plot. Below the plot will also
appear a proxy control. This proxy control emulates the
selected frame (select any frame by clicking on its sub-panel on the left) and allows the
user to resize columns by clicking and dragging borders. So when a column width is
resized in the proxy control, its respective frame is resized.

Certain frames like lithology, casing and targets have a proxy control that
appears below the plot, where by adjusting the proxy chart column widths, the
frame’s column widths are adjusted.
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All the characteristics besides column width are controlled in the frame’s sub-panel.
Click on the radio button to pull up each respective dialogue.
NOTE: To trigger changes made to the frame here, sometimes another change must be
made. The easiest way to do this without making unwanted changes is to check the
“Show Frames” box twice.
ANCHOR CONTROL: The 9-circle grid on the top right
of the panel is an anchor control which delineates which
quadrant of the plot the frame will be placed. Sometimes
the frame will not be place in the absolute corner of a
plot when told to do so because of the spacing priority
logic of previously placed frames or objects. But this
anchoring control is only for rough placement anyway.
All final placements on a plot are done in InkScapeTM.
(To get to InkScapeTM, just click “Edit w/ InkScapeTM” at
the top of the main control panel).

Frames are placed via the 9-circle grid of their respective subpanels. However,
they will be stacked on top of other frames if the spot is already taken. This is
because the anchor is only for approximate placement. All final placements of
frames and objects are done in Inkscape where they can also be warped, resized,
drawn and commented on.
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4. Targets List
Further editing of a grid-style section can be done under the “Edit Frame” tab, selected
from the top of the main control panel in the Plot Designer. Changing a frame without
making it a default will have the changes only apply to the current plot. Once Make
Default is selected then the changes will be reflected in all newly generated plots. One
of the most common grid style sections in plots is the Target List. To fine-tune edit such
a list once it has been created in the plot, just click the “Edit Frame” tab, then select
“Targets” from the “Frame Object drop-down menu. Then be sure to select “Grid” from
the “Section Style” drop-down list.
OTHER GRID-STYLE FRAMES: Lithology and
Casing lists are also grid-style lists, so they can be
fine-tune edited under this tab by selecting them
under Frame Objects drop-down menu and
selecting “Grid” for the section style.
The font, number of columns and overall width of
the frame is controlled in this panel. Check the
“Show Grid Lines” box to display the lines along
each of the columns.
COLUMN WIDTHS: The column width field
allows the user to define widths by percentage from the left. The number of percentage
values given depends on the number of columns in the frame. Each value defines where
a column division is placed, with the first and last values (0 and 100) representing the
outer edges of the frame. The following target list has 6 columns with a column width
percentage of 0, 16.67, 33.33, 50, 66.67, 83.33, 100:

The column width percentages will automatically generate to equal spacing when a
new number of columns is selected for the frame.
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ADDING DATA COLUMNS: Further below
in text flow editing panel are the data type
selection columns. There you can choose which
kinds of data will appear in the text flow
section. On the left are all the available data
types that can be added. To add one, left-click
on it, and it will appear at the bottom of the
right-hand column. The right-hand column,
likewise, displays in order from top down
which data types are displayed from left to
right on the plot (restarting from top left on
subsequent rows and columns). To remove a
data type, left-click and then right-click on the
word. To re-order the data, you must remove
each of them and re-stack them in the desired
order.
APPLY/MAKE DEFAULT: Be sure to click the “Apply” button after making each
change to the frame so that it will appear in the plot. Once all the parameters of a given
frame type have been set up to personal spec, then click the “Make Default” button to
save them as such.
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5. Critical Points List
Critical points frames are the kind found under the
generic “Add Frame” button in the main control
panel.
To add a critical points list to the plot, click the “Add
Frame” button, which will create a new sub-panel
below labeled “Frame.” From its “Frame” drop-down
menu, select “Critical Points.” This creates the frame
in the plot.

RESIZING: Resizing the critical points list is done in
two ways: either selecting a width in the sub-panel
width drop-down menu (height is determined by the
content of the list itself), or by sliding the “Outer
Scale” slide control on the right. In addition, a frame’s
column widths may be altered with the proxy grid just below the plot window.
RESOLVING TEXT OVERLAP: The critical points list, like many of the other
informational list-based frames in the Plot Designer, may display overlapping text and
numbers when initially placed. This is resolved in three ways:
a. Resize and/or change the font by clicking the “Font” button.
b. Enlarge the frame by increasing width in the sub-panel.
c. Resize the frame and/or its components in InkScapeTM:
InkScapeTM allows each of the elements in
a frame to be resized and manipulated, so
resolving individual instances of text
overlap is as easy as clicking on the
trouble line and resizing it.
NOTE: InkScapeTM will not alter the actual
information itself. Such changes must be
made in the project itself in HawkEye’s
main interface or in the Plot Designer
editing field below the preview window.
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6. Geodetics, Magnetics and a North Arrow
The Geodetics, Magnetics and North Arrow frames all have
identical sub-panel controls, and they are among the
simplest of all the frames that can be added to a plot.
ADD THE FRAME: To add any of these frames, click the
“Add Frame” button in the main control panel of the Plot
Designer, then select any of the bottom three selections from
the “Frame” drop-down menu in the sub-panel.
FRAME FEATURES: The user may control background,
font and frame color, as well as height and width of the
frame. If a font size or type becomes larger than the
background of the frame itself, there may be clipping. This
is resolved by increasing the dimensions of the frame size.
The Inner Scale slider is inert, but the Outer Scale slide
controls the overall size of the frame. Click “SAVE” to save
the current settings to the default for that particular kind of
frame.
RESIZING AND PLACING: Although resizing is mostly done in the Plot Designer,
fine-tune resizing and placement is done in InkScapeTM. (“Edit w/InkScapeTM” button).

The Geodetics, Magnetics and North Arrow frames all have an identical subpanel control set. These feature controls are the simplest of all the frames.
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g. Add Frames: Screenshots
There are two special frames that can be added to the plot which take images from the
3D space. The Multishot will take four screenshots of a single point, and the Last 3D
View will take the very last 3D view that you see before the Plot Designer is opened.

1. 3D Perspectives (Multishot)
HawkEyeTM can take four snapshots of the same
3D space from the four cardinal directions and
place them in a plot. To do this, the user must align
the 3D window view to the desired portion of the
curve to be captured. Once the Look-at Point is
positioned to the desired place, select the snapshot
mode in the “Mode” drop-down menu just under the 3D window. The choices are
Vertical M.S., Custom M.S. or Snapshot.
VERTICAL M.S.: This mode takes four
screenshots of the current Look-at Point from
a flat angle, looking straight across. It is
essentially a 3D vertical section view of the
Look-at Point from 0, 90, 180 and 270 degrees
azimuth.

CUSTOM M.S.: This mode will take four
screenshots of the current Look-at Point, but
from any inclination up or down that the POV
is currently positioned at. The shots are still
taken with the north, south, east and west
direction .
SNAPSHOT: This mode allows the user to
take a single screenshot of the currently
displayed view in the 3D window to later load as a graphic in the Plot Designer. When
taken, it requires the user to enter a file name for the snapshot.
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TAKE THE SHOTS: Once the multishot mode is selected, click the Snapshot icon to the
right of the drop-down menu.
This will take the four
shots in the case of the Vertical and Custom M.S. and the
single shot if the Snapshot mode is selected.
SELECT THE SET: For Vertical M.S. and Custom M.S.
modes, up to ten different sets of shots can be saved. After
taking the shot, the Graphics Set prompt will appear.
Choose the slot to save the current set to, from 1 to 10. This set of screenshots is later
chosen in the 3D Perspectives sub-panel before loading into the plot.
Vertical Lines (droplines) can also be added here to each of the curves with the
checkbox at the bottom. They would be generated here and saved permanently in the
screenshots.
3D PERSPECTIVES FRAME: Launch the Plot Designer
from the top left of the main screen.
The Multishot frame is treated as a generic frame, so to add
it, just click “Add Frame” in the main control panel. Then
select “3D Perspectives” from the “Frame” drop-down
menu. This will immediately generate the multishot frame
in the plot window on the right.
The frame is called “3D Perspectives” because the sub-panel
allows for the multishots as well as a snapshot to be loaded
into the plot.

Once the frame is created, the multishot sub-panel will allow for certain setting
adjustments. The colors can be adjusted by clicking the circle to the left of the color
labels.
PLACEMENT: The 9-circle grid on the top right will control the general placement of
the graph. However, for fine-tune placement (as well as resizing), InkScapeTM is used.
This grid is only for rough draft placing.
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RESIZING: The Width drop-down menu is the primary way to resize the multishot
frame, whereas height does not control the size nearly as much. The Outer Scale slider
control will shrink the frame while keeping aspect ratio. To further resize this
screenshot frame, launch InkScapeTM by clicking the “Edit w/ InkScapeTM” button in the
main control panel above.
LAYOUT: Select “Horizontal” to line the four
screen shots in a row on the plot. “Vertical”
will stack them in a column. “Rectangle” is the
default and will arrange them in a 2x2
orientation.
TYPE: Select either Ver. MS, Cus. MS or
Snapshot in order to instantly change the set
of screenshots displayed in the frame.
HawkEyeTM will pull the set from the type as
they were captured in the 3D space. There will
be no changes to the frame if a screenshot set
for that type has not be taken yet.
SET: This drop-down menu allows the user to
select the graphic index 1 through 10, loading
the respective index into the frame itself. These indexes are available for Vertical M.S.
and Custom M.S. and the prompt to choose the index always appears after taking the
shot in the 3D space.
IND AND CAPTION: This drop-down menu selects the “index” from 1 to 4, selecting
the caption field to be edited. The captions under each screenshot can be edited by
selecting a number from this menu and then editing the text in the “Caption” field. (The
default is: 1 -“North View,” 2- “East View,” 3- “South View,” and 4- “West View.”)
Click on the “FONT” button to edit the font characteristics of the captions.
AUTO SCALE: Checking this box will attempt to resize the SNAPSHOT, if there is one
loaded in the plot, into a size comparable to surrounding
loaded screenshots.
FILE: This field becomes active when the “Snapshot”
Type is selected. Click the “Browse” button to load either
the snapshot taken from the 3D space or ANY graphic file
to load. NOTE: To load custom graphic files, the “Add
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Graphic” button in the Plot Designer main control panel will launch a dedicated picture
frame sub-panel.
SAVE: Click the “Save” button to lock in the current settings as default for every time a
new 3D Perspectives (“multishot views”) frame is created in the Plot Designer.

2. Last 3D View
Any time the Presentation Plot Designer is launched
from the main screen, it grabs the last 3D view that is
being displayed in the 3D window. To customize the
screenshot itself before launching the Plot Designer, the
user simply resizes the window and calibrates the 3D
view itself to reflect whatever view is desired. Once set
up, just click the Presentation Plot icon at the top.
The next step, once inside the Plot Designer, is to click
“Add Frame” and select “Last 3D View” from the
“Frame” drop-down menu of the new sub-panel. This
will automatically drop the 3D screenshot into the plot.
TEMPLATE: In order to always have the Last 3D View
dropped into a plot, just add this frame to a plot and
save as a template. The Plot Designer will treat that
space as any other template-designed frame and fill it in
with the actual last 3D view displayed.
RESIZING: Height and width can be changed with the
drop-down menus. The “Outer Scale” slide control will
resize the graphic as a whole. Further fine-tune resizing
can be done in InkScapeTM. (Launch InkScapeTM by
clicking the “Edit w/ InkScapeTM” button in the main
control panel on the top left quadrant of the Plot Designer).
PLACEMENT: The 9-circle grid on the top right will control the general placement of
the graph. However, for fine-tune placement (as well as resizing), InkScapeTM is used.
The grid is only for rough draft placing.
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h. Finishing With InkScape™
The InkScapeTM program is installed with HawkEyeTM as a companion program which
acts as an empowered module for extremely professional plot layouts. Although the
program installs with HawkEyeTM, you may also download it to any computer as a
standalone SVG application by going to http://InkScape.org/download.
WHAT IS INKSCAPE?
Inkscape is an open source vector graphics editor, with capabilities similar to Illustrator,
CorelDraw, or Xara X, using the W3C standard Scalable Vector Graphics (SVG) file
format.
Inkscape supports many advanced SVG features (markers, clones, alpha blending,
etc.) and great care is taken in designing a streamlined interface. It is very easy to
edit nodes, perform complex path operations, trace bitmaps and much more. Its
creators also aim to maintain a thriving user and developer community by using
open, community-oriented development. As such, it has become an extremely
polished SVG editor that is the product of tens of thousands of dedicated
manhours over the course of ten years.

1. Primary Functions
InkScapeTM is used in HawkEyeTM primarily to RESIZE plot frames and the
alphanumeric elements within, as well as PLACE those frames in exact positions for a
fine-tuned plot layout.
OPENING INKSCAPETM: You can open InkScapeTM at any
time from the Plot Designer by clicking on the “Edit w/
InkScapeTM” button. This will launch InkScapeTM, but make
sure to have all frames of the plot already placed. Such
elements can only be added in the Plot Designer. InkScapeTM
allows for the adding of additional graphics and comments,
as well as editing text and numbers, but is not integrated
with the database information of a project in HawkEyeTM.
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When InkScapeTM opens, all of the elements
that have been placed in the Plot Designer
will appear in the same paper size but in
SVG layers. Although it may appear a
jumble, now each of the elements can be
moved about freely and precisely. If the plot
in InkScapeTM appears small, hit “5” to
automatically fit the plot to screen width and
height.
LAYERS: The SVG elements (plot frames and
graphics) in InkScapeTM are treated as sets of
layers, which can be selected individually, in
groups or even linked together. Select a layer
by double-clicking on it in the graphic
window. By double-clicking again and again
on an element, different layers within that
element are selected. Double-click on any
blank space in the graphics window to get
back to the root layer. The layer indicator appears at the bottom left of the screen.
ZOOM: Select the magnifying glass icon on the left side of the screen to go into zoom
mode and simply draw a box over any portion of the graphics window to zoom into
that area. To get back to the whole page view, hit “5” on the keyboard. Advanced zoom
preferences can be explored in the Preferences panel (File>Preferences or Shift+Ctrl+P)
which allow for things like zooming with the scroll wheel.
MOVING OBJECTS: To move an object, it
must be selected. Since InkScapeTM works in
SVG, there are often multiple layers to each
object. A singular element may be selected
when trying to move an entire object, resulting
in fragmentation. When this occurs, simply hit
Ctrl+Z to undo the move, then double-click on the object until it is selected in its
entirety. After a little practice, this becomes second nature. And sometimes particular
layers of a list or grid will need individual nudging, so it’s a valuable tool. One hint is to
keep an eye on the layer name at the bottom and get accustomed to how the layers are
labeled.
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RESIZING: When an object is selected, arrows will appear at its corners and sides.
These are “handles” which can be clicked on and dragged to resize the object. One
major issue with resizing an object is the aspect ratio. (Ctrl+Z to undo unwanted
resizings). InkScapeTM has two methods of retaining aspect ratio when resizing an
object. 1) Hold down SHIFT while dragging a corner
handle of an object, or
2) Click the “Lock” icon at the top while the object is
selected. This will permanently lock the aspect ratio for
that selected object. Be sure that the entire object is
selected and not just one layer in it.
GROUPING: Two or more objects can be “grouped” or
locked in an orientation and moved as one object. This is
useful for when getting graphs placed on top of each
other and not wanting to re-place the graphs when
moving them around the plot. To group objects, they
must all be first selected at once. To select multiple
objects, select one then HOLD SHIFT while selecting
another. Or draw a box over all the objects to be selected
with the black arrow selector tool and they will be
simultaneously selected. Then as a final step, click the “Group” icon at the top of the
page to marry all the objects together. Any group will be moved and resized as if it
were one object.
SENDING LAYERS TOP AND BOTTOM: Since all
objects are layers, they are stacked from front to back, or
“top” to “bottom.” Layers that are closer to the top are
displayed when overlapping any layers that have a
lower status or designation. In laying out a complex
plot, there will be objects that overlap each other and usually the smaller elements will
need to be on top so that they are not covered by the larger ones. To control the layer
status of an object, just select it, then go to the four icons at the top of the screen. They
will either 1) Lower selection to bottom, 2) Lower selection down one level, 3) Lower
selection up one level, or 4) Lower selection to top.
ADDING TEXT AND NUMBERS: InkScapeTM allows for
the adding of comments, as well as the editing of text
fields within lists that have been added from HawkEye’s
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Plot Designer. The first step is to set up the font and size settings. Do this by clicking on
the Text and Font panel box at the top of the page or hit Shft+Ctrl+T. Click “Set as
default” in the panel to make those settings permanent.
Then select the Text Tool on the bottom of the left side (or hit F8). As
with all specialized tools in InkScapeTM, the cursor will change to
indicate which mode the user is in. Here the cursor is a crosshair with
the letter “A.” Use the Text cursor to draw a box on the graphics
window. This will create a text box in which text can be entered.
PASTING TEXT: Once this text box is drawn, simple text can also be pasted into the
box from other programs. But note, InkScapeTM will only display simple text and none
of the more complex formats. Any changes to font, size and color must be done after
pasting into the textbox.
Color of the text can easily by changed by 1) selecting the text box itself, then 2) clicking
on a color along the color palette bar that stretches along the bottom of the screen.
Editing the text field within a list is as simple as
clicking on that field and typing in or deleting
whatever data is there. But remember that InkScapeTM
is not integrated with the project database
information itself, so whatever data changes are made
in InkScapeTM are neither saved to the project nor
verified by HawkEyeTM in any way.
ALIGN TOOLS: To make sure that any or all objects
are aligned correctly, select any or all objects and click
one of the alignment options found on the right-hand
side of the screen. If the options are not displayed,
then hit Shift+Ctrl+A for them to appear.

PRINTING: The recommended way to print the final plot is to first SAVE AS A PDF
(File>Save As, then select “Portable Document File” as filetype). After saving the file as
such, open it with Adobe Reader, which is free and should be installed on any
computer, and select print options from there.
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2. Tips and Tricks

a. Setup Tips
As with HawkEyeTM, spending a little time to explore InkScapeTM will pay back in
spades. In the case of InkScapeTM, the better one is with its interface, the more advanced
and professional-looking a plot will have the potential to be. There are many great
tutorials
online
for
InkScapeTM.
A
basic
starter
is
found
at
http://InkScapeTM.org/doc/basic/tutorial-basic.html. There are certain preferences and
tricks in InkScapeTM which grease the wheels navigation and of enhancing plot-design.
Here are a few setup tricks:
SCROLL ZOOM: Zooming in and out with a scroll wheel is convenient and can save a
lot of time with large plots. Since HawkEyeTM users should be using a hyperscroll
mousewheel, the zooming can become a convenient second-nature activity. But the
option needs to be turned on.
All preferences are found under
File>Preferences (Shift+Ctrl+P), and
each of them is divided into categories
on the left column in the preferences
panel. To turn on the Scrollwheel
Zoom feature, click on “Scrolling” in
the Preferences window. Then check
“Mouse wheel zooms by default.”
Another useful option to turn on here
is LEFT MOUSE BUTTON PANNING.
Just check the box labeled “Left mouse
button pans when Space is pressed.”
This option will do just that.
FIT TO PAGE: Set InkScapeTM to always fit
to page when opening by going to
File>Preferences (or Shift+Ctrl+P), then in the
Preferences scroll down the left column to
“Windows” and check the “Zoom when
window is resized” box. Also remember, hit the number “5” on
the keyboard to autofit everything to the screen in its entirety.
You may also click on the “Fit to Page” icon at the top of the
screen.
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b. Drop Shadows
Adding graphical flourishes to plot objects is the whole point of InkScapeTM in
HawkEyeTM. One essential such embellishment is the drop shadow, which gives a frame
a sense of depth.
To add shadow to a frame, first select the frame by clicking on the
Rectangle Selector, then with the plus-rectangle cursor, click on the frame.

Once the frame is selected, go to Filters>Shadows and
Glows>Drop Shadows. This opens the Drop Shadow
dialogue in which the shadow can be highly customized. But
the default drop shadow is a fairly decent as it is. Click
“Apply” and the drop shadow will appear “behind” the
frame. It is actually part of the layer and will move/resize
with it. To edit this effect, just select the frame and go back to
the Drop Shadow dialogue.

Drop shadows will add a sense of depth to any frame, enhancing the plot with a
3D feel. Many other effects are found under the “Filters” menu in Inkscape.
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c. Arrow Pointers
Complex parametric curves (Bezier curves) can be dropped onto a plot in InkScapeTM as
arrows to simulate the organic look of handwritten marker notation. This effect is useful
for callouts and has the advantage over actual marker notations because the arrow and
comments are both cleanly defined and editable before printing.
To make such an arrow pointer, first select the Bezier Drawing Tool on the left side of
the screen. Once selected, click on the screen once (1) with the tool to set the first point,
then click a second time (2) to place the Bezier pivot point. Finally click a third time (3)
after bending the hypothetical curve to create the end point. The straight line will
disappear and only the curve will remain.

Once the curve is created, its style can be edited in the Fill,
Stroke Paint and Stroke Style panels on the top right corner of
the screen. This panel is available for many objects in
InkScapeTM and provides a wide array of customization options.
Select the color under the Stroke paint tab.
To make the curve an arrow pointer, it is simply a matter of
selecting a “Start Marker” and “End Marker” under the Stroke
style tab. The choices are many under these drop-down menus
and just by changing the endings a curve can transform into
many different objects.
EDIT THE CURVE: Click on the “Edit Path Nodes” icon just below the black arrow
icon on the top left of the screen, or hit F2 to go into “Edit Path Nodes” mode in order
reactivate the draw nodes of the curve. Now by dragging the nodes around, the arrow
is re-drawn on the fly, but will retain its start and end markers. This is necessary for
precision placement on a plot.
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ADD TEXT: To add a text box, click on the “Text” icon on the bottom left, or hit F8 to
go into Text Mode. Then draw a box onto the graphics window and type in any desired
comments. This box can be placed at the end of the pointer to create a callout.

SAVE THE ARROW POINTER: Select the entire arrow, then go File>Save As and save
the arrow as a .SVG file. This will save the arrow as an importable object that can later
be added to other plots.
To IMPORT the arrow, just go File>Import… (Ctrl+I), then select the file from wherever
it was saved. Editing the direction of the arrow in new plots simply requires hitting the
F2 button to activate the Edit Nodes mode and then dragging those nodes around until
it is shaped just right.
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VI.

BHA/DAILY

The BHA/Daily module in HawkEye is where users can input the following
information:
•
•
•
•

New/Edit Job IDs
Tool Lists
BHAs
Daily Items

It is also where Daily, BHA and End-of-Well reports are generated. This chapter will
cover the basic layout of the module, as well as some tips and tricks, but not
exhaustively cover every single feature of the module.
Launch the BHA/Daily: Click on the “BHA Daily” icon at the far right of the row of
icons in the Home tab of the main screen.

The layout of this module is broken down into seven main tabs at the top, as well as a
brief “File” menu accessed from the top left.
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1. File Menu
Export Current Job to .hwkjob: This allows you
to save all BHA/Daily information from the
current job (as entered into and displayed in the
BHA/Daily module) to a special file. That file
can then be imported back into HawkEye.
Importing a .hwkjob Job file: To import such a file,
you need to be in the main screen of HawkEye. In the
Data Tree, right-click on the curve that you want to
import the job info to and select “Import Job From
.hwkjob File.” NOTE: There is nowhere inside the
BHA/Daily module to import a .hwkjob file. You
have to be in the main screen and import it from the
curve’s right-click menu, as show here.

Import a WinSurv2 .mdb
database: You can bring in a legacy
.MDB (Access 97 database) file that
was created with PDT’s
WinSURV2 program. The dialogue
that opens will allow you to select
specific jobs from that .MDB that
will be imported and saved in the
current HawkEye database.
1. Click “Browse” to select the .MDB from your computer.
2. Click “Load Jobs Below” to load the database into this dialogue.
3. Check or uncheck as desired in the ”Import/Overwrite” column.
4. Click “Import Jobs” to bring in the selected jobs.
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2. Job Overview
Current Job: When opening the module, the name of the current job that is associated
with the current curve is shown in large white letters against a black background.
Jobs List: The column on the far left displays all jobs
contained in the current HawkEye database. They are
organized in alphabetical order under each Company.

Edit Current/Selected Job: The middle column displays
whichever job is selected on the right. NOTE: This is not
necessarily the current job. By clicking on any job other
than the current one, the program will warn you that you
are VIEWING another job. You can edit this job’s basic
information in the center column here, but it is not going
to be the job associated with your current curve.

BHA/Daily Reports: On the right is the BHA/Daily’s entire reporting module. It is
repeated again in the last main tab of the module labeled "Reports,” but is all here on
the first tab as well. There are two formats of reports that you can generate:
•

PDF Reports: The list of reports with the black background listed
up front are all PDF reports that will show a preview when you
click on them.
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•

Excel Reports: Click on the blue “Export Excel” button to
open the report assembler that produces Excel-spreadsheet
format reports.

1. Select the report that you would like to generate. The preview on the right
does not contain the specific information of your report. It only shows you
the format of the report.
2. Select the specific information for that report (e.g. date range, BHA number,
etc).
3. Click Add Sheet(s). This will add the report into the bottom left black box
titled “Your Report:”
By repeating Steps 1-3, you can assemble a multi-tabbed spreadsheet report. When
you’re done compiling the kind of custom report that you want, click “Export to Excel”
at the bottom.
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3. Tool List
The Tool List displays all tools related to a job.

•

For best results, after clicking “Add Tool” and entering information on a new
tool, fill out ALL columns of the new row.
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4. BHA Manager
The BHA Manager is used to oversee all BHAs run on a job.

•

Casing Data is one of the few data points that can be entered from the main
screen of HawkEye, under the Edit tab.

•

The “More Motor Data” button contains a lot more parameters that can be
entered for any particular motor.
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5. BHA Builder
The BHA Builder is used to build up individual bottom hole assemblies.

•

Start with the Bit

•

If you plan on using the Hydraulics module in the program’s main screen (at the
end of the row of icons on the Home tab), be sure to add HWDP at the end of
your BHA here.
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6. Daily Manager
The Daily Manager is for seeing all the days of where a job has activity, as denoted by
red circles on the calendar in the top-middle of the screen. You can also track daily costs
on the top right.

•

Make sure your “End of Reporting Day” time is set to the right time for your job
(top left of the screen)

•

Click on any day in the calendar with a red circle to see all of that day’s entered
daily activities at the bottom.
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7. Daily Items
The Daily Items are where you enter daily activities.

•

After clicking “Add Activity” (bottom left), the best practice is to fill out all
information for that row through End Depth.
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VII.

WELL PLANNING

TWO MODES: There are two overall modes in
HawkEye. The Field Mode is default and available
in both versions. It is used for directional drillers
who are not creating much in the way of complex
proposals or well plans. Whereas the Well
Planning Mode, available only in the Well
Planning Version, is used to created complex well
plans.
To get into the Well Planning Mode, you need
the Well Planning Version of HawkEye.

TWO DIFFERENCES BETWEEN THE TWO VERSIONS
1. PRINTING PLOTS: The difference between the Field Version and Well Planning
Version of HawkEyeTM with plotting is that only in the Well Planning Version will
the larger wall plot sizes be available for printing and exporting. Only the smaller
paper sizes are available in the Field version since it is assumed that users of the
Field Version will not need a plot printout larger than A3.
Exclusive Well Planning Version print sizes include: A4, A2, 11x17, ISO A0-2, ISO
B1, B1-B4(JIS), ARCH A-E1, Folio [8.5x13in], 22x36in, 24x48in, 24x60in, 24x72in,
24x84in, 24x96in, 24x108in, 36x42in, 36x60in, 36x72in, 36x84in, 36x96in, 36x108in and
PostScript Custom.
2. WELL PLANNING: The principle difference to keep in mind between the Field
Version and Well Planning Version of HawkEyeTM is that, although they both have
the same arsenal of projections which can be appended end to end, only in the Well
Planning Version can a projection be edited at any segment and tweaked in random
fashion.
In other words, in the Field Version, only the last appended projection can be edited,
so that in order to edit a part further up the curve, the user must delete all appended
parts of the curve made subsequent to that higher up part before editing it. In Well
Planning, the proposal is “poseable,” a model with hundreds of points of
articulation.
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Well Planning Control Panel

1.

The Well Planning Mode is activated by clicking on the “Well Plan” tab at the top of the
TM
main screen. (This Icon does not appear in the Field Version of HawkEye .)

The Control Panel that appears just below the tab contains a number of powerful tools,
most of them centered around profiles that contain sets of projections. When this tab is
selected, this is what is referred to as being in the “Well Planning Mode” as opposed to
being in the Workspace, or Field Mode. In the “Well Planning Mode,” the curve you are
working with is a temporary curve that is multicolored, representing the different
projection segments that constitute the proposal.
In order to commit this curve as the proposal curve it is necessary to click the light blue
“Apply to Prop.” Button at the far right. The ‘temporary’ curve that constitutes the
projection segments is saved to the database so that should you desire to make changes
at a later time you can return to the Well Planning Mode and alter what you want.
Once you click the “Clear Proj.” button, however, this segmented curve is erased
permanently.
Workspace/Field Mode View: Click on any main tab besides “Well Plan” to close the
TM
Well Planning control panel and brings HawkEye back into the default Field Mode.
INDIVIDUAL PROJECTIONS: You can add projections one-by-one to a well plan by
selecting it from the “Projection” dropdown menu,” then putting in the parameters for
that projection, then clicking “Add.” Depending on the projection you select, you may
need to designate a target first.

Select the origin of your plan, either from surface (Well Head) or from an existing curve
(WellPath).
KOP: This turns on the search for KOP flag for either the Aligned well, or the Slant
well. Be aware that this can be a time consuming process, particularly with an Aligned
well since there is a great deal of iteration that the computer does in order to find a
solution.
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DEFAULT PROFILES: The special controls of the Well
Planning version allow the user to load well profiles, as
well as save new ones. The default profiles are the most
common type of profiles and are designed so that all the
user need do is load the profile and fill in the white
background grid cells, perhaps select a target if it isn’t
already selected, and have a solution.
The “Profile Name” drop-down menu contains several default profiles to choose from,
and will also contain any saved user-created profiles. The default profiles are:
•
•
•
•
•
•
•

Simple 2D S-well (w/special profiler tool)
Simple 2D Slant (w/special profiler tool)
Find KOP Slant
Find KOP Aligned
Default Slant
Default Aligned
Default Horizontal

LOAD PROFILE: Once a profile is selected from
the drop-down menu, click “Load Profile” to the
right of the menu.
If a “targeted” projection (Slant, Aligned, BOT and
Horizontal) is selected, then HawkEyeTM needs a First
Target. Designate a target as First Target by right-clicking
on one in the 3D space icon and hitting “Set as the First
Target,” or by clicking on the large Target icon and
designating First target from the dropdown list.
Then click “Load Profile” again.
SAVE AS NEW PROFILE: Click this button to save the
current projection set, as displayed in the 3D and List
Panel at the bottom of the screen, as a profile that can
later be conveniently invoked as a whole. Any new
profiles are saved to the current database, and they
become available in the “Profile” drop-down menu.
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WELL PLANNING CRITICAL POINTS (CP): In the Well Planning Mode, the Well
Planning CP tab is displayed, allowing the display of each projection of a curve in a
list. For each projection type, there are a number of columns of information in which
the WHITE cells can be edited independently of other parameters.

The parameters for each projection in the well planning list are:
•
•
•
•
•

Projection (type)
Target
MD
CL
Inc Deg

•
•
•
•
•

Azm Deg
EVD
NS
EW
Easting

•
•
•
•
•

Northing
TVD
DLS
TFA Deg
Comment

MAKE CHANGES: When a profile is loaded, it will have with it default values for KOP
and DLS as well as other parameters. Any of these projections can be changed or
nudged by finding the parameter in the Well Plan List Panel at the bottom of the screen,
clicking on the field in question, and changing the number right there in the field.
Changes to the projection are usually instantaneous, but are not automatically applied
to the proposal. NOTE: For aligned projections, you must click “CALCULATE” after
each change. After changes are made here, but before they are applied, they are still in
the status of a projection.
Click on any projection in the List Panel at the bottom and its respective control
panel will appear. Parameters in white may be changed in the special panel or in the
List Panel. Click “Apply to Proposal” to lock in changes.

APPLY TO PROPOSAL: When it is decided that any changes made to a proposal are
acceptable, click “Apply to Prop.” to integrate changes to the current proposal curve.
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ADD NEW PROPOSAL: Clicking the “Add New
Prop.” button will launch the “Add New Curve”
dialogue, which can also be launched by rightclicking on a slot in the Data Tree. It will create
either a Proposal or Survey curve under the current
slot, and that curve can be assigned to any jobs from
the database. The “Job” button here will launch the
Jobs dialogue in which job information can be added
and edited.
Once this new curve is made, it will become the new “current” curve and a new blank
slate onto which you can add wellplan projections.
PREVIOUS PROPOSAL CURVES: If you make a previous Proposal curve the current
curve again, it will remember the last set of wellplan projections given to it.
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a. Simple 2D S-Well Profiler
Within the Well Planning Control Panel, selecting the “Simple 2D S-Well” from the
“Profile Type” pulldown menu will invoke the dedicated profiler for this well type.

The “Simple 2D SWell Profiler”:
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FIRST TARGET: Since S-wells are “targeted projections,” a first target must usually be
set. If a first target has not been set yet, find the target to be set either in the Data Tree,
3D space, right-click on it and select “Set as First Target.”
Or set it from the 1st Target pulldown list in the Well Planning
panel.

LOAD THE PROFILE: Select the profile from the “Profile”
dropdown menu. This is best done in every case AFTER
designating target(s).

HOW TO USE 1ST TARGET: The top left option
in the Profiler allows the user to either ignore
First Target (for when creating an open plan) or
treat it as the PBHL (Proposed Bottom Hole Location). When “Don’t Use” is selected,
the profiler will create a target where the projection ends and call it “PBHL” by
default.
S-CURVE PROPERTIES SOLVER: Throughout this colorful list of parameters, the
important rule of thumb to keep in mind is that the fields in red cannot be changed,
whereas the fields in white can be changed. These fields change depending on which
solve mode is selected.

In the Solver, different fields are editable depending on which solve mode is
selected (from the 6 radio buttons on right). Red fields are uneditable while
white fields are editable. Click “Calculate” to register parameter changes.
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The Solver has 10 different parameters which shape the S-Well. The properties are:
•
•
•
•
•

•
•
•
•

•

KOP- The depth at which the first build in the S-Well begins.
Start Inc- The starting inclination. It is always set to ‘0’ and can’t be changed for
this type of plan.
Build Rate- The degree of turn per 100 ft along the first turn.
Hold Angle- Angle in degrees of the tangent / hold section.
Tangent- Length of the tangent / hold section between the upper and lower
curves. If this is set to 0 and the radio button to the right is set, then the
program will solve for a kick off point.
Drop Rate- Drop rate in degrees per 100ft or degrees per 30 meters. Note that
this does not have to drop, it can also build if it is a horizontal well.
Entry Angle- Degree at which the second turn ends. 0 degrees will make the
curve going straight down at the end of the second turn.
Extension- This is the distance of straight extension BEFORE the target and at the
end of the drop of the second curve.
V. Section- This is the closure distance or vertical section distance of the target
point at the end of the proposal This can be a locked parameter with the
“Locked” checkbox of the Well Properties just below the Solver. When this is
locked it is in essence defining the target point, as opposed to an open solution in
which the target pt would be defined by the solution.
Delta TVD- Difference between the KOP and the Target TVD.

As changes and solutions are made, they are displayed in the vertical section view
immediately to the right of the Solver, all color coded to the background color of the
various solver parameters.
In addition, critical points data is displayed in spreadsheet format in the list panel at the
bottom of the profiler. This allows the user to see details of the curve that are not always
apparent in either the in-profiler VS View or Solver fields.
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WELL PROPERTIES: The “Target TVD” and “Well Direction” fields under this
heading will only be activated if no target is used. To NOT use a target, just select
“Don’t Use” at the top left of the profiler where it says “How to Use 1st Target.” The
“Locked” checkbox will lock these parameters into place even other parameters are
changed.
CREATE TARGET PLANE: Check this box in the Profiler to turn on a target plane in
the 3D space. When the profile you make is sent to the 3D space, it will generate a target
plane along the first straight tangent section. This target plane will remain even if the
profile is cleared away.
CREATE WAY POINT TARGET: Check this box to
automatically generate a target (default name: “Way Point”) at
the beginning of the first turn in the S-Well. This target will
remain even if the profile is cleared away. Example at right.

SEND TO 3D SPACE: This button acts as an “APPLY” button,
porting all of the S-Well changes made in the Profiler into the
3D space. This option will be a prompt when clicking “OK” just
in case the user forgets. When an S-Well is sent into the 3D
space from the Well Planning Profiler, a Nudge projection is
inserted for the first half of the first build.
This feature provides a sort of hinge, allowing the user to nudge the Nudge portion of
the s-well and redirecting the entire curve left or right while retaining all features below
the first turn. To tweak the Nudge component or any other part of the well, return to
the Well Planner Mode, then click on the desired projection in the List Panel at the
bottom of the screen.

When the Nudge row is clicked, its special control panel appears for editing. If the Tool
Face, for example, is changed in this Nudge section, then the entire curve will be
redirected yet maintain its build characteristics. You can edit any parameters directly in
the List Panel which have a white background.
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S-Well Defined Without Targets
The first three steps to creating an S-Well without targets is to:
1) Select “Don’t Use” at the top left of the Profiler, then
2) Check “Extension” to solve for extension.

3) Uncheck the “Lock” checkbox at the bottom in Well
Properties in order to allow for the editing of the V. Section
field. It may also be a good idea to click the Erase icon to clear
all the fields.

From there, in the Solver, enter a KOP, Build Rate, Tangent, V.Section (Vertical Section)
and Delta TVD. After the last two parameters are entered, the Profiler will solve for a
Target TVD. The final step is to enter a desired Well Direction at the bottom.
Create the target points by checking “Create Target Plane”
and “Create Way Point Target” at the bottom under the graph.
Then click “OK” and make sure to “Send to 3D Space” when
prompted.
The curve will appear in the 3D space going through two
targets and along a target plane. Just as with the targeted SWell made from the Profiler, this S-Well contains a Nudge
projection near the top that allows for powerful nudging
options which preserve the S-Well’s characteristics. Any of the
projection components of the well can be accessed and edited
by clicking on the projection in the List Panel at the bottom of the screen.
Once the curve is nudged and adjusted, click “Apply to Prop.l” in the Well Planning
Control Panel and it will make this curve a proposal curve.
Click any tab other than “Well Plan” to get back to the Field Mode and the S-Well will
be displayed as a proposal curve along with the targets generated and listed.
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b. Simple 2D Slant Profiler
Within the Well Planning Control Panel, selecting the
“Simple 2D Slant” from the “Profile:” drop-down menu will
invoke the dedicated Profiler for these well types. The
parameter set for both slant wells and horizontal wells are
identical since both consist of a single turn.

You will open up the “Simple 2D Slant / Horizontal Profiler:
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FIRST TARGET: Since Both Slant and Horizontal projections are “targeted
projections,” a first target must usually be set. If a first target has not been set yet, find
the target to be set either in the Data Tree, 3D space, right-click on it and select “Set as
First Target.”
Or set it from the 1st Target pulldown list in the Well Planning
panel.

LOAD THE PROFILE: Select the profile from the “Profile” dropdown menu. This is
best done in every case AFTER designating target(s).

HOW TO USE 1ST TARGET: Choose from the top
left box in the Profiler how to build the profile
around the target.
• Don’t Use- This option allows the user to make the Profiler determine where a
target should be after providing certain parameters. When “Don’t Use” is
selected, the profiler will create a target where the projection ends and call it
“PBHL” by default.
• As Landing- This means set the target to the landing point which is another way
of saying: “Solve for the minimum build rate that is required to achieve the
desired inclination at the landing point. The KOP will be determined as a
function of that.”
• As PBHL- Treating the target as a Proposed Bottom Hole Location is the default
method of target utilization, with the target acting as the end point designation
for the curve.
CURVE PROPERTIES SOLVER: As with the S-Well Properties Solver (found in the SWell Profiler), the rule of thumb is that the fields in red cannot be changed, whereas the
fields in white can be changed. These fields change depending on which solve mode is
selected. Select for a solve mode by clicking on one of the three radio buttons on the
right.
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In this Solver, different fields are editable depending on which solve mode is
selected (three radio buttons on right). Red fields are uneditable while white
fields are editable. Click “Calculate” to register parameter changes.

The Solver for Slant/Horizontal wells has 8 different parameters which define the well.
The properties are:
•
•
•
•
•
•
•
•

•

KOP- The depth at which the first turn in the S-Well begins, usually after the
initial straightaway from the surface.
Build Rate- The degree of turn per 100 ft along the first turn.
Start Inc- This is the initial inclination, which is always zero for this type of plane
End Inc- The landing inclination
Landing Disp- Displacement in feet or meters to the landing point, illustrated by
the Dark Green upper line in the diagram
Delta TVD- The change in True vertical depth on the curve. The Red Line
illustrates this distance.
Delta MD- The change in measured depth from the beginning of the curve to the
end of the curve. The Blue Line represents where this distance is calculated.
Dip Angle- The dip angle is calculated as 90-Landing Inc. So a curve that has a
landing angle of 88 degrees would have a 2 degree dip. The Maroon Line
represents where this angle is calculated, relative to an imaginary horizontal line.
Above Dip- The Above dip distance is represented by the Black Line on the left.
This is the distance above the formation at the beginning of the kick off.
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WELL PROPERTIES: Unlike the S-Well Profiler, the “Well
Properties” fields are uneditable regardless of which solve
mode is selected. These fields merely indicate the figures
shown. These parameters indicate several crucial bits of
information:
•
•
•

Landing TVD- The Target TVD
Well Direction- The azimuth direction in which the well is being planned.
Extension- The extension is the amount of tangent Measured Depth before
reaching the Landing TVD, aka. the Target.

CREATE TARGET PLANE: Check this box in the Profiler to turn on a target plane in
the 3D space. Target Planes in the 3D space are a very useful visual tool. They can
easily be created within the 3D space by selecting a tangent section on a curve that the
right-clicking for the context menu and then selecting ‘Create Target Plane’. But, if you
know you want to have a target plane then it is even easier to have one automatically
created
CREATE WAY POINT TARGET:
Common practice in directional
drilling is to have the point at the
end of the build section identified as
a target. This is more commonly
referred to as a waypoint. Selecting
this option will have the program
automatically create a waypoint
target at the end of the first turn in the curve. The target will be named “Way Point”
with its TVD by default.
SEND TO 3D SPACE: This button acts as an “APPLY” button, porting all of the
Slant/Horizontal well changes made in the Profiler into the 3D space. This option will
be a prompt when clicking “OK” just in case the user forgets.
COMES WITH A NUDGE INSTALLED: Just like the S-Well, when a Slant/Horizontal
well is sent into the 3D space from the Well Planning Profiler, it is equipped with a
Nudge projection at the first turn.
This feature acts as a sort of hinge, allowing the user to nudge the Nudge portion of the
well and redirecting the entire curve elsewhere while retaining all features below the
first turn. To tweak the Nudge component or any other part of the well, return to the
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Well Planner Mode, then click on the desired projection in the List Panel at the bottom
of the screen.
When the Nudge row is clicked, its special control panel appears for editing. If the Tool
Face, for example, is changed in this Nudge section, then the entire curve will be
redirected yet maintain its build characteristics.
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c. Find KOP Slant
The “Find KOP Slant” is the first of the profiles to not have a dedicated profiler tool. It
is styled like all the remaining profiles in that it gives you a series of projections with
which you can tweak, add to or take projections out of. This profile will look for the
optimal KOP given the parameters that you enter into your slant projection panel.

SET FIRST TARGET: Since the Slant projection is a targeted projection, a First Target
must be set. Do so by finding the target in the 3D space, right-clicking and selecting “Set
as First Target.”
Or set it from the 1st Target pulldown list in the Well Planning
panel.

LOAD PROFILE: This profile does not have a dedicated
profiler tool pop up when you select it. Remember to click
“Load Profile” after selecting this and all profiles below this
one.

CHANGE INCLINATION FROM THE LIST PANEL: If the resulting proposal curve is
not exactly what is needed, any of the projections composing the curve can be edited.
The fields in white can be edited directly in the List Panel. To change other parameters
of a given projection, click on the name of the projection and its own control panel will
appear.
Below is the projection series created by the “Find KOP S-Well,” with “Target1” set as
the First Target. The inclination of the first slant can be changed to affect the KOP:
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Changes are updated instantaneously to the 2D and
3D space. To the right is a typical “Find KOP Slant”
profile, with the parameters from the previous List
Panel screenshot.
Here, the KOP is seen in the List Panel as 2038.6
feet. The build is at 30 degrees inclination and 45
degrees azimuth.

APPLY TO PROPOSAL: Remember that any list of
projections that you create in the Well Planning
Mode will not appear in the Field Mode and
become a part of your Proposal Curve until you
click “Apply to Prop.”
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d. Find KOP Aligned
The “Find KOP Aligned” is a standard style Well Planning profile in that it gives you a
series of projections with which you can tweak, add or take projections out of. This
profile will look for the optimal KOP given the parameters that you enter into your
aligned projection panel.
SET FIRST AND SECOND TARGET: Since the Aligned projection is a targeted
projection, a First Target must be set. Additionally, it is the only projection which uses
the Second Target. Set these targets by finding them in the 3D space, right-clicking and
selecting “Set as First Target” and “Set as Second Target.”
Or set it from the 1st Target pulldown list in the Well Planning
panel. You may also need to designate a 2nd target here if you
are using the “Line up to hit 2nd Target feature (described just
below).

LOAD PROFILE: This profile does not have a dedicated profiler
tool pop up when you select it. Remember to click “Load Profile”
after selecting this and all profiles below this one.

LINE UP TO HIT 2ND TARGET: With the Aligned projection, if
you want to hit two targets you will need to open up the Aligned
Projection control panel by clicking on the aligned projection in the
Projects List.
Once the control panel is open, check the “Line up to hit 2nd
Target” and “Extend to 2nd Target” boxes. This will ensure that
the projection is calculated to pass through the First Target and end
at the Second Target.
NOTE: With the Aligned projections, always remember to hit the “Calculate” button,
either in the small control panel or the Well Planning Control Panel on the far right.
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CHANGE INCLINATION FROM THE LIST PANEL: If the resulting proposal curve is
not exactly what is needed, any of the projections composing the curve can be edited.
Below is the projection series created by the “Find KOP Aligned,” with “Target1” set as
the First Target and “Target2” set as Second Target:

The fields in white in the List Panel can be edited directly. To change other parameters
of a given projection, click on the name of the projection and its own control panel will
appear. In the example above, since the “Find KOP” box is checked under our “Find
KOP Aligned” profile, we can directly change the Inclination on the first aligned
projection. This will cause the KOP to be recalculated.
MUST CLICK “CALCULATE”: For profiles
containing aligned projections such as this
one, changes are updated to the 2D and 3D
space after clicking “Calculate.”
To the right is the vertical section view of a
typical “Find KOP Aligned” profile, with the
parameters from the List Panel above. Here,
the KOP is seen in the List Panel as 1731.84
feet. The DLS values are at 6 and 4, according
to the Aligned Projection control panel. The
curve hits Target1 and extends in a straight
tangent for 1417.74 feet to hit Target2.

APPLY TO PROPOSAL: Remember that any
list of projections that you create in the Well
Planning Mode will not appear in the Field
Mode and become a part of your Proposal Curve until you click “Apply to Prop.”
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e. Default Slant
The Default Slant profile is similar to the Find KOP Slant profile except that it is not
solving for a KOP given a user-provided inclination. Instead, a KOP must be provided,
as well as DLS and Hold Angle numbers for the slant projection portions.
SET FIRST TARGET: Since the Slant projection is a targeted projection, a First Target
must be set. Do so by finding the target in the 3D space, right-clicking and selecting “Set
as First Target.”
Or set it from the 1st Target pulldown list in the Well Planning
panel.

LOAD PROFILE: This profile does not have a dedicated profiler
tool pop up when you select it. Remember to click “Load Profile”
after selecting this and all profiles below this one.

CHANGE KOP FROM THE LIST PANEL: If the resulting proposal curve is not exactly
what is needed, any of the projections composing the curve can be edited. The fields in
white can be edited directly in the List Panel. To change other parameters of a given
projection, click on the name of the projection and its own control panel will appear.
Below is the projection series created by the “Default Slant,” with “Target1” set as the
First Target. The KOP can be changed:
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Changes are updated instantaneously to the 2D and 3D
space. To the right is a typical “Default Slant” profile,
with the parameters from the previous List Panel
screenshot.
Here, the KOP was defined in the List Panel as 3000
feet. The build is at 27.01 degrees inclination and 79.30
degrees azimuth. The DLS for this curve is 5 degrees
per hundred feet, and that could be reduced by
decreasing the user-defined KOP.
APPLY TO PROPOSAL: Remember that any list of
projections that you create in the Well Planning Mode
will not appear in the Field Mode and become a part of
your Proposal Curve until you click “Apply to Prop.”
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f. Default Aligned
The “Default Aligned” is a standard style Well Planning profile in that it gives you a
series of projections with which you can tweak, add to or take projections out of. This
profile will allow you to change your KOP as well as your inclination and azimuth
upon reaching the first target.
SET FIRST AND SECOND TARGET: Since the Aligned projection is a targeted
projection, a First Target must be set. Additionally, it is the only projection which uses
the Second Target. Set these targets by finding them in the 3D space, right-clicking and
selecting “Set as First Target” and “Set as Second Target.”
Or set it from the 1st Target pulldown list in the Well Planning
panel. You may also need to designate a 2nd target here if you
are using the “Line up to hit 2nd Target feature (described just
below).

LOAD PROFILE: This profile does not have a dedicated
profiler tool pop up when you select it. Remember to click
“Load Profile” after selecting this and all profiles below this
one.

CHANGE KOP AND INC/AZM AT FIRST TARGET: If the resulting proposal curve is
not exactly what is needed, any of the projections composing the curve can be edited.
Below is the projection series created by the “Default Aligned,” with “Target1” set as
the First Target:

The fields in white, here the KOP and Inc/Azm at First Target, can be edited directly. To
change other parameters of a given projection, click on the name of the projection and
its own control panel will appear.
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MUST CLICK “CALCULATE”: For profiles
containing aligned projections such as this one,
changes are updated to the 2D and 3D space
after clicking “Calculate.”
To the right is the vertical section view of a
“Default Aligned” profile, with the parameters
from the List Panel above. Here, the KOP was
set in the List Panel at 781.64 feet. The curve
hits Target1 at 0 degrees inclination and
azimuth, or in other words straight down from
the top.

EXTEND TO NEXT TARGET: With the Aligned projection, if you want to hit two
targets you will need to open up the Aligned Projection control panel by clicking on the
aligned projection in the List Panel below.
Once the control panel is open, check the “Use Vector to Second Target” and “Extend to
Next Target” boxes. This will ensure that the projection is calculated to pass through the
First Target and end at the Second Target.
NOTE: With the Aligned projections, always remember to hit the “Calculate” button,
either in the small control panel or the Well Planning Control Panel on the far right.

LINE UP TO HIT 2ND TARGET: With the Aligned projection, if
you want to hit two targets you will need to open up the Aligned
Projection control panel by clicking on the aligned projection in the
Projects List.
Once the control panel is open, check the “Line up to hit 2nd
Target” and “Extend to 2nd Target” boxes. This will ensure that
the projection is calculated to pass through the First Target and end
at the Second Target.
NOTE: With the Aligned projections, always remember to hit the “Calculate” button,
either in the small control panel or the Well Planning Control Panel on the far right.
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When extending to the next target, the program will recalculate the aligned projection
to automatically hit Second Target from the First Target. In the example below, once the
projection was told to use vector to second target, it calculated that it needed to hit First
Target at 90 degrees inclination and 45 degrees azimuth:

APPLY TO PROPOSAL: Remember that any list of projections that you create in the
Well Planning Mode will not appear in the Field Mode and become a part of your
Proposal Curve until you click “Apply to Prop.”
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g. Default Horizontal
The “Default Horizontal” profile contains the horizontal projection, which is a targeted
projection but will not use First or Second Target. Instead, just like when making a
horizontal projection in the Field Mode, you must define a target plane from within the
control panel.
LOAD PROFILE: This profile does not have a dedicated profiler
tool pop up when you select it. Remember to click “Load
Profile” after selecting this and all profiles below this one.

DEFINE YOUR TARGET PLANE: Just as in the Field Mode,
the Horizontal Projection can only be calculated upon
defining the target plane which it is supposed to hit. So when
the “Default Horizontal” profile is loaded, you must click on
the “Horizontal” projection in the List Panel below and enter
some parameters into the control panel that pops up.
Here, we have defined a plane that sits at 5000 feet RKBTVD,
with no dip in any direction, and we want the curve to strike
the plane at a 90 degree angle (flat), at a direction of 45
degrees, with no extension. The program calculates that this
will require a low 1.91 DLS.
MAKE TARGET PLANE: By clicking the “Make Target Plane,” this projection will
automatically generate a target plane in the 3D space that will be associated with your
current structure. Generating the target plane may help to visualize how and where the
curve strikes the plane.
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MAKE CHANGES IN THE LIST PANEL: As is the case with all data in the Well
Planning Mode’s List Panel, white fields are editable. Taking a look at the List Panel
below. Here, we can change the KOP, strike azimuth and total depth of the plane itself:

As can be seen in the vertical section view to the
right, the Horizontal projection profile can be
used to make a smooth “landing” with a low DLS.

APPLY TO PROPOSAL: Remember that any list of projections that you create in the
Well Planning Mode will not appear in the Field Mode and become a part of your
Proposal Curve until you click “Apply to Prop.”
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h. Tie-Ins
Adding tie-ins in the Well Planning Mode is conceptually the same as doing it in the
Field Mode. The advantage here is that it can be nudged and modified by any
parameter at any point, which is the general advantage of working in the Well Planning
Mode.
TIE TYPE: To create a tie-in from the Well Planning Control Panel, DON’T select a
profile. Instead, first select the type of tie-in to be created from the “Tie Type” dropdown menu. The choices are Well Head or WellPath. In the following example, the tiein will be off of the well path.
TIE CURVE: When “WellPath” is selected as the tie-in type, the “Tie Curve” dropdown menu is activated and a curve from which to tie in can be selected. Keep in mind
that you cannot launch a tie-in from the
current curve that you are on: it must be
from either the survey curve or another
proposal.

Once a tie-in base curve is selected, by default, the tie-in will start at the END of the
selected tie-in base curve. This entry appears in the List Panel as “Tie in.” Change where
the tie-in starts by changing the MD in the List Panel.

ADD PROJECTION: The next step is to select a projection type
to use as the tie-in curve from the “Add Projection” drop-down
menu. When any projection is selected, its special control panel
appears inside of the 3D window, where it always normally
appears.
In this example, a horizontal projection is used as the tie-in off of
horizontal proposal. When a horizontal projection is made, a
target plane must be defined and this is done in the Horizontal
Projection panel. It is defined by its RKBTVD, Max Dip and Max
Dip Direction. In this case, the target plane is contacted 2500 feet

231
HawkEye

TM

User’s Manual

Copyright © 2022 by Performance Drilling Technology

below the surface location, its maximum dip angle is 3 degrees and its direction is 78
degrees.
For the tie in, the strike inclination is defined as 93 degrees, and the strike azimuth is
258 degrees, which is exactly 180 degrees opposite the proposal’s azimuth. The tie-in is
also given an extension of 3000 feet and the DLS is automatically calculated at 14.61 in
order to accommodate these parameters.
ADD: The next step is to click the “Add” button. This will create the curve and it will
appear both in the 3D space as a translucent projection as well as the next projection
entry in the Well Planning List Panel (just below “Tie in). (See 9.1.8 video for reference)

The new tie-in is also reflected in the 2D and 3D space as a translucent projection.

By changing the “MD” value of the Tie-in in the List Panel, the actual tie-in point can be
manipulated. Notice that when the tie-in’s MD (tie-in point) is changed from 2050 to
2100, it starts lower off of the base curve and ultimately adopts a more severe dogleg
severity to attain its assigned strike inclination.
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To get the exact desired dogleg severity, the user can keep changing the MD until the
right DLS value is generated. Such “what-if” games can be played in the Well Planning
version for all sorts of parameters in order to create an optimal curve.
When the tie-in curve has been articulated to user spec, click “Apply to Prop.” and it
becomes part of a multilateral proposal curve. Click any tab other than “Well Plan” to
get back to the Field Mode and see the proposal curve.
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2. BUILD A CUSTOM WELL PLANNING TEMPLATE
Once the Well Planning Control Panel has become familiar, creating customized profiles
is straightforward. The principle tools are the “Add” button and the List Panel. Custom
profiles can also be based on existing default profiles. Any sequence of projections that
is currently displayed in the List Panel can be saved as a new user-created profile,
making this aspect of the Well Planning Mode a potent time saving device.
ADD FIRST PROJECTION: When creating a profile
from scratch, first click the “Clear” button in the Well
Planning panel. Then add a projection at the top of the
curve by selecting the type in the “Add Projection”
drop-down menu. The special control panel for any of
the projections appear where they normally do, just
inside the 3D window. Edit the main parameters in this
panel.
Then click the “Add” button. The projection as defined will appear in the List Panel
below as well as the 3D space above. All parameters can be further edited in the List
Panel by clicking on the projection row, or in the special control panel.
ADD ANOTHER PROJECTION: The next step in building a profile is to stack on a
second projection. A common and useful second projection for ample customization
room down the road is a Nudge projection since it acts as a flexible control point for any
template. Select “Nudge” from the “Add Projection” drop-down menu and click
“Add.” This will place a Nudge projection just after the first one.

ADD TARGETED PROJECTIONS: Add targeted projections in the same manner as
targetless, but keep in mind that a target will need to be set as First Target when adding
the former. Set a target as First Target by right-clicking on it in the 3D window and
selecting “Set as the First Target.” When loading the profile for later projects, the
targeted sections of the profile will adjust to whichever current First Target is set.
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MAKE FINAL CHANGES: Any tweaks to the projections can be made in the List Panel
before saving by clicking on the parameter in question.

Changes are reflected instantly in the 3D window above the List Panel.
SAVE AS NEW PROFILE: Once a list of projections
has been compiled, they may all be saved as a template
for future use.
Name the new profile when prompted, and it will be
available in the “Profile Name” drop-down menu along
with all the default profiles.

APPLY TO PROPOSAL: Anything created and displayed in the Well Planning Mode
must be actively pushed over into the Work Space in order for it to become part of a
proposal curve. To do that, just click “Apply to Proposal.” Click any tab other than
“Well Plan” to get back to the Field Mode and see the proposal curve.
CHANGING THE TEMPLATE: Anytime a template needs to be altered, first get back
to the Well Planning panel and load the profile. Then make the desired changes in the
List Panel and individual control panels for any of the curves. Finally save as new
profile again, naming it the same or something different.
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VIII.

TORQUE AND DRAG
The Torque and Drag Program
The Softdrill NL Torque and Drag module is a program offered with
an additional charge for those ordering the Field Version of
HawkEye™, or simply included in the Well Planning Version.

Performance Drilling Technology has enlisted Softdrill NL to embed its torque and drag
program within HawkEye™ as an optional component module. T&D is an important
component of many drilling operations and the ability to create useful T&D analysis
quickly and accurately is important.
To this end, HawkEye™ passes survey information to the torque and drag program
which provides the interface for setting up the calculation parameters for torque and
drag, and also provides the reports and graphs. The following pages explain how to
operate the Torque and Drag program.

1. OVERVIEW
Softdrill NL Torque & Drag can be used for a variety of engineering applications:
• Optimizing well path design and prediction of operational scenarios
• Drillstring design and prediction of expected tension and torque values

exerted on drillstring elements
• Analysis of normal forces (predicting casing wear)
• Analyzing drilling problems (string “hang up”)
• Prediction of hook loads while tripping in or out of the hole and early

detection of cuttings build up by comparing actual hook loads
(“diverge/converge” method).
Each of these applications of the software will be introduced and described in this
document.
NOTE: This manual has been written for the stand-alone version of Torque & Drag,
which allows multiple calculation models to be opened simultaneously (multiple
document interface). The Torque & Drag version embedded in Performance Drilling
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Technology’s HawkEye™ consists of a single document interface, but functionality of
the software is similar to the stand-alone version. Please refer to section “Hawkeye™
Embedded Version” later in this chapter for further details.

a. Units of measurement
Common to all Softdrill NL applications, the Torque & Drag program has full
flexibility with regards to the units of measurement used for input and output. All
numeric data is stored in a consistent set of units (imperial) when it is saved in a file or
stored in a database. This is schematically depicted in the figure below.

Conversion of units of measurement

The conversion mechanism is fully transparent to the user and allows the program(s) to
function fully independently of the selected units. The advantage of this is two-fold:
every user can work in his preferred units while working with the program and change
to the required units just prior to printing the report(s) to be presented.
To access of variety of functions related to the selected units of measurements, click the
on the program tool bar or select [File] > [Conversions…] from the main menu. This
opens the dialog window as displayed below in the next figure:
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Conversion settings editor

This dialog window presents the user with several options related to units of
measurement:
• The conversion families (or: groups of units) are sorted in the most logical

manner in the context of an engineering application. However, you may choose
to sort this list by Conversion Family by clicking on the column header
(continued clicking will toggle between ascending and descending sort order).
• For each conversion family, you may select your preferred unit from the drop-

down box in the Selected Unit column.
• The button [Set default file location] allows the user to define a folder

(directory) where all conversion files will be saved. Typically this is My
Documents\Softdrill NL data for the current user, but it may be changed to any
folder. This folder’s path is saved to the registry and becomes the default
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location when storing your settings. (This can still be overridden because the
user is asked for a storage location prior to opening or saving a settings file).
Note that it is probably not a good idea to set a network location as the default.
Specifically with a laptop computer, you may not be connected to the network
and problems will occur when attempting to retrieve you default settings.
• If you check the checkbox labeled ‘Make current settings my default settings’,

the currently selected settings will become the default (on startup) of all
Softdrill NL applications installed on your computer.
• Click “OK” to keep your selected settings or “Cancel” to undo all changes and

keep things as they were.

b. The Torque & Drag Toolbar
The following shortcut buttons are available on the toolbar in the main window:

[File] > [New]
This option opens a new calculation model. Use this to start a new model from scratch.

[File] > [Open…]
Open existing (saved) calculation model. Alternatively you can use this to open an
existing model, input the required changes and save it under a new name using [File] –
[Save As…] from the main menu. This is particularly useful in situations where several
cases for similar situations must be calculated (e.g. only minor changes to BHA, various
bit depths, different mud weights, etc.). Please note that specifically for this purpose
the Case No. and Description input fields were added to allow easy distinction between
several different cases.

[File] > [Save]
Save changes to currently opened calculation model.

[File] > [Calculate]
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Calculate currently opened calculation model. This takes you to the resulting graph
screen on completion of the calculation. The same function is executed when the [F9]
key is pressed.

[File] > [Print…]
Print Torque & Drag report complete with selected graphs. This function prints to a
preview window first, allowing the user to review the report prior to printing the actual
hardcopy.
When you print the report from the preview window (click on printer icon), the print
dialog opens where you can select and adjust the printer you want to use to print the
report. Optionally you can print to a PDF file directly by checking the ‘Print to file’
checkbox and selecting ‘PDF’ from the combo-box.

[File] > [Conversions…]
Edit conversion settings (units of measurement) as described above.

2. INPUT SCREENS
a. General data
The main screen of the currently selected model window gives you access to the
following general input data:

Input of general data for calculation model
Most data input in this section is self-explanatory but the following may require some
additional explanation:
• Case no- Allows distinction between models for the same BHA on the same

well (use in conjunction with ‘Description’ field).
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• Step length- The torque and drag is calculated cumulatively for various depths

along the drillstring (from the bit upwards). These depths are calculated using
the specified step length. Typically this value is set to 100 feet (or 30 meters).
Different step lengths will yield different results but will also impact calculation
time.
• Safety factor- This factor is used to adjust the tension and torsional yield curves

for the operational scenario graph. The absolute yield values are divided by the
safety factor to calculate the yield curve values on the graph. For example, a
safety factor of 1.25 results in a graph value being plotted at 1 / 1.25 = 0.80 = 80%
of the absolute value
• M.O.P.- The margin of overpull applied in the calculation of the model.
• Stiff string- By default the model is calculated as ‘Soft string’ whereby

additional forces, resulting from bending the drillstring elements, are not taken
into account. Selecting this option will alter the calculation model where these
additional forces will be taken into account. See the ‘Calculation theory’ section
further in this document for further explanation.
• Helical buckling- Allows the user to select the applied method for calculation

of the helical buckling force. The available options are ‘Chen & Cheatham’ and
‘Wu & Juvkam-Wold’, where ‘Chen & Cheatham’ is considered the most
reliable and the default value.
• Calculation mode- Available options are: Scenario (also known as ‘single depth

analysis’), Trip Log (surface hook load vs. bit depth) and Friction Factor (backcalculates friction factor from known surface loads; used for post run analysis
and in-field optimization of models).
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b. Drilling parameters

Input of (drilling) parameters

This grid allows input of various (drilling) parameters for each operational mode. The
operational modes are defined as shown in the left-most column. Cells for nonapplicable values are grayed out and disabled.
Bit torque and BHA torque define the starting values for calculating torque values along
the drillstring. These values are increased as a result of an increasing weight (and
bending force in the case of stiff string models) along the drillstring. BHA Drag serves
as a start value for calculation of tension along the drillstring.
Other data is considered to be self-explanatory.

c. Hole sections

Hole sections

When selected, the hole size column will display an ellipsis button ( ). If the Section
Type column is defined as Casing or Liner, the clicking the button displays a casing
catalog from which the user can choose the applicable specifications.
The friction factor is a crucial parameter in the torque & drag calculation that allows
modeling of a variety of surface-to-surface interactions resulting in drag and torsional

242
HawkEye

TM

User’s Manual

Copyright © 2022 by Performance Drilling Technology

friction. The actual value of the friction factor used in a particular situation is a
combination of several factors, including:
• Material and condition of cased hole sections and formation type in open hole

sections
• Drilling fluid type and composition
• Tool joint material and condition
• Additional borehole tortuosity not correctly reflected by the survey data (i.e.

‘micro doglegs’).
At a specific point in time, the borehole tortuosity, drillstring composition, drillstring
characteristics and mud type will be constant, but several sections of cased and open
hole may exist. In most cases it will therefore be necessary to specify multiple friction
factors.
d. Drillstring

Drillstring

Type. Specify element type. Currently three values are valid: Drill Collar, HWDP and
Drill Pipe9.
Description. Self-explanatory, but selecting this column (As shown in figure 6 above)
will reveal a button that – when clicked - allows the user to select the element from a
catalog10.
Actual weight is nominal pipe weight corrected for tool joints and used in actual
calculation.
Tension limit, torsion limit and make-up torque are used for calculating the various
yield curves in the result graphs (taking safety factor and margin of overpull into
consideration).

Future editions of Softdrill NL Torque & Drag are planned to include additional element types
such as Casing, Tubing, Coiled tubing, etc. Please check the website at www.softdrill.nl for
further details.
10
Please note that updated catalogue files may be published on the website from time to time.
9
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e. Survey data

Survey data

Survey (or wellplan) data can be input manually or imported from a text file. For
wellplans only critical points (KOP, end of build, start of drop, etc.) have to be entered
since intermediate points will be interpolated as required.
If the first section of a wellplan is vertical down to the kick off point (KOP), the
resultant torque and drag values will be zero due to the absence of any inclination
(theoretical absence of wall contact). To model a real-time situation it is recommended
to adjust the inclination in the KOP to 1.00° (for example). Optionally, intermediate
stations with low inclination and random direction can be entered to simulate borehole
tortuosity in this section.
Select [Utility] – [Import surveys…] to display the dialog box below and import survey
or wellplan data from a variety of text file types:
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Import survey dialog box

Click the button in the ‘Selected file’ to select a *.txt or *.csv (Excel comma separated)
text file. The ‘Value separator’ radio buttons specify which token to use a field
separator when reading data.
Under ‘Import settings’ you can specify how many lines should be ignored before
reading data (skip comment lines), what measurement units were used for measured
depth values (feet or meters) and which columns contain measured depth, inclination
and direction data. Specific attention should be given to the definition of the units used
for the depth column to ensure correct conversion upon import of the data.

245
HawkEye

TM

User’s Manual

Copyright © 2022 by Performance Drilling Technology

3. EMBEDDED VERSION
Softdrill NL Torque & Drag is also available as an embedded module in Hawkeye™.
The single document interface may differ slightly from the multiple document interface
of the stand-alone version at first sight, but the principle function of the application
remains the same.
The primary differences lie in the file absence of the main menu and the standard
toolbar. For the embedded version an alternative toolbar with primary functionality is
made available to the user. This allows changing of setting and conversion units as well
as saving and opening external data files for the purpose of exchanging models with
other users.
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